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Introduction SOLIDWORKS Education 2023
To the Teacher The SOLIDWORKS Education Edition - Fundamentals of 3D Design 
and Simulation manual is designed to assist you in teaching 
SOLIDWORKS and SOLIDWORKS Simulation in an academic 
setting. This guide offers a competency-based approach to teaching 3D 
design concepts, analysis and techniques.

Qualified schools on subscription have access to the eBook at no cost 
to students. Contact your SOLIDWORKS Value Added Reseller to 
obtain access. 

SOLIDWORKS 
Tutorials

The SOLIDWORKS Education Edition 
- Fundamentals of 3D Design and 
Simulation manual also supplements 
the SOLIDWORKS Tutorials.

Accessing the 
SOLIDWORKS 
Tutorials

To start the SOLIDWORKS Tutorials, click Help, SOLIDWORKS 
Tutorials. The SOLIDWORKS window is resized and a second 
window appears next to it with a list of the available tutorials. There are 
over 40 lessons in the SOLIDWORKS Tutorials. As you move the 
pointer over the links, an illustration of the tutorial will appear at the 
bottom of the window. Click the desired link to start that tutorial.

TIP: When you use SOLIDWORKS Simulation to perform analysis, 
click Help, SOLIDWORKS Simulation, Tutorials to access 
over 50 lessons and over 80 verification problems. Click 
Tools, Add-ins to activate SOLIDWORKS Simulation, 
SOLIDWORKS Motion, and SOLIDWORKS Flow 
Simulation.
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SOLIDWORKS Education 2023 Introduction
Conventions Set your screen resolution to 1280x1024 for optimal viewing of the 
tutorials.

The following icons appear in the tutorials:

Moves to the next screen in the tutorial.

Represents a note or tip. It is not a link; the information is below 

the icon. Notes and tips provide time-saving steps and helpful hints.

You can click most buttons that appear in the lessons to flash the 
corresponding SOLIDWORKS button.

Open File or Set this option automatically opens the file or sets 
the option.

A closer look at... links to more information about a topic. 
Although not required to complete the tutorial, it offers more detail on 
the subject.

Why did I... links to more information about a procedure, and 
the reasons for the method given. This information is not required to 
complete the tutorial.

Show me... demonstrates with a video.

Printing the 
SOLIDWORKS 
Tutorials

If you like, you can print the SOLIDWORKS Tutorials by following 
this procedure:

1. On the tutorial navigation toolbar, click Show.

This displays the table of contents for the SOLIDWORKS 
Tutorials.

2. Right-click the book representing the lesson you wish to print and 
select Print... from the shortcut menu.

The Print Topics dialog box appears.

3. Select Print the selected heading and all subtopics, and click 
OK.

4. Repeat this process for each lesson that you want to print.
3
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My SOLIDWORKS My.SolidWorks.com is a community website to share, connect, and 
learn everything about SOLIDWORKS. My SOLIDWORKS learning 
contains additional video lessons and individual learning paths for your 
students.

Certification 
Exams

The Certified SOLIDWORKS Associate(CSWA) - Academic program 
provides free certification exams for you or your students in a 
proctored setting. Achieving CSWA proves the fundamentals of 
engineering design competency. Employers verify students job ready 
credentials through our online virtual tester. Schools that provide two 
or more courses in SOLIDWORKS-based instruction can also apply to 
be a Certified SOLIDWORKS Professional(CSWP) - Academic 
Provider.

More information and to apply can be found at 
www.solidworks.com/cswa-academic.

Training Files A complete set of the various files used throughout the course can be 
downloaded from the following website:
www.solidworks.com/EDU_Fundamentals3DDesignSim

The files are organized by lesson number. The Case Study folder 
within each lesson contains the files you need when presenting the 
lessons. The Exercises folder contains any files that are required for 
doing the laboratory exercises.

Educator 
Resources link

The Instructors Curriculum link on the SOLIDWORKS Resources 
 tab of the Task Pane includes substantial supporting materials to aid 

in your course presentation. Accessing this page requires a login 
account for the SOLIDWORKS Customer Portal. These supporting 
materials afford you flexibility in scope, depth, and presentation.

1. Start SOLIDWORKS.

Using the Start menu, start the SOLIDWORKS application.

2. SOLIDWORKS Content.

Click SOLIDWORKS Resources  to 
open the SOLIDWORKS Resources Task 
Pane.

Click on the Instructors Curriculum link 
which will take you to the 
SOLIDWORKS Customer Portal web 
page.
4



SOLIDWORKS Education 2023 Introduction
Prerequisites Students attending this course are expected to have the following:

 Mechanical design experience.

 Experience with the Windows® operating system.
 Completed the online tutorials that are integrated in the 

SOLIDWORKS software. You can access the online tutorials by 
clicking Help, Online Tutorial.

Course Design 
Philosophy

This course is designed around a process- or task-based approach to 
training. A process-based training course emphasizes the processes and 
procedures you follow to complete a particular task. By utilizing case 
studies to illustrate these processes, you learn the necessary commands, 
options and menus in the context of completing a task.

A Note About 
Dimensions

The drawings and dimensions given in the lab exercises are not intended 
to reflect any particular drafting standard. In fact, sometimes dimensions 
are given in a fashion that would never be considered acceptable in 
industry. The reason for this is the labs are designed to encourage you to 
apply the information covered in class and to employ and reinforce 
certain techniques in modeling. As a result, the drawings and dimensions 
in the exercises are done in a way that complements this objective.

Conventions Used 
in this Book

This manual uses the following typographic conventions:

Windows The screen shots in this manual were made using the SOLIDWORKS 

software running a mixture of Windows® 7 and Windows 10. You may 
notice slight differences in the appearance of the menus and windows. 
These differences do not affect the performance of the software.

Convention Meaning

Bold Sans Serif SOLIDWORKS commands and options 
appear in this style. For example, Features > 

Extruded Cut  means click the Extruded 
Cut icon on the Features tab of the 
CommandManager.

Typewriter Feature names and file names appear in this 
style. For example, Sketch1.

17 Do this step

Double lines precede and follow sections of 
the procedures. This provides separation 
between the steps of the procedure and large 
blocks of explanatory text. The steps 
themselves are numbered in sans serif bold.
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Use of Color The SOLIDWORKS user interface makes extensive use of color to 
highlight selected geometry and to provide you with visual feedback. 
This greatly increases the intuitiveness and ease of use of the 
SOLIDWORKS software. To take maximum advantage of this, the 
training manuals are printed in full color.

Also, in many cases, we have used 
additional color in the illustrations to 
communicate concepts, identify 
features, and otherwise convey 
important information. For example, 
we might show the result of a filleting 
operation with the fillets in a different 
color even though, by default, the 
SOLIDWORKS software would not display the results in that way.

Graphics and 
Graphics Cards

 The SOLIDWORKS software sets a new 
standard with best-in-class graphics. The 
combination of a highly reflective 
material and the realism of RealView 
Graphics is an effective tool for 
evaluating the quality of advanced part 
models and surfaces.

RealView Graphics is hardware 
(graphics card) support of advanced 
shading in real time. For example, if you 
rotate a part, it retains its rendered appearance throughout the rotation.

Color Schemes Out of the box, the SOLIDWORKS software provides several 
predefined color schemes that control, among other things, the colors 
used for highlighted items, selected items, sketch relation symbols, and 
shaded previews of features.

We have not used the same color scheme for every case study and 
exercise because some colors are more visible and clear than others 
when used with different colored parts. 

In addition, we have changed the viewport background to plain white 
so that the illustrations reproduce better on white paper.

As a result, because the color settings on your computer may be 
different than the ones used by the authors of this book, the images you 
see on your screen may not exactly match those in the book.

User Interface 
Appearance

Throughout the development of the software, there have been some 
cosmetic User Interface changes, intended to improve visibility, that do 
not affect the function of the software. As a policy, dialog images in the 
manuals which exhibit no functional change from the previous version 
are not replaced. As such, you may see a mixture of current and “old” 
UI dialogs and color schemes.
6



Lesson 1
SOLIDWORKS Basics and the

User Interface

Upon successful completion of this lesson, you will be able to:

 Describe the key characteristics of a feature-based, parametric solid 
modeler.

 Distinguish between sketched and applied features.

 Identify the principal components of the SOLIDWORKS user 
interface.

 Explain how different dimensioning methodologies convey 
different design intents.
7
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SOLIDWORKS Basics and the User Interface
What is the 
SOLIDWORKS 
Software?

SOLIDWORKS mechanical design automation software is a feature-
based, parametric solid modeling design tool which takes advantage of 
the easy to learn Windows graphical user interface. You can create fully 
associative 3D solid models with or without constraints while utilizing 
automatic or user defined relations to capture design intent.

The italicized terms in the previous paragraph mean:

 Feature-based
Just as an assembly is made up of a number of individual piece parts, a 
SOLIDWORKS model is also made up of individual constituent 
elements. These elements are called features.

When you create a model using the SOLIDWORKS software, you 
work with intelligent, easy to understand geometric features such as 
bosses, cuts, holes, ribs, fillets, chamfers, and drafts. As the features are 
created they are applied directly to the work piece.

Features can be classified as either sketched or applied.

 Sketched Features: Based upon a 2D sketch. Generally that sketch 
is transformed into a solid by extrusion, rotation, sweeping or 
lofting.

 Applied Features: Created directly on the solid model. Fillets and 
chamfers are examples of this type of feature.

The SOLIDWORKS software graphically shows you the feature-based 
structure of your model in a special window called the 
FeatureManager® design tree. The FeatureManager design tree not only 
shows you the sequence in which the features were created, it gives you 
easy access to all the underlying associated information. You will learn 
more about the FeatureManager design tree throughout this course.

To illustrate the concept of feature-
based modeling, consider the part 
shown at the right:

This part can be visualized as a 
collection of several different 
features – some of which add 
material, like the cylindrical boss, 
and some which remove material, 
like the blind hole.
8
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SOLIDWORKS Basics and the User Interface
If we were to map the individual features to their corresponding listing 
in the FeatureManager design tree, it would look like this:

 Parametric
The dimensions and relations used to create a feature are captured and 
stored in the model. This not only enables you to capture your design 
intent, it also enables you to quickly and easily make changes to the 
model.

 Driving Dimensions: These are the dimensions used when creating 
a feature. They include the dimensions associated with the sketch 
geometry, as well as those associated with the feature itself. A 
simple example of this would be a feature like a cylindrical boss. 
The diameter of the boss is controlled by the diameter of the 
sketched circle. The height of the boss is controlled by the depth to 
which that circle was extruded when the feature was made.

 Relations: These include such information as parallelism, tangency, 
and concentricity. Historically, this type of information has been 
communicated on drawings via feature control symbols. By 
capturing this in the sketch, SOLIDWORKS enables you to fully 
capture your design intent up front, in the model.

 Solid Modeling
A solid model is the most complete type of geometric model used in 
CAD systems. It contains all the wire frame and surface geometry 
necessary to fully describe the edges and faces of the model. In addition 
to the geometric information, it has the information called topology that 
relates the geometry together. An example of topology would be which 
faces (surfaces) meet at which edge (curve). This intelligence makes 
operations such a filleting as easy as selecting an edge and specifying a 
radius.
9
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SOLIDWORKS Basics and the User Interface
 Fully Associative
A SOLIDWORKS model is fully associative to the drawings and 
assemblies that reference it. Changes to the model are automatically 
reflected in the associated drawings and assemblies. Likewise, you can 
make changes in the context of the drawing or assembly and know that 
those changes will be reflected back in the model.

 Constraints
Geometric relationships such as parallel, perpendicular, horizontal, 
vertical, concentric, and coincident are just some of the constraints 
supported in SOLIDWORKS. In addition, equations can be used to 
establish mathematical relationships among parameters. By using 
constraints and equations, you can guarantee that design concepts such 
as through holes or equal radii are captured and maintained.

 Design Intent
The final italicized term is design intent. This subject is worthy of its 
own section, as follows.

Design Intent In order to use a parametric modeler like SOLIDWORKS efficiently, 
you must consider the design intent before modeling. Design intent is 
your plan as to how the model should behave when it is changed. The 
way in which the model is created governs how it will be changed. 
Several factors contribute to how you capture design intent:

 Automatic (sketch) Relations
Based on how geometry is sketched, these relations can provide 
common geometric relationships between objects such as parallel, 
perpendicular, horizontal, and vertical.

 Equations
Used to relate dimensions algebraically, they provide an external way 
to force changes.

 Added Relations
Added to the model as it is created, relations provide another way to 
connect related geometry. Some common relations are concentric, 
tangent, coincident, and collinear.

 Dimensioning
Consider your design intent when applying dimensions to a sketch. 
What are the dimensions that should drive the design? What values are 
known? Which are important for the production of the model? The way 
dimensions are applied to the model will determine how the geometry 
will change if modifications are made.

Consider the design intent in the following examples.
10
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Examples of 
Design Intent

The design intent of each sketch below is slightly different. How will 
the geometry be affected if the overall plate width, 100mm, is 
changed? 

A sketch dimensioned like this will keep 
the holes 20mm from each end regardless 
of the width of the plate. 

Baseline dimensions like this will keep the 
holes positioned relative to the left edge of 
the plate. The positions of the holes are not 
affected by changes in the overall width of 
the plate.

Dimensioning from the edge and from 
center to center will maintain the distance 
between the hole centers and allow it to be 
changed that way. 

How Features 
Affect Design 
Intent

Design intent is affected by more than just 
how a sketch is dimensioned. The choice of 
features and the modeling methodology are 
also important. For example, consider the 
case of a simple stepped shaft as shown at 
the right. There are several ways a part like 
this could be built and each way creates a 
part that is geometrically identical.

The “Layer Cake” 
Approach

The layer cake approach builds the part one piece at a time, adding each 
layer, or feature, onto the previous one, like this:

Changing the thickness of one layer has a ripple effect, changing the 
position of all the other layers that were created after it.
11
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The “Potter’s 
Wheel” Approach

The potter’s wheel approach builds the part as 
a single, revolved feature. A single sketch 
representing the cross section includes all the 
information and dimensions necessary to make 
the part as one feature. While this approach 
may seem very efficient, having all the design 
information contained within a single feature 
limits flexibility and can make changes awkward.

The Manufacturing 
Approach

The manufacturing approach to modeling mimics the way the part 
would be manufactured. For example, if this stepped shaft was turned 
on a lathe, you would start with a piece of bar stock and remove 
material using a series of cuts.

There is not really a right or wrong answer when trying to determine 
which approach to use. SOLIDWORKS allows for great flexibility and 
making changes to models is relatively easy. But creating models with 
design intent in mind will result in well built documents that are easily 
modifiable and well suited for re-use, making your job easier.

File References SOLIDWORKS creates files that are compound documents that 
contain elements from other files. File references are created by linking 
files rather than duplicating information in multiple files.

Referenced files do not have to be stored with the document that 
references them. In most practical applications, the referenced 
documents are stored in multiple locations on the computer or network. 
SOLIDWORKS provides several tools to determine the references that 
exist and their location.
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Object Linking and 
Embedding (OLE)

In the Windows environment, information sharing between files can be 
handled either by linking or embedding the information.

The main differences between linked objects and embedded objects are 
where the data is stored and how you update the data after you place it 
in the destination file.

Linked Objects When an object is linked, information is updated only if the source file 
is modified. Linked data is stored in the source file. The destination file 
stores only the location of the source file (an external reference), and it 
displays a representation of the linked data. 

Linking is also useful when you want to include information that is 
maintained independently, such as data collected by a different 
department.

Embedded Objects When you embed an object, information in the destination file doesn't 
change if you modify the source file. Embedded objects become part of 
the destination file and, once inserted, are no longer part of the source 
file.

File Reference 
Example

The many different types of external references created by 
SOLIDWORKS are shown in the following graphic. Some of the 
references can be linked or embedded. 
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Opening Files SOLIDWORKS is a RAM-resident CAD system. Whenever a file is 
opened, it is copied from its storage location to the computer’s Random 
Access Memory or RAM. All changes to the file are made to the copy 
in RAM and only written back to the original files during a Save 
operation.

Computer Memory To better understand where files are stored and which copy of the file 
we are working on, it is important to differentiate between the two main 
types of computer memory.

Random Access 
Memory

Random Access Memory (RAM) is the volatile memory of the 
computer. This memory only stores information when the computer is 
operating. When the computer is turned off, any information in RAM is 
lost.

Fixed Memory Fixed memory is all the non-volatile memory. This includes computer 
hard drives, flash drives and CD/DVD drives. Fixed memory holds its 
information even when the computer is not running.

Save

Open

Fixed Disk
RAM
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The 
SOLIDWORKS 
User Interface

The SOLIDWORKS user interface is a native Windows interface, and 
as such behaves in the same manner as other Windows applications. 
Some of the more important aspects of the interface are identified 
below.

Welcome Dialog 
Box

The Welcome dialog box opens with SOLIDWORKS to provide 
convenient ways to create new documents, open existing documents, 
and access SOLIDWORKS resources and news.

Note This dialog box can also be set to Do not show on startup.

Graphics Area

Document Window Reference Triad

CommandManager Tabs

FeatureManager
design tree

Status Bar

Task Pane

Heads-up

Menu Bar pull-downs

View Toolbar
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Pull-down Menus The Pull-down menus provide access to many of the commands that 
the SOLIDWORKS software offers. Float over the right facing arrow 
to access the menus. Click the pushpin to keep the menus open. 

When a menu item has a right-pointing 

arrow like this: , it 
means that there is a sub-menu associated 
with that choice.

When a menu item is followed by ellipses 

like this: , it means 
that the option opens a dialog box with 
additional choices or information.

Customizing 
Pull-down Menus

When the Customize Menu item is selected, each 
item appears with a check box. Clearing the check 
box removes the associated item from the menu.

Using the 
Command 
Manager

The CommandManager is a set of icons divided into tabs that are 
geared towards specific tasks. For example, the part version has several 
tabs to access commands related to features, sketches, and so on.

Note The CommandManager can be displayed with or without text on the 
buttons. These images show the Use Large Buttons with Text option. 
16
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Adding and 
Removing 
CommandManager 
Tabs

The default settings display multiple CommandManager tabs for a part 
file. Others can be added or removed by right-clicking on any tab, 
clicking Tabs, and clicking or clearing the tab by name. 

There are different sets of tabs for part, assembly and drawing files. 

FeatureManager 
Design Tree

The FeatureManager design 
tree is a unique part of the 
SOLIDWORKS software 
that visually displays all the 
features in a part or 
assembly. As features are 
created they are added to the 
FeatureManager design tree. 
As a result, the 
FeatureManager design tree 
represents the chronological 
sequence of modeling 
operations. The 
FeatureManager design tree 
also allows access to the 
editing of the features 
(objects) that it contains.

FeatureManager Design Tree
PropertyManager

ConfigurationManager

Hide/
Show
FM

DimXpertManager

Hide/
Show
Display
Pane

DisplayManager
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Show and Hide 
FeatureManager 
Items

Many FeatureManager items (icons and folders) are hidden by default. 
In the image above, only the History, Sensors and Annotations 
folders are shown. 

Click Tools, Options, System Options, and FeatureManager to 
control their visibility using one of the three settings explained below. 

 Automatic - Hide the item when it is empty. 
 Hide - Hide the item at all times. 
 Show - Show the item at all times. 

Tip The CommandManager or PropertyManager can be dragged and 
docked on the top, side or outside of the SOLIDWORKS window or to 
a different monitor. 
18
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PropertyManager Many SOLIDWORKS commands are executed through the 
PropertyManager. The PropertyManager occupies the same screen 
position as the FeatureManager design tree and replaces it when it is in 
use.

The top row buttons contain the 
standard OK and Cancel buttons. 

Below the top row of buttons are 
one or more Group Boxes that 
contain related options. They can 
be opened (expanded) or closed 
(collapsed) and in many cases 
made active or inactive.

Full Path Name The full path name of the document can be 
seen as a tool tip when floating the cursor over 
the file name.

Selection 
Breadcrumbs

Selection Breadcrumbs show the 
hierarchy of objects based on a selected 
piece of geometry. For example, selecting 
a face can lead to a series of objects 
including the feature, sold body, component, subassembly, and finally 
to the top level assembly. 

It also leads to the sketch of the feature and the mates attached to that 
component. 

These visual objects can also be used for access. Right-clicking on the 
boss feature offers several editing tools including Edit Feature and 
Hide.

Note These objects and tools will be discussed in later lessons.

Group Box

Open and active

Open and

Close icon

Cancel
OK

Group Box

Closed and inactive
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Task Pane The Task Pane window contains SOLIDWORKS Resources , 

Design Library , File Explorer , View Palette , 

Appearances, Scenes, and Decals , and Custom Properties  
options. The window appears on the right by default but it can be 
moved and resized. It can be opened/closed, tacked or moved from its 
default position on the right side of the interface.
20
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Opening Labs with 
the File Explorer

You can open parts and assemblies 
required for lab exercises using the File 
Explorer. 

 Open the Task Pane.

 Click File Explorer .
 Expand the Essentials folder used 

for the class files. It should be found 
under the SOLIDWORKS Training 
Files folder.

 Expand the lesson folder 
(Lesson01 for example) followed 
by either the Case Study or 
Exercises folder.

 Double-click a part or assembly file 
to open it.

Heads-up View 
Toolbar

The Heads-up View toolbar is a 
transparent toolbar that contains 
many common view manipulation 
commands. Many of the icons 
(such as the Hide/Show Items 
icon shown) are Flyout Tool 
buttons that contain other options. 
These flyouts contain a small 

down arrow  to access the other 
commands.

Unselectable 
Icons

At times you will notice commands, icons, and menu options that are 
grayed out and unselectable. This is because you may not be working in 
the proper environment to access those options. For example, if you are 
working in a sketch (Edit Sketch mode), you have full access to all the 
sketch tools. However, you cannot select the icons such as fillet or 
chamfer on the Features tab of the CommandManager. This design 
helps the inexperienced user by limiting the choices to only those that 
are appropriate.
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To Preselect or Not? As a rule, the SOLIDWORKS software does not require you to 
preselect objects before opening a menu or dialog box. For example, if 
you want to add some fillets to the edges of your model, you have 
complete freedom – you can select the edges first and then click the 
Fillet tool or you can click the Fillet tool and then select the edges. The 
choice is yours.

Mouse Buttons The left, right and middle mouse buttons have distinct meanings in 
SOLIDWORKS.

 Left
Select objects such as geometry, menus buttons, and objects in the 
FeatureManager design tree.

 Right
Activates a context sensitive shortcut menu. The contents of the menu 
differ depending on what object the cursor is over. These menus also 
represent shortcuts to frequently used commands.

Shortcut Menu At the top of the Shortcut Menu is the 
Context Toolbar. It contains some of the most 
commonly used commands in icon form.

Below it is the pull-down menu. It contains 
other commands that are available in the 
context of the selection, in this example a face.

Note The Context toolbar will also become available as you make selections 
with the left mouse button. It provides quick access to common 
commands.

 Middle
Dynamically rotates, pans or zooms a part or assembly. Pans a drawing.

Keyboard 
Shortcuts

Some menu items indicate a keyboard shortcut like this: 

 

SOLIDWORKS conforms to standard Windows conventions for such 
shortcuts as Ctrl+O for File, Open; Ctrl+S for File, Save; Ctrl+Z for 
Edit, Undo and so on. In addition, you can customize SOLIDWORKS 
by creating your own shortcuts.
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Multiple Monitor 
Displays

SOLIDWORKS can take advantage of multiple monitor displays to 
span monitors and to move document windows or menus to a different 
monitor. 

Spanning Monitors Click Span Displays  on the top bar of the SOLIDWORKS window 
to stretch the display across both monitors. 

Fitting to a Monitor Click either Click to Tile Left  or Click to Tile Right  on the top bar 
of a document to fit it to the left or right monitor. 

System Feedback Feedback is provided by a symbol attached to the 
cursor arrow indicating what you are selecting or 
what the system is expecting you to select. As the 
cursor floats across the model, feedback will come in 
the form of symbols, riding next to the cursor. The 
illustration at the right shows some of the symbols: 
vertex, edge, face and dimension. 

Vertex

Edge

Face

Dimension
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Options Located on the Tools menu, the Options dialog box enables you to 
customize the SOLIDWORKS software to reflect such things as your 
company’s drafting standards as well as your individual preferences 
and work environment.

Tip Use the search bar in the upper right of the Options dialog box to find 
system options and document properties. Type the label of the check 
box, radio button, or other option to locate the page where the option 
resides.
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Customization You have several levels of customization. They are:

 System options
The options grouped under the heading System Options are saved on 
your system and affect every document you open in your 
SOLIDWORKS session. System settings allow you to control and 
customize your work environment. For example, you might like 
working with colored viewport background. I don’t. Since this is a 
system setting, parts or assemblies opened on your system would have 
a colored viewport. The same files opened on my system would not.

 Document properties
These settings are applied to the individual document. For example, 
units, drafting standards, and material properties (density) are all 
document settings. They are saved with the document and do not 
change, regardless of whose system the document is opened on.

 Document templates
Document templates are pre-defined documents that were set up with 
certain specific settings. For example, you might want two different 
templates for parts. One with English settings such as ANSI drafting 
standards and inch units, and one with metric settings such as 
millimeters units and ISO drafting standards. You can set up as many 
different document templates as you need. They can be organized into 
different folders for easy access when opening new documents. You 
can create document templates for parts, assemblies, and drawings.

 Object
Many times the properties of an individual object can be changed or 
edited. For example, you can change the default display of a dimension 
to suppress one or both extension lines, or you can change the color of a 
feature.

Search The Search option can be used to find information from 
SOLIDWORKS Help, Commands, Files and Models on your system 
by searching for any part of the name (requires Windows Desktop 
Search engine), or MySolidWorks information. Search using this 
procedure:

 Choose which type of search you would like to do.
 Type a name or partial name into the Search box 

and click the search icon . 
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Lesson 2
Introduction to Sketching

Upon successful completion of this lesson, you will be able to:

 Create a new part.

 Insert a new sketch.

 Add sketch geometry.

 Establish sketch relations between pieces of geometry.

 Understand the state of the sketch.

 Extrude the sketch into a solid.
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2D Sketching This lesson introduces 2D sketching, the basis of modeling in 
SOLIDWORKS.

Sketches are used for all sketched features in SOLIDWORKS 
including:

 Extrusions  Revolves
 Sweeps  Lofts

The illustration below shows how a given sketch can form the basis of 
several different types of features.

In this lesson, only extruded features will be covered. The others will 
be covered in detail in later lessons or courses.

Stages in the 
Process

Every sketch has several characteristics that contribute to its shape, size 
and orientation.

 New part
New parts can be created in inch, millimeter or other units. Parts are 
used to create and hold the solid model.

 Sketches
Sketches are collections of 2D geometry that are used to create solid 
features.

 Sketch geometry
Types of 2D geometry such as lines, circles and rectangles that make 
up the sketch.

 Sketch relations
Geometric relationships such as horizontal and vertical are applied to 
the sketch geometry. The relations restrict the movement of the entities.

Extrude Revolve Sweep Loft
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 State of the sketch
Each sketch has a status that determines whether it is ready to be used 
or not. The state can be fully-, under- or over defined.

 Sketch tools
Tools can be used to modify the sketch geometry that has been created. 
This often involves trimming or extending entities.

 Extruding the sketch
Extruding uses the 2D sketch to create a 3D solid feature.

Procedure The process in this lesson includes sketching and extrusions. To begin 
with, a new part file is created.

Introducing: 
New Part

The New tool creates a new SOLIDWORKS document from a 
selection of part, assembly or drawing templates. There are several 
training templates in addition to the default ones. 

Where to Find It  Menu Bar: New 
 Menu: File, New
 Keyboard Shortcut: Ctrl+N

1 New part.

Click New  and click the Part_MM template from the Training 
Templates tab on the New SOLIDWORKS Document dialog box, and 
click OK.

The part is created with the settings of the template including the units. 
This part template uses millimeters as the units. You can create and 
save any number of different templates, all with different settings.
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Saving Files Saving files writes the file information in RAM to a location on a fixed 
disk. SOLIDWORKS provides three options for saving files. Each has 
a different effect on file references.

Save Copy the file in RAM to the fixed disk, leaving the copy in RAM open. 
If this file is being referenced by any open SOLIDWORKS files, there 
are no changes to the reference.

Where to Find It  Menu Bar: Save 
 Menu: File, Save
 Keyboard Shortcut: Ctrl+S

Save As Copy the file in RAM to the fixed disk under a new name or file type, 
replacing the file in RAM with the new file. The old file in RAM is 
closed without saving. If this file is being referenced by any open 
SOLIDWORKS files, you should update the references to this new file.

Save As Copy to 
Disk

Copy the file in RAM to the fixed disk under a new name or file type, 
leaving the original in RAM open. If this file is being referenced by any 
open SOLIDWORKS files, you should not update the references to this 
new file.

Save As Copy and 
Open

Copy the file in RAM to the fixed disk under a new name or file type, 
leaving both the copy and the original open.

2 Saving a part.

Click Save  and file the part under the name Plate. The extension, 
*.sldprt, is added automatically. Click Save.
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What are We 
Going to 
Sketch?

The first feature of a part will be created in this section. That initial 
feature is just the first of many features needed to complete the part.

Sketching Sketching is the act of creating a 2D profile comprised of wireframe 
geometry. Typical geometry types are lines, arcs, circles and ellipses. 
Sketching is dynamic, with feedback from the cursor to make it easier.

Default Planes To create a sketch, you must choose a plane on which to sketch. The 
system provides three initial planes by default. They are Front Plane, 
Top Plane, and Right Plane.

Introducing: Sketch When creating a new sketch, the Sketch tool opens the sketcher on the 
currently selected plane or planar face. You also use the Sketch tool to 
edit an existing sketch.

If you have not preselected a face or plane before activating the Sketch 

tool, the cursor  appears indicating that you should select a face or 
plane.

Where to Find It  CommandManager: Sketch > Sketch 
 Menu: Insert, Sketch
 Shortcut Menu: Right-click a plane or planar face and click 

Sketch
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3 Open a new sketch. 

Click . This will show all three 
default planes for selection in a 
Trimetric orientation. A 
Trimetric orientation is a pictorial 
view that is oriented so the three 
mutually perpendicular planes 
appear unequally foreshortened.

From the screen, choose the Front 
Plane. The plane will highlight and 
rotate.

Note The Reference Triad (lower left corner) shows the orientation of 
the model coordinate axes (red-X, green-Y and blue-Z) at all 
times. It can help show how the view orientation has been 
changed relative to the Front Plane.

4 Sketch active.
The selected Front Plane 
rotates so it is parallel to the 
screen.

The  symbol represents 
the sketch origin. It is 
displayed in the color red, 
indicating that it is active.

Introducing: 
Confirmation Corner

When many SOLIDWORKS commands are active, a symbol or a set of 
symbols appears in the upper right corner of the graphics area. This 
area is called the Confirmation Corner.

Sketch Indicator When a sketch is active, or open, the Confirmation Corner 
displays two symbols. One looks like a sketch. The other is a 
red X. These symbols provide a visual reminder that you are 
active in a sketch. Clicking the sketch symbol exits the sketch and saves 
any changes. Clicking the red X exits the sketch and discards any 
changes.

When other commands are active, the confirmation corner 
displays a check mark and an X. The check mark executes the 
current command. The X cancels the command.

Press the D key to move the confirmation corner to the pointer 
location. 
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Sketch Entities SOLIDWORKS offers a rich variety of sketch tools for creating profile 
geometry. In this lesson, only one of the most basic shapes will be used: 
Lines.

Sketch Geometry The following chart lists some of the sketch entities that are available:

Sketch Entity Button Geometry Example

Line

Circle

Perimeter Circle

Centerpoint Arc

Tangent Arc

3 Point Arc

Ellipse

Partial Ellipse

Parabola

Spline

Straight Slot

Centerpoint 
Straight Slot

3 Point Arc Slot

Centerpoint Arc 
Slot

Polygon
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Basic Sketching The best way to begin sketching is by using the most fundamental 
shape, the Line.

The Mechanics of 
Sketching

To sketch geometry, there are two techniques that can be used:

 Click-Click
Position the cursor where you want the line to start. Click (press 
and release) the left mouse button. Move the cursor to where you 
want the line to end. A preview of the sketch entity will follow the 
cursor like a rubber band. Click the left mouse button a second 
time. Additional clicks create a series of connected lines. 

 Click-Drag
Position the cursor where you want the line to start. Press and hold 
the left mouse button. Drag the cursor to where you want the sketch 
entity to end. A preview of the sketch entity will follow the cursor 
like a rubber band. Release the left mouse button.

Corner Rectangle

Center Rectangle 
(Construction 
geometry can be 
added to any type)

3 Point Corner 
Rectangle

3 Point Center 
Rectangle

Parallelogram

Point

Centerline

Sketch Entity Button Geometry Example
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Introducing: 
Insert Line

The Line tool creates single line segments in a sketch. Horizontal and 
vertical lines can be created while sketching by watching for the 
feedback symbols on the cursor. 

Where to Find It  CommandManager: Sketch > Line 
 Menu: Tools, Sketch Entities, Line
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Line 

Introducing: Sketch 
Relations

Sketch Relations are used to force a behavior on a sketch element 
thereby capturing design intent. They will be discussed in detail in 
Sketch Relations on page 41.

5 Sketch a line.

Click Line  and sketch a horizontal line from the origin. The  
symbol appears at the cursor, indicating that a Horizontal relation will 
be automatically added to the line. The number indicates the length of 
the line. Click again to end the line. 

Important! Do not be too concerned with making the line the exact length. 
SOLIDWORKS software is dimension driven – the dimensions control 
the size of the geometry, not the other way around. Make the sketch 
approximately the right size and shape and then use dimensions to 
make it exact.

6 Line at angle.
Starting at the end of the first line, 
sketch a line at an angle.

Note The pencil icon at the cursor will be omitted for clarity. 
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Inference Lines 
(Automatic 
Relations)

In addition to the relation symbols, dashed inference lines will also 
appear to help you “line up” with existing geometry. These lines 
include existing line vectors, normals, horizontals, verticals, tangents 
and centers.

Note that some lines capture actual 
geometric relations, while others 
simply act as a guide or reference 
when sketching. A difference in the 
color of the inference lines will 
distinguish them. In the picture at the 
right, the lines labeled “A” are 
yellow, and if the sketch line snaps to 
them, a tangent or perpendicular 
relationship will be captured.

The line labeled “B” is blue. It only provides a reference, in this case 
vertical, to the other endpoint. If the sketch line is ended at this point, 
no vertical relation will be captured.

Note The display of Sketch Relations that appears automatically can be 
toggled on and off using View, Hide/Show, Sketch Relations. It will 
remain on during the initial phase of sketching.

7 Inference lines.
Create a line moving in a direction per-
pendicular to the previous line. This 
causes inference lines to be displayed 
while sketching. A Perpendicular rela-
tion is created between this line and the 
last one.

The cursor symbol indicates that you 
are capturing a perpendicular relation. 

8 Perpendicular.
Create another perpendicular line from 
the last endpoint, again capturing a 
perpendicular relation.

AB
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9 Reference.
Create a horizontal line from the last 
endpoint. Blue inferences are strictly for 
reference and do not create relations. 
They are displayed in blue. This 
reference is used to align the endpoint 
vertically with the origin.

10 Close.
Close the sketch with a final line 
connected to the starting point of the 
first line. 

A closed contour is confirmed with 
shading. 

Note Click Shaded Sketch Contours  from the Sketch 
CommandManager to toggle the shading on and off.

Sketch Feedback The sketcher has many 
feedback features. The 
cursor will change to 
show what type of entity 
is being created. It will 
also indicate what selections on the existing geometry, such as end, 
coincident (on) or midpoint, are available using an orange dot when the 
cursor is on it. 

Three of the most common feedback symbols are:

Symbol Icon Description

Endpoint Yellow concentric circles appear at the Endpoint 
when the cursor is over it.

Midpoint The Midpoint appears as a yellow square. It changes 
to orange when the cursor hovers over the line.

Coincident 
(On Edge)

The quadrant points of the circle appear with a 
concentric circle over the centerpoint.
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Turning Off Tools Turn off the active tool using one of these techniques:

 Menu Bar: Select 
 CommandManager: Click the active tool to toggle the tool off
 Keyboard Shortcut: Esc

11 Turn off the tool.
Press the Esc key on the keyboard to turn off the line tool. 

Status of a Sketch Sketches can be in one of five definition states at any time. The status 
of a sketch depends on geometric relations between geometry and the 
dimensions that define it. The three most common states are:

Under Defined The sketch is inadequately defined, but the sketch can still be used to 
create features. This is good because many times in the early stages of 
the design process, there isn’t sufficient information to fully define the 
sketch. When more information becomes available, the remaining 
definition can be added at a later time. Under defined sketch geometry 
is blue (by default).

Fully Defined The sketch has all the information necessary to fully describe the 
geometry. Fully defined geometry is black (by default). As a general 
rule, when a part is released to manufacturing, the sketches within it 
should be fully defined.

Over Defined The sketch has duplicate dimensions or conflicting relations and it 
should not be used until repaired. Extraneous dimensions and relations 
should be deleted. Over defined geometry is red (by default).

Note The two other states are No Solution Found and Invalid Solution 
Found. They both indicate that there are errors that must be repaired. 

Rules That 
Govern 
Sketches

Different types of sketches will yield different results. Several different 
types are summarized in the table below. It is important to note that 
some of the techniques shown in the table below are advanced 
techniques that are covered either later in this course, or in other 
advanced courses. 

Sketch Type Description Special Considerations

A typical “standard” 
sketch that is a neatly 
closed contour.

None required.
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12 Current sketch status.
The sketch is Under Defined 
because some of the geometry is 
blue. Note that endpoints of a line 
can be a different color and 
different state than the line itself. 
For example, the vertical line at 
the origin is black because it is (a) 
vertical, and (b) attached to the 
origin. However, the uppermost 

Multiple nested 
contours creates a boss 
with an internal cut.

None required.

Open contour creates a 
thin feature with 
constant thickness.

None required. 

Corners are not neatly 
closed. They should be.

Use the Contour Select Tool. 
Although this sketch will work, it 
represents poor technique and sloppy 
work habits. Do not do it.

Sketch contains a self-
intersecting contour.

Use the Contour Select Tool. If both 
contours are selected, this type of sketch 
will create a Multibody Solid. See Multi-
body Solids in the Advanced Part Model-
ing course.
Although this will work, multibodies are 
an advanced modeling technique that you 
should not use until you have more 
experience.

The sketch contains 
disjoint contours.

This type of sketch can create a Multibody 
Solid. See Multibody Solids in the 
Advanced Part Modeling course.
Although this will work, multibodies are 
an advanced modeling technique that you 
should not use until you have more 
experience.
39



Lesson 2 SOLIDWORKS Education 2023
Introduction to Sketching
endpoint is blue because the length of the line is under defined.

13 Dragging.
Under defined geometry (blue) can be 
dragged to new locations. Fully defined 
geometry cannot. Drag the uppermost 
endpoint to change the shape of the 
sketch. The dragged endpoint appears 
as a blue dot.

14 Undo the change.

Undo the last command by clicking the Undo  option. You can see 
(and select from) a list of the last few commands by clicking the down 
arrow menu. The keyboard shortcut for Undo is Ctrl+Z.

Tip You can also Redo  a change, which reverts it back to the state prior 
to undo. The shortcut for redo is Ctrl+Y.

Design Intent The design intent, as discussed earlier, governs how the part is built and 
how it will change. In this example, the sketch shape must be allowed 
to change in these ways:

What Controls 
Design Intent?

Design intent in a sketch is captured and controlled by a combination of 
two things:

 Sketch relations
Create geometric relationships such as parallel, collinear, 
perpendicular, or coincident between sketch elements.

 Dimensions
Dimensions are used to define the size and location of the sketch 
geometry. Linear, radial, diameter and angular dimensions can be 
added.

To fully define a sketch and capture the desired design intent requires 
understanding and applying a combination of relations and dimensions.

Tip The relations are visible because View, Hide/Show, Sketch Relations 
is toggled on. If it is turned off, clicking the geometry will show the 
relations and open the PropertyManager.
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The relations will be toggled off at this point, but they will still appear 
on selected geometry. 

Desired Design 
Intent

In order for the sketch to change properly, the correct relations and 
dimensions are required. The required design intent is listed below:

Note The shading has been removed from table images for clarity.

Sketch 
Relations

Sketch Relations are used to force a behavior on a sketch element 
thereby capturing design intent. Some are automatic, others can be 
added as needed. In this example, we will look at the relations on one 
of the lines and examine how they affect the design intent of the sketch.

Automatic Sketch 
Relations

Automatic relations are added as geometry is sketched. We saw this as 
we sketched the outline in the previous steps. Sketch feedback tells you 
when automatic relations are being created.

Horizontal and vertical 
lines

Angle value

Parallel Distance value

Right-angle corners, or 
perpendicular lines

Overall length value
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Added Sketch 
Relations

For those relations that cannot be added automatically, tools exist to 
create relations based on selected geometry.

Introducing: 
Display/Delete 
Relations

Display/Delete Relations shows the relations in a sketch. It also 
enables you to remove relations.

Where to Find It  CommandManager: Sketch > Display/Delete Relations 
 Menu: Tools, Relations, Display/Delete
 Properties PropertyManager: Existing Relations

15 Display the relations associated with a line.
Click the uppermost angled line and the 
PropertyManager opens. The Existing Relations 
box in the PropertyManager lists the geometric 
relations that are associated with the selected line.

16 Remove the relation.
Remove the uppermost relation by clicking the 
relation, either the symbol or in the 
PropertyManager, and pressing the Delete key. 
If the symbol is selected, it changes color and 
displays the entities it controls.

17 Drag the endpoint.
Because the line is no longer constrained to be 
perpendicular, the sketch will behave 
differently when you drag it. Compare this to 
how the sketch behaved when you dragged it in 
step 13.
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Examples of 
Sketch Relations

There are many types of Sketch Relations. Which ones are valid 
depends on the combination of geometry that you select. Selections can 
be the entity itself, endpoints or a combination. Depending on the 
selection, a limited set of options is made available. The following 
chart shows some examples of sketch relations. This is not a complete 
list of all geometric relations. Additional examples will be introduced 
throughout this course. 

Relation Before After

Coincident between 
a line and an 
endpoint.

Merge between two 
endpoints.

Parallel between 
two or more lines.

Perpendicular 
between two lines.

Collinear between 
two or more lines.
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Horizontal applied 
to one or more lines.

Horizontal between 
two or more 
endpoints.

Vertical applied to 
one or more lines.

Vertical between 
two or more 
endpoints.

Equal between two 
or more lines.

Relation Before After
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Introducing: Add 
Relations

Add Relations is used to create a geometric relationship such as 
parallel or collinear between sketch elements.

Where to Find It  CommandManager: Sketch > Display/Delete Relations  > 

Add Relation 
 Menu: Tools, Relations, Add
 Shortcut Menu: Select one or more sketch objects and click a 

relation

Selecting Multiple 
Objects

As you learned in a previous lesson, you select objects with the left 
mouse button. What about when you need to select more than one 
object at a time? When selecting multiple objects, SOLIDWORKS 
follows standard Microsoft® Windows conventions: hold down the Ctrl 
key while selecting the objects.

Equal between two 
or more arcs or 
circles.

Midpoint between a 
line and an endpoint.

Tangent between a 
line and an arc/circle 
or two arc/circles.

Tangent between a 
line and an arc using 
the common 
endpoint.

Relation Before After
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18 Add a relation.
Hold down Ctrl and click the two lines. The con-
text menu shows only those relations that are 
valid for the geometry selected. 
Click Make Perpendicular. 

19 Drag the sketch.
Drag the sketch back into approximately 
its original shape.

Dimensions Dimensions are another way to define geometry and capture design 
intent in the SOLIDWORKS system. The advantage of using a 
dimension is that it is used to both display the current value and change 
it.

Introducing:
Smart Dimensions

The Smart Dimension tool determines the proper type of dimension 
based on the geometry chosen, previewing the dimension before 
creating it. For example, if you pick an arc the system will create a 
radial dimension. If you pick a circle, you will get a diameter 
dimension, while selecting two parallel lines will create a linear 
dimension between them. In cases where the Smart Dimension tool 
isn’t quite smart enough, you have the option of selecting endpoints 
and moving the dimension to different measurement positions.

Where to Find It  CommandManager: Sketch > Smart Dimension 
 Menu: Tools, Dimensions, Smart
 Shortcut Menu: Right-click in the graphics area and click 

Smart Dimension 
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Dimensioning: 
Selection and 
Preview

As you select sketch geometry with the dimension tool, the system 
creates a preview of the dimension. The preview enables you to see all 
the possible options by simply moving the mouse after making the 
selections. Clicking the left mouse button places the dimension in its 

current position and orientation. Clicking the right mouse button  
locks only the orientation, allowing you to move the text before final 
placement by clicking the left mouse button.

With the dimension tool and two endpoints selected, below are three 
possible orientations for a linear dimension. The value is derived from 
the initial point to point distance and may change based on the 
orientation selected.

Note Another option is to select the geometry that is to be dimensioned and 

click Auto Insert Dimension .

20 Adding a linear dimension.

Click Smart Dimension  and 
click the line shown and right-click 

 to lock in the orientation. Click 
again to place the text as shown. The 
dimension appears with a Modify 
tool displaying the current length of 
the line. The thumbwheel is used to 
incrementally increase/decrease the 
value using the middle mouse 
button. Or with the text highlighted, you can type a new value to 
change it directly.

Endpoints
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Note A midpoint location can be inadvertently selected 
instead of the geometry itself. To avoid this, select the 
geometry slightly off center.

The Modify Tool The modify tool that appears when you create or 
edit a dimension (parameter) has several 
options. The options available to you are:

 Dial the value up or down.

 Save the current value and exit the dialog box.

 Restore the original value and exit the dialog box.

 Rebuild the model with the current value.

 Reverse the sense of the dimension.

 Change the thumbwheel increment value.

 Mark the dimension for drawing import.

Note The dimension name can be changed in the upper section of the dialog 
box.

Units in the Modify 
Tool

Units different from the part units can be 
selected for the input. When typing the 
value, select the Units > menu and select 
input units.

Note Unit abbreviations and fractions can also be typed into the value field 
after the numeric value (for instance 0.375in or 3/8”).
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21 Set the value. 
Change the value to 20 and click the 

Save  option. The dimension 
forces the length of the line to be 
20mm.

Tip Pressing Enter has the same effect as clicking the Save  button.

22 Linear dimensions.
Add additional linear dimensions 
to the sketch as shown.

Dimensioning Tip When you dimension a sketch, 
start with the smallest dimension 
first, and work your way to the 
largest. 
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Angular 
Dimensions

Angular dimensions can be created using the same dimension tool used 
to create linear, diameter and radial dimensions. Select either two lines 
that are both non-collinear and non-parallel, or select three non-
collinear endpoints.

Depending on where you place the angular dimension, you can get the 
interior or exterior angle, the acute angle, or the oblique angle. Possible 
placement options:

23 Angular dimension.
Using the dimension tool, create 
the angular dimension shown and 
set the value to 125°.

The sketch is fully defined. See 
Fully Defined on page 38.
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Instant 2D Instant 2D can be used to manipulate sketch dimensions, dynamically 
changing the values using a graphic Ruler. 

Note The ruler is displayed to guide the drag. Moving closer to the ruler 
gradients allows you to snap to them. 

Where to Find It  CommandManager: Sketch > Instant 2D 

24 Select dimension.
The Instant 2D tool is on by default. Select the 125° dimension.

Click and hold the round ball handle at the tip of the arrow. 

The value of the dimension, and the geometry, changes dynamically as 
the handle is dragged.

Drag the value to 135° using the ruler. 

Extrude Once the sketch is completed, it can be extruded to create the first 
feature. There are many options for extruding a sketch including the 
start and end conditions, draft and depth of extrusion, which will be 
discussed in more detail in later lessons. Typically, extrusions take 
place in a direction normal to the sketch plane, in this case the Front 
plane.

Where to Find It  CommandManager: Features > Extruded Boss/Base 
 Menu: Insert, Boss/Base, Extrude
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25 Extrude. 

Click Extruded Boss/Base .

On the Features 
CommandManager tab, the 
options for other methods of 
creating features are listed along 
with Extrude and Revolve. They 
are unavailable because this 
sketch does not meet the 
conditions necessary for creating 
these types of features. 

The view automatically changes 
to Trimetric and a preview of the feature is shown at the default depth. 

Drag Handles and 
Rulers

Handles  appear that can be 
used to drag the preview to the 
desired depth. The handle is 
colored while dragging in the 
active direction. A callout shows 
the current depth value and a 
ruler.

26 Extrude Feature settings.
Change the settings as shown.

 End Condition = Blind

  (Depth) = 6mm 

Click OK  to create the feature.
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Tip The OK button  is just one way to accept and complete the process. 
A second is to press the Enter key. 

A third method is the set of OK/Cancel buttons in the 
Confirmation Corner of the graphics area, or press the D key 
to bring it to the cursor.

A fourth method is to right-click and click OK 
from the shortcut menu.

27 Completed feature.
The completed feature is the first solid, 
or feature of the part. The sketch is 
absorbed into the Extrude1 feature.

Note Click the  preceding the feature name to expand 
the feature and show the sketch. 

28 Save and close.

Click Save  then click File, Close to close the part.
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Sketching 

Guidelines†
Following is a collection of “rules of thumb” or best practices for 
sketching of which all SOLIDWORKS users should be aware. Some of 
these tips are covered in substantial detail in subsequent lessons within 
this book.

 Keep your sketches simple. Simple sketches are easier to edit, less 
likely to develop errors, and help with downstream features such as 
configurations. 

 Make use of the origin in your first sketch.

 The first sketch of a new part should represent the main profile of 
the part. 

 Create sketch geometry first, add geometric relationships second, 
and then add your dimensions last. Dimensions can sometimes 
interfere with the addition of required relations.

 Use geometric relations wherever possible to maintain design 
intent.

 Draw the sketch to approximately the right scale to prevent errors 
or geometry overlap when you start adding dimensions.

 Add or edit dimensions on the closest / smallest geometry first, then 
work your way to the outer / larger geometry to prevent geometry 
overlap.

 Use relations, equations, and global variables to reduce the number 
of independent dimensions needed. 

 Take advantage of symmetry. Use the Mirror or Dynamic Mirror 
sketch tool to mirror sketch elements and add symmetrical 
relations. 

 Be flexible. It may be necessary to change the order in which 
you’re adding dimensions or relations. Drag the sketch geometry 
closer to the required location before adding dimensions.

 Fix errors as they occur. Use SketchXpert and Check Sketch for 
Feature which can quickly help you identify problems and correct 
them.

† Thanks to Joe Medeiros, Javelin Technologies.
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Exercise 1:
Sketch and 
Extrude 1 

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create this part. 

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic 

Relations) on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters 

1 New part. 
Create a new part using the Part_MM template.

2 Sketch. 
Create this sketch on the Front Plane using lines, automatic relations 
and dimensions. 

3 Extrude. 
Extrude the sketch 50mm in 
depth. 

4 Save and close the part. 
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Exercise 2:
Sketch and 
Extrude 2 

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create this part. 

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic 

Relations) on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters 

1 New part. 
Create a new part using the Part_MM template.

2 Sketch. 
Create this sketch on the Front Plane using lines, automatic relations 
and dimensions. 

3 Extrude. 
Extrude the sketch 50mm in 
depth. 

4 Save and close the part. 
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Exercise 3:
Sketch and 
Extrude 3

Create this part using the information 
and dimensions provided. Sketch and 
extrude profiles to create this part. 

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic 

Relations) on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters 

1 New part. 
Create a new part using the Part_MM template.

2 Sketch. 
Create this sketch on the Front Plane using lines, automatic relations 
and dimensions. 

3 Extrude. 
Extrude the sketch 25mm in depth. 

4 Save and close the part. 
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Exercise 4:
Sketch and 
Extrude 4

Create this part using the information 
and dimensions provided. Sketch and 
extrude profiles to create this part. 

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic 

Relations) on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters 

1 New part. 
Create a new part using the Part_MM template.

2 Sketch. 
Create this sketch on the 
Front Plane using lines, 
automatic relations and 
dimensions. 

3 Extrude. 
Extrude the sketch 100mm in depth. 

4 Save and close the part. 
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Exercise 5:
Sketch and 
Extrude 5

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create the part.

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic Relations) on 

page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters

1 New part.
Create a new part using the Part_MM template.

2 Sketch.
Create this sketch on the Front Plane using lines, automatic relations 
and dimensions.

Fully define the sketch.

3 Extrude.
Extrude the sketch 25mm in 
depth.

4 Save and close the part.
59



Exercise 6 SOLIDWORKS Education 2023
Sketch and Extrude 6
Exercise 6:
Sketch and 
Extrude 6

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create the part.

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic Relations) 

on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters

1 New part.
Create a new part using the Part_MM template.

2 Automatic relations.
Create this sketch on the Front Plane using lines and automatic 
relations. Show the Perpendicular and Vertical relations.

3 Dimensions.
Add dimensions to fully define the 
sketch.

4 Extrude.
Extrude the sketch 12mm.

5 Save and close the part.
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Upon successful completion of this lesson, you will be able to:

 Choose the best profile for sketching.

 Choose the proper sketch plane.

 Extrude a sketch as a cut.

 Create Hole Wizard holes.

 Insert fillets on a solid.

 Use the editing tools Edit Sketch, Edit Feature and Rollback. 

 Make a basic drawing of a part.

 Make a change to a dimension.

 Demonstrate the associativity between the model and its drawings.
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Basic Modeling This lesson discusses the 
considerations that you 
make before creating a 
part, and shows the 
process of creating a 
simple one.

Stages in the 
Process

The steps in planning and executing the creation of this part are listed 
below.

 Terminology
What are the terms commonly used when talking about modeling and 
using the SOLIDWORKS software?

 Profile choice
Which profile is the best one to choose when starting the modeling 
process?

 Sketch plane choice
Once you’ve chosen the best profile, how does this affect your choice 
of sketch plane?

 Design intent
What is design intent and how does it affect the modeling process?

 New part
Opening the new part is the first step.

 First feature
What is the first feature?

 Bosses, cuts and hole features
How do you modify the first feature by adding bosses, cuts and holes?

 Fillets
Rounding off the sharp corners – filleting.

 Editing tools
Use three of the most common editing tools. 

 Drawings
Creating a drawing sheet and drawing views of the model.

 Dimension changes
Making a change to a dimension changes the model’s geometry. How 
does this happen?
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Terminology Moving to 3D requires some new terminology. The SOLIDWORKS 
software employs many terms that you will become familiar with 
through using the product. Many are terms that you will recognize from 
design and manufacturing such as cuts and bosses.

Feature All cuts, bosses, planes and sketches that you create are considered 
Features. Sketched features are those based on sketches (boss and cut), 
and applied features are applied directly to existing geometry (fillet).

Plane Planes are flat and infinite. They are represented on the screen with 
visible edges. They are used as the primary sketch surface for creating 
boss and cut features.

Extrusion Although there are many ways to 
create features and shape the solid, 
for this lesson, only extrusions 
will be discussed. An extrusion 
will extend a profile along a path 
typically normal to the profile 
plane for some distance. The 
movement along that path becomes the solid model. 

Sketch In the SOLIDWORKS system, the name used to 
describe a 2D profile is sketch. Sketches are created 
on flat faces and planes within the model. They are 
generally used as the basis for bosses and cuts, 
although they can exist independently.

Boss Bosses are used to add material to the model. The critical initial feature 
is always a boss. After the first feature, you may add as many bosses as 
needed to complete the design. As with the base, all bosses begin with a 
sketch.

Cut A Cut is used to remove material from the model. This is the opposite 
of the boss. Like the boss, cuts begin as 2D sketches and remove 
material by extrusion, revolution, or other methods you will learn 
about.

Fillets and Rounds Fillets and rounds are generally added to the solid, not the sketch. By 
nature of the faces adjacent to the selected edge, the system knows 
whether to create a round (removing material) or a fillet (adding 
material).

Design Intent How the model should be created and changed, is considered the design 
intent. Relationships between features and the sequence of their 
creation all contribute to design intent.
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Choosing the 
Best Profile

Choose the “best” profile for the model's base feature. This profile, 
when extruded, will generate more of the model than any other. Look at 
these models as examples. 

Part Best Profile Extruded
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Choosing the 
Sketch Plane

Once the best profile is determined, the next step is to decide which 
view to use and select the plane with the same name for sketching it. 
The SOLIDWORKS software provides three planes; they are described 
below.

Planes There are three default planes, labeled Front Plane, Top Plane and 
Right Plane. Each plane is infinite, but has screen borders for viewing 
and selection. Also, each plane passes through the origin and is 
mutually perpendicular to the others.

The planes can be renamed. In this course the names Front Plane, Top 
Plane and Right Plane are used. This naming convention is used in 
other CAD systems and is comfortable to many users.

Although the planes 
are infinite, it may be 
easier to think of them 
as forming an open 
box, connecting at the 
origin. Using this 
analogy, the inner 
faces of the box are the 
potential sketch 
planes.

Placement of the 
Model

The part will be placed into the box three times. Each time the best 
profile will contact or be parallel to one of the three planes. Although 
there are many combinations, the choices are limited to three for this 
exercise.

When choosing the sketch plane, consider the part's appearance and its 
orientation in an assembly. The appearance dictates how the part will 
be oriented in standard views such as the Isometric. It also determines 
how you will spend most of your time looking at the model as you 
create it.

The part's orientation in an assembly dictates how it is to be positioned 
with respect to other, mating parts.

Orient the Model for 
the Drawing

Another consideration when deciding which sketch plane to use is how 
you want the model to appear on the drawing when you detail it. You 
should build the model so that the front of the model is the same as the 
Front view in the drawing. This saves time during the detailing process 
because you can use predefined views.
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In the first example, the best 
profile is in contact with the Top 
plane.

In the second example, it is 
contacting the Front plane.

The last example shows the best 
profile in contact with the Right 
plane.

Chosen Plane The Top plane orientation seems 
to be the best. This indicates that 
the best profile should be 
sketched on the Top plane of the 
model.

How it Looks on the 
Drawing

By giving careful thought to 
which plane is used to 
sketch the profile, the 
proper views are easily 
generated on the detail 
drawing.

Right Plane Front Plane

Top Plane

Right Plane Front Plane

Top Plane

Right Plane Front Plane

Top Plane
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Details of the 
Part

The part we will be creating is shown below. There are two main boss 
features, some cuts, and fillets.

Standard Views The part is shown here in four standard views.

Main Bosses The two main bosses have distinct 
profiles in different planes. They 
are connected as shown in the 
exploded view at right.

Best Profile The first feature of the model 
is created from the 
rectangular sketch shown 
overlaid on the model. This is 
the best profile to begin the 
model. 

The rectangle will then be 
extruded as a boss to create 
the solid feature.
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Sketch Plane Placing the model “in the box” determines which plane should be used 
to sketch on. In this case it will be the Top plane. 

Design Intent The design intent of this part describes how the part’s relationships 
should or should not be created. As changes to the model are made, the 
model will behave as intended.

 All holes are through holes.

 The slot is aligned with the 
tab.

 The counterbored hole in the 
front shares the same center 
point as the rounded face of 
the tab. 

Procedure The modeling process includes sketching and creating bosses, cuts and 
fillets. To begin with, a new part file is created.

1 New part.

Click New , or click File, New. Create a new part using the 
Part_MM template and Save it as Basic.

2 Select the sketch plane.
Insert a new sketch and choose 
the Top Plane.

Tip A plane doesn’t have to be shown 
in order to be used; it can be 
selected from the 
FeatureManager design tree.

Sketch Plane
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Sketching the First 
Feature

Create the first feature by extruding a sketch into a boss. The first 
feature is always a boss, and it is the first solid feature created in any 
part. Begin with the sketch geometry, a rectangle.

Introducing: 
Corner Rectangle

Corner Rectangle is used to create a rectangle in a sketch. The 
rectangle is comprised of four lines (two horizontal and two vertical) 
connected at the corners. It is sketched by indicating the locations of 
two diagonal corners. There are several other rectangle/parallelogram 
tools available:

 Center Rectangle  - Uses a center point and corner to create a 
rectangle with horizontal and vertical lines. 

 3 Point Center Rectangle  - Creates a rectangle based on a 
center point, midpoint of edge and corner. Lines are perpendicular 
at corners. 

 3 Point Corner Rectangle  - Uses three corners to define a 
rectangle. Lines are perpendicular at corners. 

 Parallelogram  - Uses three corners to define a parallelogram 
(corners are not perpendicular). 

Where to Find It  CommandManager: Sketch > Corner Rectangle 
 Menu: Tools, Sketch Entities, Corner Rectangle
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Corner Rectangle 

3 Sketch a rectangle.
Click Corner Rectangle  
and begin the rectangle at the 
origin.

Make sure the rectangle is locked to the origin by looking for 
the coincident icon next to the cursor as you begin sketching. 
Do not worry about the size of the rectangle. Dimensioning it 
will take care of that in the next step.

4 Fully defined sketch. 
Add dimensions to the sketch. The 
sketch is fully defined.
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Extrude Options An explanation of some of the more frequently used Extrude options is 
given below (see Extrude on page 51). Other options will be discussed 
in later lessons.

 End Condition Type
A sketch can be extruded in one or two directions. Either or both 
directions can terminate at some blind depth, up to some geometry in 
the model, or extend through the whole model.

 Depth
The distance for a blind or mid-plane extrusion. For mid-plane, it refers 
to the total depth of the extrusion. That would mean that a depth of 
50mm for a mid-plane extrusion would result in 25mm on each side of 
the sketch plane.

 Draft
Applies draft to the extrusion. Draft on the extrusion can be inwards 
(the profile gets smaller as it extrudes) or outward.

5 Extrude.

Click Extrude  and extrude the rectangle 10mm upwards. Click OK.

Renaming 
Features

Any feature that appears in the FeatureManager design tree (aside from 
the part itself) can be renamed using the procedure below. Renaming 
features is a useful technique for finding and editing features in later 
stages of the model. Well chosen, logical names help you to organize 
your work and make it easier when someone else has to edit or modify 
your model.

6 Rename the feature.
It is good practice to rename important features that you create with 
some meaningful name. In the FeatureManager design tree, use a very 
slow double-click to edit the feature Boss-Extrude1. When the name 
is highlighted and editable, type BasePlate as the new feature name. 
All features in the SOLIDWORKS system can be edited in the same 
way.

Tip Instead of using a slow double-click to edit the name, you can select the 
name and press F2.
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Boss Feature The next feature will be the boss 
with a curved top. The sketch 
plane for this feature will be a 
planar face of the model instead 
of an existing plane. The required 
sketch geometry is shown 
overlaid on the finished model. 

Sketching on a 
Planar Face

Any planar (flat) face of the model can be used as a sketch plane. 

Simply select the face and click Sketch . Where faces are difficult 
to select because they are obscured by other faces, the Select Other 
tool can be used to choose a face without reorienting the view. In this 
case, the planar face on the front of the BasePlate is used.

7 Insert new sketch.
Select the indicated face and click 

Sketch . 

Note Make sure that Features > Instant 3D  is turned off. Leaving it on 
will cause several handles and axes that we are not currently using to 
appear on the face. 

Sketching SOLIDWORKS offers a rich variety of sketch tools for creating profile 
geometry. In this example, Tangent Arc is used to create an arc that 
begins tangent to a selected endpoint on the sketch. Its other endpoint 
can be placed in space or on another sketch entity.

Introducing: 
Tangent Arc

Tangent Arc is used to create tangent arcs in a sketch. The arc must be 
tangent to some other entity, line or arc, at its start.

Where to Find It  CommandManager: Sketch > Arc  > Tangent Arc 
 Menu: Tools, Sketch Entities, Tangent Arc
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Tangent Arc 

Sketch Plane
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Tangent Arc Intent 
Zones

When you sketch a tangent arc, the 
SOLIDWORKS software infers from the motion 
of the cursor whether you want a tangent or 
normal arc. There are four intent zones, with 
eight possible results as shown.

You can start sketching a tangent arc from the end point of any existing 
sketch entity (line, arc, spline, and so on). Move the cursor away from 
the end point.

 Moving the cursor in a tangent direction creates one of the four 
tangent arc possibilities.

 Moving the cursor in a normal direction creates on of the four 
normal arc possibilities.

 A preview shows what type of arc you are sketching.

 You can change from one type of tangent arc to the other by 
returning the cursor to the endpoint and moving away in a different 
direction.

Autotransitioning 
Between Lines and 
Arcs

When using Line , you can switch from sketching a line to sketching 

a tangent arc, and back again, without clicking Tangent Arc . You 
can do this by returning the cursor to the endpoint and moving away in 
a different direction or by pressing the A key on the keyboard.

8 Vertical line.

Click Line  and start the vertical 
line at the lower edge capturing a 

Coincident  relation at the lower 

edge and Vertical relation .

9 Autotransition.
Move the cursor back to the endpoint and move away in a different 
direction.You are now in tangent arc mode.

10 Tangent arc.
Sketch a 180° arc tangent to the 
vertical line. Look for the inference 
line indicating that the end point of 
the arc is aligned horizontally with 
the arc’s center.

When you finish sketching, the 
sketch tool automatically switches 
back to the line tool.
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11 Finishing lines.
Create a vertical line from the arc end 
to the base, and one more line 
connecting the bottom ends of the 
two vertical lines.

Note that the horizontal line is black, 
but its endpoints are not.

12 Add dimensions.
Add linear and radial 
dimensions to the sketch.

As you add the dimensions, 
move the cursor around to view 
different possible orientations.

Always dimension to an arc by selecting on its circumference, rather 
than center. This makes other dimensioning options (min and max) 
available.

13 Extrude direction.

Click Extrude  and set the 
Depth to 10mm. Note that the 
preview shows the extrusion 
going into the base, in the 
proper direction.

If the direction of the preview is 
away from the base, click 
Reverse Direction .

Note When using the Spin Increment arrows, the 
default up and down increment is 10mm. 
Pressing the Alt key with an arrow drops it to
1/10X, or 1mm. Using it with Ctrl key it 
increases it 10X to 100mm.
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14 Completed boss.
The boss merges with the previous 
base to form a single solid.

Rename the feature VertBoss. 

Cut Feature Once the two main boss features are completed, it is time to create a cut 
to represent the removal of material. Cut features are created in the 
same way as bosses - in this case with a sketch and extrusion.

Introducing: 
Cut Extrude

The menu for creating a cut feature by extruding is identical to that of 
creating a boss. The only difference is that a cut removes material while 
a boss adds it. Other than that distinction, the commands are the same. 
This cut represents a slot.

Where to Find It  CommandManager: Features > Extruded Cut 
 Menu: Insert, Cut, Extrude

15 Rectangle.
Press Space bar and click 

Front . Start a sketch on 
this large face and add a 
rectangle Coincident with 
the bottom model edge.

Turn off the rectangle tool.

16 Dimensions. 
Add a dimension as shown. 

Note The sketch is under defined, but it will be made fully defined later in 
this lesson. See Status of a Sketch on page 38.
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View Selector The View Selector helps to visualize how 
views of the model will appear by using a 
transparent cube surrounding the model. 

Select a face of the cube to look at the model 
through the cube, normal to that face or select 
a view orientation by name. 

The cube can also be rotated prior to selecting 
a face.

Where to Find It  Heads-up View Toolbar: View Orientation  and 

View Selector
 Keyboard Shortcut: Space bar

Note Pressing the Space Bar opens the View Selector and the Orientation 
dialog box. Pressing Ctrl+Space bar opens only the View Selector.

17 View Selector.
Press Space Bar and click the corner of the cube that is labeled 
Isometric.
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18 Through All Cut.

Click Extruded Cut . Choose Through All 
and click OK. This type of end condition always 
cuts through the entire model no matter how far. 
No depth setting was needed. Rename the 
feature BottomSlot.

Using the Hole 
Wizard

The Hole Wizard is used to create specialized holes in a solid. It can 
create simple, tapered, counterbored and countersunk holes using a step 
by step procedure. I n this example, the Hole Wizard will be used to 
create a standard hole.

Creating a 
Standard Hole

You can choose the face to insert the hole onto, define the hole’s 
dimensions and locate the hole using the Hole Wizard. One of the most 
intuitive aspects of the Hole Wizard is that you specify the size of the 
hole by the fastener that goes into it.

Tip You can also place holes on planes and non-planar faces. For example, 
you can create a hole on a cylindrical face.

Counterbore Hole A counterbore hole is required in this model. Using the front face of the 
model and a relation, the hole can be positioned.

Note The Advanced Hole Wizard (Insert, Features, 
Advanced Hole) is similar to the Hole Wizard, but 
allows you to design a stack of hole styles including 
counterbores, countersinks, tapered, tapped, and 
standard holes. 

Introducing: 
The Hole Wizard

The Hole Wizard creates shaped holes, such as countersunk and 
counterbore types. The process creates two sketches. One defines the 
shape of the hole. The other, a point, locates the center.

Where to Find It  CommandManager: Features > Hole Wizard 
 Menu: Insert, Features, Hole Wizard
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19 Select Counterbore.
Select the face indicated and click Hole 

Wizard . Set the properties of the hole as 
follows:

Type: Counterbore

Standard: ANSI Metric

Type: Hex Bolt - ANSI B18.2.3.5M

Size: M8

End Condition: Through All

20 Wake up the centerpoint.
Click the Positions tab.

Hover the cursor over the 
circumference of the large arc. 
Do not click.

When the Coincident symbol 
appears , the center point of 
the large arc has been “woken 
up” and is now a point you can 
snap to. 

Click the point onto the arc’s centerpoint. Look for the feedback that 
tells you that you are snapping to the arc’s center, a coincident relation. 
Click OK to complete the dialog.

Select this face
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Filleting Filleting refers to both fillets (adding volume) and rounds (removing 
volume). The distinction is made by the geometric conditions, not the 
command itself. Fillets are created on selected edges of the model. 
Those edges can be selected in several ways, and several options exist 
for creating different fillet types including constant size, variable size, 
face and full round fillets. Fillet profile options include circular, conic 
and curvature continuous. 

Note See the Advanced Part Modeling course for more information on fillet 
types and options.

Filleting Rules Some general filleting rules are:

1. Leave cosmetic fillets until the end.
2. Create multiple fillets that will have the same radius in the same 

command.
3. When you need fillets of different radii, generally you should make 

the larger fillets first.
4. Fillet order is important. Fillets create faces and edges that can be 

used to generate more fillets.
5. Existing fillets can be converted to chamfers (see Chamfers on 

page 175). 

Selection Toolbar The Selection Toolbar can be used to turn a single edge selection into 
multiple, related, selections. It will not be used in this example, but it 
will be explained in Edge Selection on page 173.

Preview You have a choice between Full preview, Partial preview and No 
preview of the fillet. Full preview, as shown in the following images, 
generates a mesh preview on each selected edge. Partial preview only 
generates the preview on the first edge you select. As you gain 
experience with filleting, you will probably want to use Partial or No 
preview because they are faster.
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Where to Find It  CommandManager: Features > Fillet 
 Menu: Insert, Features, Fillet/Round

 Shortcut Menu: Right-click a face or edge and click Fillet 

21 Insert Fillet.

Click Fillet . Click Manual, click Constant 

Size Fillet  and set the radius value to 
8mm. 

Clear Show selection toolbar and click Full 
preview.

22 Select edge.
Select the two hidden edges shown through the 
model as shown.

23 Additional selections.
Select the additional four corner edges as shown and click OK. 

Note All six fillets are controlled by the same dimension value. The creation 
of these fillets has generated new edges suitable for the next series of 
fillets.
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Recent Commands SOLIDWORKS provides a 
“just used” buffer that lists 
the last few commands for 
easy reuse. The Enter key can 
also be used to re-launch the 
last used command.

Recent Features The History folder contains a list of the most 
recent features that have been created or 
edited. This is useful for getting access to 
recent features. See Editing Tools on page 81 
for more information.

24 Recent Command.
Right-click in the graphics area and click Recent Commands and the 
Fillet command from the drop-down list to use it again.

25 Preview and propagate.
Add another fillet, radius 3mm, using Full 
preview.

Select the edges indicated to see the 
selected edges and preview. 

Click OK.
80



SOLIDWORKS Education 2023 Lesson 3
Basic Part Modeling
Editing Tools Three of the most common editing tools are introduced in this lesson: 
Edit Sketch, Edit Feature and Rollback. They can be used to edit and 
repair sketches and features as well as specify where, in the 
FeatureManager design tree, the features are to be created. 

Tip The other editing tools are found later in this lesson: Editing Features 
on page 82 and Rollback Bar on page 82. 

Editing a Sketch Once created, sketches can be changed using Edit Sketch. This opens 
the selected sketch so that you can change anything: the dimension 
values, the dimensions themselves, the geometry or geometric 
relations. 

Introducing: 
Edit Sketch

Edit Sketch enables you to access a sketch and make changes to any 
aspect of it. During editing, the model is “rolled back” to its state at the 
time the sketch was created. The model will be rebuilt when the sketch 
is exited. 

Where to Find It  Shortcut Menu: Right-click a sketch or feature and click 

Edit Sketch
 Menu: Select a face and click Edit, Sketch

26 Edit the sketch. 

Right-click the BottomSlot feature and click Edit Sketch . The 
existing sketch will be opened for editing. 

Selecting Multiple 
Objects

As you learned in Selecting Multiple Objects on page 45, when 
selecting multiple objects, hold down the Ctrl key and then select the 
objects.

27 Relations. 
Select the endpoint and edge as shown and add 
a Coincident relation.

28 Repeat.
Repeat the procedure for the endpoint 
at the other end of the rectangle as 
shown. The addition of these relations 
will fully define the sketch.
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Note For more information about relations, see Sketch Relations on page 41. 

29 Exit the sketch. 

Click Exit Sketch  in the upper right (confirmation) corner to 

exit the sketch and rebuild the part. 

Editing Features The second fillet should also be applied to the top edges of the Base 
Plate. To do this we will edit the definition of the last fillet feature.

Introducing: 
Edit Feature

Edit Feature changes how a feature is applied to the model. Each 
feature has specific information that can be changed or added to, 
depending on the type of feature it is. As a general rule, the same dialog 
box used to create a feature is used to edit it.

Fillet Propagation The Tangent Propagation checkbox within the Fillet tool allows a 
fillet feature to flow to tangent edges of the selections made.

Where to Find It  Menu: Select a feature and click Edit, Definition

 Shortcut Menu: Right-click a feature and click Edit Feature 

30 Edit the feature. 

Right-click the Fillet2 feature and click Edit Feature . The existing 
feature will be opened for editing using the same PropertyManager that 
was used to create the feature. Make sure that Tangent Propagation is 
clicked.

31 Select additional edge. 
Select the additional short edge as shown and 
the propagation will create the fillets as 
shown. Click OK. 

Rollback Bar The Rollback Bar is the blue horizontal bar 
located at the bottom of the FeatureManager 
design tree. 

The Rollback Bar has many uses. It can be used to “walk through” a 
model showing the steps that were followed to build it or to add 
features at a specific point in the part’s history. In this example, it will 
be used to add a hole feature between the existing fillet features. 
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Using Rollback with 
Large Parts

The Rollback Bar is also useful when editing large parts to limit 
rebuilding. Roll back to the position just after the feature that you are 
editing. When the editing is completed, the part is rebuilt only up to the 
rollback bar. This prevents the entire part from being rebuilt. The part 
can be saved in a rollback state.

Introducing: The 
Rollback Bar

You can roll back a part using the Rollback Bar in the FeatureManager 
design tree. The rollback bar is a line which highlights when selected. 
Drag the bar up or down the FeatureManager design tree to step 
forward or backward through the regeneration sequence.

Note To move the rollback bar with the arrow keys, click Tools, Options, 
System Options, FeatureManager, Arrow key navigation. The 
focus must be set to the rollback bar by clicking on it. If the focus is set 
to the graphics area, the arrow keys will rotate the model.

Where to Find It  Shortcut Menu: Right-click a feature and click Rollback 
 Shortcut Menu: Right-click in the FeatureManager design tree and 

click Roll to Previous or Roll to End

32 Rollback. 
Click on the Rollback Bar and drag it upwards. Drop it before the fillet 
features as shown.
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33 Hole Wizard.

Click the Hole Wizard  and click the Positions tab.

34 Face selection.
Select the face indicated.

35 Holes.
Add two points and dimension them as shown.

36 Type.
Click the Type tab and set the properties of the 
hole as follows. Click OK.

Type: Hole

Standard: Ansi Metric

Type: Drill sizes

Size: 7.0

End Condition: Through All

Select this face
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37 Change the view orientation.

Click Isometric  to change view 
orientation. 

38 Roll to end. 
Right-click on the rollback bar and click Roll 
to End. 

Introducing: 
Appearances

Use Appearances to change the color and optical properties of 
graphics. Color Swatches can also be created for user defined colors. 

Where to Find It  Shortcut Menu: Right-click a face, feature, body, part, or 
component, click Appearances, and click the item to edit

 Heads-up View Toolbar: Edit Appearance 
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39 Select swatch.

Click Edit Appearance . Under the Color 
selection, select the standard swatch and one 
of the colors as shown.

Click OK.

40 Display appearances. 

Click the DisplayManager  tab to see the 
color listed. Click the FeatureManager design 

tree  tab. 

Tip The DisplayManager can also be used to view and modify decals, 
scenes, lights and cameras. 

A Note About Color 
in the User Interface

You can customize the colors of the SOLIDWORKS user interface. 
This is done through Tools, Options, System Options, Colors. You 
can select predefined color schemes, or create your own. In some cases, 
we have altered colors from their default settings to improve clarity and 
reproduction quality. As a result, the colors on your system may not 
match the colors used in this book.

41 Save the results. 

Click Save  to save your work.
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Detailing Basics SOLIDWORKS enables you to easily create drawings from parts or 
assemblies. These drawings are fully associative with the parts and 
assemblies they reference. If you change the model, the drawing will 
update.

Various topics related to making drawings are integrated into several 
lessons throughout this book. The material presented here is just the 
beginning. Specifically:

 Creating a new drawing file and sheet. 
 Creating drawing views using the View Palette.
 Using dimension assist tools. 

A comprehensive treatment of detailing is offered in the course 
SOLIDWORKS Drawings. 
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Settings Used in 
the Template

The drawing template used in this section has been designed to include 
the Document Properties shown in the chart below. Settings are 
accessed through Tools, Options. The settings that will be used in this 
lesson are:

CommandManager 
Tabs

When working in a drawing document, the CommandManager tabs 
will update to include toolbars that are specific to the process of 
detailing and making drawings. They are:

 Drawing

 Annotation

New Drawing Drawing files (*.SLDDRW) are SOLIDWORKS files that contain 
drawing sheets. Each sheet is the equivalent of a single sheet of paper.

Introducing: Make 
Drawing from Part

Make Drawing from Part takes the current part and steps through the 
creation of a drawing file, sheet format and initial drawing views using 
that part.

Where to Find It  Menu Bar: New , Make Drawing from Part/Assembly 
 Menu: File, Make Drawing from Part 

System Options
Document Properties
(Set using drawing template)

Drawings, Display Style:
• Display style for new views = 

Hidden lines removed

• Tangent Edges = Visible

Drafting Standard:
• Overall drafting standard = 

ANSI 

Colors:
• Drawings, Hidden Model Edges 

= Black

Dimensions:
• Font = Century Gothic

• Primary precision = .123

• Add parentheses by default = 
Selected

Detailing, Auto insert on view 
creation:
• All options = cleared

Units
• Unit system =MMGS
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1 Create Drawing.

Click Make Drawing from Part/Assembly  and choose 
B_Size_ANSI_MM from the Training Templates tab.

The sheet format creates a B-size drawing (11” x 17”) arranged with its 
long edge horizontal. The sheet format includes a border, title block, 
and other graphics.

Tip Double-clicking the template will automatically open it, eliminating the 
need to click OK.

Drawing Views The initial task of detailing is the creation of views. Using the Make 
Drawing from Part/Assembly tool leads you through the selection of 
the drawing sheet to the View Palette. Previews of the model 
orientations are shown in the lower pane of the View Palette. Create 
views on the drawing sheet by using a drag and drop procedure. 
Additional views can be projected or folded directly from the dropped 
view. 

These options are discussed in detail in the SOLIDWORKS Drawings 
course.

2 View Palette.
Clear Import Annotations. Drag the Front view from the View 
Palette and drop it onto the drawing as shown.
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3 Projected views.
Once the first view is placed, Projected View become active. Add the 
Top view by moving the cursor above the view and clicking. 

Return the cursor to the Front view and move to the right to create the 
Right view. Click OK.

4 Drawing views.
Add the *Isometric view by dragging and dropping from the palette. 
Place it in the upper right corner.

Note The part document is still open. You can press Ctrl+Tab to switch 
between the drawing and part document windows.
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Tangent Edges Tangent Edges are topological edges of faces that match in tangency. 
The most commonly seen tangent edges are the edges of fillets. They 
are often made visible in pictorial views but are removed from 
orthographic views.

Where to Find It  Shortcut Menu: Right-click the view and click Tangent Edge

5 Remove tangent edges.
Using the Control key, select the front, top, and right views. Click 
Tangent Edge and Tangent Edges Removed. 

6 Display style. 

Click the Isometric view and click Shaded . In the other views, 

click Hidden Lines Visible .
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Moving Views Drawing views can be repositioned on the drawing. You place your 
pointer over the view border, then drag the view. In the standard 3 view 
arrangement, the Front view is the source view. This means that 
moving the front view moves all three views. The Top and Right views 
are aligned to the Front. They can only move along their axis of 
alignment.

7 Move Aligned Views.
Select the edge and move the Front view. It can be moved in any 
direction and the other views remain aligned.

Note Once the drawing view has been selected, it can be dragged with the 
mouse or moved with the arrow keys. The distance moved for each 
press of an arrow key is set under Tools, Options, System Options, 
Drawings, Keyboard movement increment. Use Alt-drag to select 
anywhere in the view. Use Shift-drag to maintain the spacing between 
the views while dragging.
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Center Marks Center Marks are attached to circle and arc centers in the drawing 
view.

Center marks were not inserted into the drawing 
views automatically. You can turn this option 
on or off. Set your preference using the Tools, 
Options, Document Properties, Detailing 
menu.

Where to Find It  CommandManager: Annotation > Center Mark 
 Menu: Insert, Annotations, Center Mark
 Shortcut Menu: Right-click in the graphics area and click 

Annotations, Center Mark

8 Center Mark.

Click Center Mark . 

Clear Use document defaults, check the 
Extended lines option and set the Mark size to 
2mm as shown. 

Click the large arc in the front view. Continue 
adding center marks to the two holes in the Top 
view.

Click OK.
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Dimensioning Dimensions can be created in drawing views using several tools. Some 
dimensions can be related to the dimensions generated in the sketches 
and features of the model. These are driving dimensions. Other 
dimensions are independent of the sketches and features of the model. 
These are driven dimensions.

Driving 
Dimensions

Driving dimensions always display the proper values and can be used 
to change the model. The Model Items tool imports the dimensions 
created in the sketches and features of the model into the drawing.

Driven 
Dimensions

Driven dimensions always display the proper values but cannot be used 
to change the model. The values of driven dimensions change when the 
model dimensions change. By default, dimensions of this type appear 
in a different color and are enclosed in parentheses. Here are two ways 
to create driven dimensions:

 The Smart Dimension tool manually adds dimensions to the 
model like those in a sketch.

 The DimXpert tool adds dimensions working from a datum 
position.

Introducing: Model 
Items

The Model Items tool assists in adding 
dimensions to a view or all views using the 
sketch and feature dimensions of the model.

You can import the dimensions for a selected 
feature or the entire model. It also has the 
capability to select and import different types 
of dimensions as well as many types of 
Annotations and Reference Geometry that 
may exist within the model. 

Where to Find It  CommandManager: Annotation > Model Items 
 Menu: Insert, Model Items
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9 Model items. 

Click Model Items . Click Entire Model as 
the Source and Import items into all views. 

Under Dimensions, click Marked for 
drawing, Hole Wizard Locations, Hole 
callout and Eliminate duplicates. 

Click OK. 

Note The position of a dimension depends on how the feature was created 
and where the model dimension was placed. Your results may vary 
from the image above.

Tip Once the dimensions are inserted, they are associated to that view and 
will move with it unless you deliberately move them to another view or 
delete them. For more information, see Manipulating Dimensions on 
page 96.
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Manipulating 
Dimensions

Once dimensions have been added to a view, there are several options 
as to how they can be manipulated: 

10 Drag dimensions.
Drag dimensions within the view to reposition them as shown.

Tip Align dimension text using the yellow guidelines. 

Drag Drag dimensions by their text to new locations. 
Use the inference lines to align and position 
them.

Hide Right-click the dimension text and click Hide 
from the shortcut menu. 

Move to another 
view

There is generally more than one view where a 
dimension can be used. To move a dimension, 
Shift + drag the dimension onto another view. 

Copy to another 
view

To copy the dimension, hold down Ctrl and 
drag it into another view and drop it.

Delete Unwanted dimensions can be deleted from the 
drawing using the Delete key. 
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11 Move to another view. 
Shift + drag the 125mm dimension to Drawing View1 and drop it. It 
will be moved from the original view to the new view. 

12 Move remaining dimensions. 
Move dimensions to reposition them as shown.
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Dimension Palette The Dimension Palette appears near your cursor when you insert a 
dimension or select one or more dimensions. It can be used to change 
the dimensions’ properties, formatting, position, and alignment.

Where to Find It  Select one or more dimensions then click 

Dimension Assist 
Tool - Smart 
Dimensioning

Use the Smart dimensioning option of the dimension assist tool to 
manually add dimensions in the drawing. These dimensions are 
considered to be driven dimensions. See Driven Dimensions on 
page 94.

13 Arrange the dimensions.

Select all of the dimensions in the top view and click  to open the 

Dimension Palette. Then, click Auto Arrange Dimensions  to 
provide better spacing and alignment of the dimensions.

Note Adjustments can be made to dimensions after using arrange. 

14 Dimensioning.

Click Smart Dimension . Select vertices 
at the top and bottom and place the dimension 
to the left of the view. 

Click OK. 
98



SOLIDWORKS Education 2023 Lesson 3
Basic Part Modeling
Associativity 
Between the Model 
and the Drawing

In the SOLIDWORKS software, everything is associative. If you make 
a change to an individual part, that change will propagate to any and all 
drawings and assemblies that reference it.

15 Switch windows. 
Press Ctrl+Tab and click the part file 
to switch back to the part document 
window.

Changing 
Parameters

SOLIDWORKS makes it very easy to make changes to the dimensions 
of your part. This ease of editing is one of the principal benefits of 
parametric modeling. It is also why it is so important to properly 
capture your design intent. If you don’t properly capture the design 
intent, changes to dimensions may cause quite unexpected results in 
your part.

Rebuilding the 
Model

After you make changes to the dimensions, you must rebuild the model 
to cause those changes to take affect.

Rebuild Symbol If you make changes to a sketch or part that require the part to be 

rebuilt, a rebuild symbol  is displayed beside the part’s name as well 
as superimposed on the icon of the feature that requires rebuilding 

. Look for the rebuild icon on the Status Bar, also.

The rebuild symbol also is displayed when you are editing a sketch. 
When you exit the sketch, the part rebuilds automatically.

Introducing: Rebuild Rebuild regenerates the model with any changes you have made.

Where to Find It  Menu Bar: Rebuild 
 Menu: Edit, Rebuild
 Keyboard Shortcut: Ctrl+B

Tip The model is also rebuilt when it is saved. 

Note To rebuild all features, press Ctrl+Q.
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16 Double-click on the feature.
You can double-click on the BasePlate feature either in the 
FeatureManager design tree or the graphics area. When you do this, the 
parameters associated with the feature will appear. 

Double-click on the 125mm dimension indicated. The Modify dialog 
box will appear. Enter a new value either by typing it directly or by 
using the spin box arrows. Enter 150mm and click OK.

17 Rebuild the part to see the results.

Rebuild the part by clicking Rebuild . If you use the one on the 
Modify dialog box, the dialog box will stay open so you can make 
another change. This makes exploring “what if” scenarios easy. 
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18 Update the drawing.
Press Ctrl+Tab and click the drawing file to switch back to the drawing 
sheet. The drawing will update automatically to reflect the changes in 
the model. Dimensions may move during the rebuilding process and 
require some clean up.

19 Close the drawing. 
Click File, Close to close the drawing. Click Save All to save both the 
drawing and part files.

20 Confirm.
Click Yes to update the drawing views before saving the drawing. Save 
the drawing file in the same folder as the part. 
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Exercise 7:
Plate

Create this part using the information 
and dimensions provided. Sketch and 
extrude profiles to create the part. This 
lab reinforces the following skills:

 Choosing the Best Profile on 
page 64

 Introducing: Corner Rectangle on 
page 69

 Sketching on a Planar Face on page 71
 Boss Feature on page 71
 Using the Hole Wizard on page 76

Units: millimeters

Procedure Create a new mm part and name it Plate. Create the geometry as 
shown in the following steps. 

1 Sketch base feature. 
Create a new sketch on the Top plane. 
Add the geometry and dimensions as 
shown. 

2 Extrude base feature. 
Extrude the sketch 10mm as shown. 
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3 Boss. 
Create a new sketch on the top face of the solid. Add the geometry and 
dimensions as shown. 

Extrude a boss 25mm. 

4 Hole Wizard. 

Click Hole Wizard  and click the face shown. 

Click the Type tab. Set the properties of the hole as follows:

Type: Hole 

Standard: Ansi Metric 

Type: Drill sizes 

Size: 25mm

End Condition: Through All 

Click the Positions tab. Place the points as shown. 

5 Save and close the part. 
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Exercise 8:
Cuts

Use rectangles, tangent arcs and 
cut features to create the part. 
This lab reinforces the following 
skills: 

 Introducing: 
Corner Rectangle on page 69

 Tangent Arc Intent Zones on 
page 72

 Cut Feature on page 74
 Filleting on page 78

Units: millimeters 

Procedure Create a new mm part and name it Cuts. Create the geometry as shown 
in the following steps. 

1 Sketch base feature. 
Create a new sketch on the Top plane. Add the geometry and 
dimensions as shown. 

2 Extrude base feature. 
Extrude the sketch 5mm as shown. 
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3 Cut slot. 
Create a new sketch on the top 
face of the solid. Add the 
geometry and dimensions as 
shown. 

Extrude a cut using Through All. 

Tip Remember to create a closed profile by sketching the line across the 
bottom.

4 Cut another slot. 
Create a new sketch using the 
same face. Add the geometry 
and dimensions as shown. 

Extrude another cut using 
Through All.

5 Cut rectangle. 
Create a new sketch using the same face. Add the geometry and 
dimensions as shown. 

Extrude another cut using Through All.
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6 Fillets. 
Add fillets of R10mm and R8mm to the edges as shown. 

7 Save and close the part. 
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Exercise 9:
Basic-Changes

Make changes to the part 
created in the previous 
lesson.

This exercise uses the 
following skills:

 Changing 
Parameters on 
page 99

 Rebuilding the Model 
on page 99

Procedure Open an existing part and edit it.

1 Open the part
Basic-Changes.
Several changes will be 
performed on the model to resize 
it and check the design intent.

2 Overall dimension.
Double-click the first feature (Base Plate) in the FeatureManager 
design tree or on the screen to access the dimensions. Change the 
length dimension to 150mm (shown bold and underlined below) and 
rebuild the model.
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3 Boss.
Double-click the Vert boss feature and change the height dimension as 
shown. Rebuild the part.

4 Hole locations.
Double-click the Ø7.0 (7) Diameter Hole1 feature and change the 
position dimensions to 20mm. Rebuild the model.

5 Center the Vert Boss.
Determine the proper value and change the dimension that centers the 
Vert Boss on the base.

Tip Optionally, you can delete the dimension and add a relations that 
centers the VertBoss relative to the base.

6 Save and close the part. 
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Exercise 10:
Base Bracket

This lab reinforces the 
following skills:

 Choosing the Best 
Profile on page 64

 Boss Feature on 
page 71

 Using the Hole Wizard 
on page 76

 Filleting on page 78

Units: millimeters

Procedure Create a new mm part and name it Base_Bracket. Create the geometry 
as shown in the following steps. 

1 Sketch base feature. 
Create a new sketch on the Top plane. Add the geometry and 
dimensions as shown. 

2 Extrude base feature. 
Extrude the sketch 20mm to create the base feature as shown. 
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3 Sketch on rear face. 
Change to the Back view orientation, select the face indicated and 
create a new sketch. Add the geometry and dimensions as shown. 

4 Extrude boss. 
Extrude to the sketch 20mm as shown. 

Select Face
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5 Fillets. 
Add fillets to the edges as shown. 

R20mm

R25mm

R12mm
111



Exercise 10 SOLIDWORKS Education 2023
Base Bracket
6 Hole Wizard. 

Click Hole Wizard  and click the face shown. Click the Type tab 
and set the properties of the hole as follows:

Type: Hole 

Standard: Ansi Metric 

Type: Drill sizes 

Size: 20mm

End Condition: Through All 

Click the Positions tab and locate the holes as shown. 

7 Second hole. 
Repeat the procedure to create an 18mm hole on a different face as 
shown. 

8 Save and close the part. 

Select Face

Select Face
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Exercise 11:
Part Drawings

Create this part drawing using the 
information provided. 

This lab reinforces the following 
skills:

 New Drawing on page 88
 Drawing Views on page 89
 Center Marks on page 93
 Dimensioning on page 94

Procedure Create a new drawing and add the views and dimensions shown in the 
following steps. 

1 Open part.
Open the part Basic-Changes-Done.

2 New drawing.
Use the Make Drawing from Part command and the 
B_Size_ANSI_MM template to create the drawing views as shown.

3 Dimensions.
Add the annotations and dimensions as shown.

4 Save and close all files. 
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Lesson 4
Patterning

Upon successful completion of this lesson, you will be able to:

 Create a linear pattern.

 Add a circular pattern.

 Use geometry patterns properly.

 Create and use the reference geometry types axes and planes.

 Create a mirror pattern.

 Use the pattern seed only option with a linear pattern.

 Add a sketch driven pattern.

 Automate the process of fully defining a sketch.
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Why Use 
Patterns?

Patterns are the best method for creating multiple instances of one or 
more features when the design intent is for the features to always 
remain the same. Use of patterns is preferable to other methods for 
several reasons.

 Reuse of geometry
The original or Seed feature is created only once. Pattern Instances 
of the seed are created and placed, with references back to the seed.

 Changes
Due to the seed/instance relationship, changes to the seed are 
automatically passed on to the instances.

 Use of Assembly Component 
Patterns
Patterns created at the part level are 
reusable at the assembly level as 
Pattern Driven Patterns. The pattern 
can be used to place component parts 
or subassemblies.

 Smart Fasteners
One last advantage of patterns is to 
support the use of Smart Fasteners. 
Smart Fasteners are used to 
automatically add fasteners to the 
assembly. These are specific to holes.

Pattern Terminology To use patterns, you should understand the terms seed and pattern 
instance.

 Seed
The seed is the geometry to be patterned. It can be one or more 
features, bodies or faces.

 Pattern Instance
The Pattern Instance (or just Instance) is the “copy” of the seed 
created by the pattern. It is in fact much more than a copy because it is 
derived from the seed and changes with the seed.
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Types of Patterns There are many types of patterns available in SOLIDWORKS and the 
following table is intended to highlight the typical uses for each type.

Note Not all of the pattern types in the table are shown as case studies.

Pattern Type: Typical usage: Key:
Seed = 
Pattern Instance = 

Linear  . . . . . . . . 
One-directional array with equal 
spacing.

Linear  . . . . . . . . 
Two-directional array with equal 
spacing.

Linear  . . . . . . . . 
Two-directional array; pattern 
seed only.

Linear  . . . . . . . . 
One- or two-directional array. 
Selected instances removed.

Linear  . . . . . . . . 
One- or two-directional array. 
Selected dimensions varied.
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Circular . . . . . . . 
Circular array with equal spacing 
about a center.

Circular . . . . . . . 
Circular array with even spacing 
about a center. Selected 
instances removed or angle less 
than 360°.

Circular . . . . . . . 
Circular array with even spacing 
about a center and symmetric 
spacing.

Circular . . . . . . . 
Circular array with selected 
dimensions varied.

Mirror. . . . . . . . . 
Mirrored orientation about a 
selected plane.

Table Driven . . . 
Arrangement based on a table of 
XY locations from a coordinate 
system.
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Sketch Driven . . 
Arrangement based on the 
positions of points in a sketch.

Curve Driven. . . 
Arrangement based on the 
geometry of a curve. 

Curve Driven. . . 
Arrangement of full or partial 
circular path.

Curve Driven. . . 
Arrangement based on the 
geometry of a projected curve.

Fill . . . . . . . . . . . .
Arrangement of instances to 
pattern based on a face.

Fill can also use default shapes: 
circles, squares, diamonds, or 
polygons.

Variable . . . . . . . .
Arrangement based on selected 
dimensions in a pattern table 
varied along a planar or curved 
surface. 
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Pattern Options Pattern features share several options. They are unique to this class of 
feature and will be discussed in detail later in this lesson.

Note The sketch options Linear Sketch Pattern  and Circular Sketch 

Pattern  can be used within a sketch to create copies of sketch 
geometry. They do not create pattern features.

Pattern 
Feature

Select 
Feature, 

Bodies or 
Faces

Propagate 
Visual 

Properties

Pattern 
Seed 
Only

Skip 
Instances

Geometry 
Pattern

Vary 
Sketch

Instances 
to Vary

Linear       

Circular     

Mirror   

Table 
Driven

  

Sketch 
Driven

  

Curve 
Driven

     

Fill     

Variable Features 
only

 All 
instances 
vary
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Linear Pattern The Linear Pattern tool creates copies, or instances, in one- or two-
dimensional arrays. Each array is controlled by a direction, a distance 
and a number of copies or instances. 

The direction can be defined by an edge, axis, temporary axis, linear 
dimension, planar face/surface, conical face/surface, circular edge, 
sketch circle/arc, or reference plane. 

The instances are dependent on the originals. Changes to the originals 
are passed on to the instanced features. This example uses the 
Spacing and Instances option. For the Up to reference option, see 
page 139. 

Note The number of instances includes the original or seed instance.

Where to Find It  CommandManager: Features > Linear Pattern 
 Menu: Insert, Pattern/Mirror, Linear Pattern

1 Open the part named 
Linear Pattern.
The part contains the seed 
feature that will be used in the 
pattern.

2 Direction 1.

Click Linear Pattern . 
Select the linear edge of the 
part and click Reverse 

Direction , if necessary, to 
set the direction shown.

Click Spacing and instances, set the Spacing to 50mm and Number 
of Instances to 5.

Note The callout is attached to the geometry used to 
define the pattern direction or axis. It contains the 
key settings for Spacing and Instances and is 
editable. Click the value field to change to change 
the value.
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Flyout 
FeatureManager 
Design Tree

The flyout FeatureManager 
design tree enables you to 
view both the FeatureMan-
ager design tree and the 
PropertyManager at the same 
time. This enables you to 
select features from the 
FeatureManager design tree 
when it would otherwise be 
obscured by the Property-
Manager. It is also transpar-
ent, overlaying the part 
graphics.

The flyout FeatureManager design tree is activated automatically with 
the PropertyManager. It may appear collapsed and can be expanded by 
clicking on the arrow icon preceding the top level feature.

3 Select features.
Click in Features and Faces and Features to 
Pattern. Select the features Cut-Extrude1, 
Fillet1 and Fillet2 from the flyout 
FeatureManager tree.

4 Direction 2.
Expand the Direction 2 group box and click a 
second linear edge as shown. 

Click Spacing and instances, set the Spacing 
to 35mm and Instances to 5.
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Skipping 
Instances

Specific instances that are generated by the pattern can be skipped by 
selecting a marker at the centroid of the instance shown in the pattern 
preview. Each instance is listed in array format (2,3) for identification. 

Note The seed feature cannot be skipped.

5 Instances to Skip.
Expand the Instances to Skip group box and drag-select the center 
instance markers as shown. The tooltip shows an array location that is 
added to the list when selected. Click OK to add the pattern feature 
LPattern1.

Note The input box can be expanded by dragging the bottom edge. 

6 Seed and instances.
Click on the pattern in the FeatureManager design tree to highlight the 
seed and instances in different colors. The tooltip for the pattern feature 
includes information about the settings that are used.
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Geometry Patterns The Geometry Pattern option is used to minimize rebuild time by 
using the Seed geometry for all Instances in the pattern. It should 
only be used when the geometry of the seed and the instances are of 
identical or similar shape.

 Without Geometry 
Pattern
If the Geometry 
Pattern option is 
cleared, the end 
condition of the seed is 
used in the instances. In 
this example, the Offset 
From Surface end 
condition of the blue 
seed feature is applied 
in the orange instances, 
forcing them to use the 
same end condition.

 With Geometry 
Pattern
If the Geometry 
Pattern option is 
checked, the geometry 
of the seed is used. The 
geometry is copied 
along the pattern, 
ignoring the end 
condition.

7 Geometry Pattern.
Right-click the LPattern1 feature and click Edit 

Feature . Check the Geometry pattern option 
and click OK. Because the plate is constant 
thickness, the resulting geometry will look the 
same.
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Performance 
Evaluation

Performance Evaluation is a tool that displays the amount of time it 
takes to rebuild each feature in a part. Use this tool to identify the 
features that take a long time to rebuild. Once they are identified, you 
can possibly edit them to increase efficiency, or suppress them if they 
are not critical to the editing process.

Introducing: 
Performance 
Evaluation

The Performance Evaluation dialog box displays a list of all features 
and their rebuild times in descending order.

 Feature Order 
Lists each item in the FeatureManager design tree: features, sketches, 
and derived planes. Use the shortcut menu to Edit Feature, Suppress 
features, and so on.

 Time%
Displays the percentage of the total part rebuild time to regenerate each 
item.

 Time
Displays the amount of time in seconds that each item takes to rebuild.

Where to Find It  CommandManager: Evaluate > Performance Evaluation 
 Menu: Tools, Evaluate, Performance Evaluation

8 Performance Evaluation.
Click Performance 

Evaluation .

The features are listed in descending 
order according to the amount of 
time required to regenerate them.

Click Close.

9 Geometry Pattern off.

Right-click the LPattern1 feature and click Edit Feature . 

Clear the Geometry pattern option and click OK.
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10 Repeat.

Click Performance Evaluation  
again.

The LPattern1 feature uses a larger 
portion of the rebuild time when the 
geometry pattern is toggled off.

11 Save and close the part.

Interpreting the Data The first thing to keep in mind is that the total rebuild time for this part 
is much less than one second, so a change to any one feature is not 
likely to make a significant difference.

The second thing is the number of significant digits and rounding error. 
For example, Feature1 may appear to take twice as long to rebuild as 
Feature2, 0.02 seconds versus 0.01 seconds. Does this indicate a 
problem with Feature1? Not necessarily. It is quite possible that 
Feature1 takes 0.0151 seconds while Feature2 takes 0.0149 seconds, 
a difference of only 0.0002 seconds.

Use Performance Evaluation to identify features that significantly 
impact rebuild time. Then either:

 Suppress or delete features to improve performance. Optionally, 
you can do this directly from the Performance Evaluation dialog 
box.

 Analyze and modify features to improve performance.

What Affects 
Rebuild Time?

Features can be analyzed to determine why they behave as they do. 
Depending on the feature type and how it is used, the reasons will vary. 

For sketched features, look for external relations and end conditions 
that reference other features. Keep these relations attached to the 
earliest feature possible. Do the same for sketch planes.

Tip In general, the more parents that a feature has, the slower it will rebuild.

For features applied to edges or faces, check the feature’s options and 
the position of the feature in the FeatureManager design tree. 
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Circular 
Patterns

The Circular Pattern tool creates copies, or instances, in a circular 
pattern controlled by a center of rotation, an angle and the number of 
copies. Changes to the originals are passed on to the instanced features.

Introducing: 
Circular Pattern

Circular Pattern creates multiple instances of one or more features 
spaced around an axis. The axis can be derived from a circular face, 
circular or linear edge, axis, temporary axis or angular dimension.

Where to Find It  CommandManager: Features > Linear Pattern  > 

Circular Pattern 
 Menu: Insert, Pattern/Mirror, Circular Pattern

1 Open the part named Circular_Pattern.

2 Pattern Axis. 

Click Circular Pattern . 

Click in Pattern Axis and click the 
cylindrical face of the model as 
shown.

3 Settings.
Click in Features and Faces and click the 
three features shown for Features to Pattern. 

Click Equal Spacing, 4 instances and click 
Geometry pattern.

Check that the Angle is set to 360° and click 
OK. 
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Note The Reverse Direction 

 and Symmetric 
options are meaningful 
only when an angle 
other than 360° is used.

4 Save and close the part.

Reference 
Geometry

There are three types of Reference Geometry that are useful in 
creating patterns: Temporary Axes, Axes and Planes. For more 
information on planes, see Planes on page 130.

Axes Axes are features that must be created using one of several methods. 
The advantages to creating an axis is that it can be renamed, selected by 
name from the FeatureManager design tree, and resized. 

Temporary Axes Every cylindrical and conical face has an axis associated with it. To 
view a specific temporary axis, float the cursor over a cylindrical or 
conical face of the part. To view all of the temporary axes in the part, 
click View, Temporary Axes. 

One axis is displayed through each circular face in the model.

Here are some examples of creating feature axes:

Temporary Axes 
can be made 
permanent using 
the One Line/
Edge/Axis option.

Select two planes 
or planar faces and 
the option Two 
Planes.
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Where to Find It  CommandManager: Features > Reference Geometry  > 

Axis
 Menu: Insert, Reference Geometry, Axis

Where to Find It  Float over a cylindrical or conical face

 Heads-up View Toolbar: Hide/Show Items  > 

View Temporary Axes 
 Menu: View, Temporary Axes

Select Two 
Points/Vertices to 
define an axis 
through them. 

Select a 
Cylindrical/
Conical Face to 
define an axis 
through the 
rotational center.

Select a plane or 
planar face and a 
point or vertex to 
define an axis 
normal to the 
plane through the 
point.

View and use the 
temporary axes of 
any part.
129



Lesson 4 SOLIDWORKS Education 2023
Patterning
1 Open the part named Circular_Pattern with Axis.

2 Create axis.

Click Axis  and select the Front and Right 
planes as shown. The Two Planes option is 
selected automatically. Click OK to add Axis1.

3 Circular pattern.

Click Circular Pattern , click in Pattern Axis and click the axis 
Axis1. Click in Features and Faces and click the feature  
Cut-Extrude1. Click Equal Spacing, 4 instances and OK.

4 Save and close the part.

Planes The Plane Wizard can be used to create a variety of planes using 
different geometry. Planes, faces, edges, vertices, surfaces and sketch 
geometry can all be used to apply constraints through First, Second 
and optionally Third References. The Fully defined state is listed 
when it is reached. 

Note To view and select hidden planes in a part or an assembly 
component, press Q. This can be particularly useful when 
creating mates in an assembly. See Things to which you 
can mate on page 222 for more information. 
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Tip If the selections cannot be combined to form a 
valid plane, a message appears in the dialog. 

Shortcut Press Ctrl and drag an existing plane to start the Offset Distance plane 
as shown below. 

Here are some examples of creating planes: 

Offset Distance
Select a planar 
face or plane and a 
distance. 

Optionally create a series 
of parallel planes the 
same distance apart.

Angle
Select a planar 
face or plane and 
an edge or axis.

Optionally create a 
series of angled planes 
the same distance apart.

Coincident
Select three 
vertices.

Coincident
Select a line and a 
single vertex.
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Parallel
Select a face and a 
vertex.

Tangent and 
Perpendicular
Select a cylindrical 
face and a planar 
face or plane with 
Perpendicular. 

Tangent and 
Parallel
Select a cylindrical 
face and a planar 
face or plane with 
Parallel. 

Mid Plane
Select two planar 
faces with Mid 
Plane. 
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Note The toggle View, Hide/Show All Types can be used to hide or show all 
planes, axes and sketches at once.

Where to Find It  CommandManager: Features > Reference Geometry  > 

Plane
 Menu: Insert, Reference Geometry, Plane

1 Open the part named Mirror_Pattern.
A cut feature in this model will be mirrored across one and two planes.

2 First reference.

Click Plane  and select the outer face as 
shown.

Perpendicular at 
a Point
Select a sketched 
line and an 
endpoint.

As a shortcut to 
Perpendicular at a Point, 
select an edge/line and 
click Insert, Sketch. The 
plane is created and a 
sketch opened on it.

Create a plane 
parallel to the 
screen
Select a vertex and 
optionally an 
offset.

Optionally, right-
click geometry and 
click Create 
Plane Parallel to 
Screen.
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3 Second reference.
Select the second outer face as shown. A 
preview of the plane appears centered between 
the reference selections. The Mid Plane option 
is selected automatically. Click OK. 

Name the plane vert_ctr.

4 Second plane.
Click Plane again and select the top face as the 
First Reference. Set it to Parallel. 
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5 Temporary axis.
Float the cursor over the cylindrical face 
of the center hole, select the temporary 
axis that appears, and click OK.

The plane is a parallel to the top face and 
passes through the center of the hole.

Name the plane hor_ctr.

Mirror Patterns The Mirror Pattern tool creates a copy, or instance, across a plane or 
planar face. The instance is dependent on the original. Changes to the 
original propagate down to the mirrored instance(s).

Introducing: 
Mirror Pattern

Mirror Pattern creates one instance of one or more features or a body 
across a plane or planar face. Optionally, the features can also be 
patterned across a secondary plane. 

Where to Find It  CommandManager: Features > Linear Pattern  > Mirror 
 Menu: Insert, Pattern/Mirror, Mirror

6 Mirror.

Click Mirror , and select the vert_ctr 
plane as the Mirror Face/Plane.

Select the library feature Keyed Hole 1 as the 
Features to Mirror. Do not click OK yet.
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7 Secondary Mirror.
Select the hor_ctr plane as the Secondary 
Mirror Face/Plane. 

8 Cuts into other features.
The patterned Keyed Hole 1 feature 
cuts into the existing fillet and through 
the front wall. Changes to the feature 
can fix the problem.

9 Changes.
Double-click the Keyed Hole 1 
feature, and change the edge distance 
dimension to 0.625 as shown.

Also, change the feature extrude depth 
to Up to Next and click OK.

and rebuild.

10 Save and close the part.
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Patterning a Solid 
Body

To mirror all the geometry of a part (the body) about a common face, 
use the common face and the solid body. 

Note The Mirror Face/Plane must be planar. 

Where to Find It Mirror PropertyManager: Bodies to Mirror

1 Open the part named Mirror_Body.

2 Mirror.

Click Mirror  and the face as shown. Click 
Full preview. 

3 Bodies to mirror. 
Click in Bodies to Mirror, and select the part in the graphics area. 
Click OK.

4 Save and close the part.
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Using Pattern 
Seed Only

The Pattern Seed Only option is used when a two direction pattern is 
created. The second direction defaults to patterning all geometry 
created by the first direction unless Pattern Seed Only is used to 
pattern only the original or seed geometry. It is commonly used to 
prevent overlapping results when the two directions use the same 
vector.

Where to Find It Linear Pattern PropertyManager: Pattern Seed Only

1 Open the part named Seed_Pattern.

2 Direction 1.

Click Linear Pattern .

Select the edge as the Pattern 
direction. Click Spacing and 
instances, 30mm as the 
Spacing, and 2 as the Number 
of Instances.

For Features and Faces, 
select the library feature 
3_Prong_Plug2.

Note An existing pattern feature can be used as the Features and Faces. 
This enables you to pattern the pattern.

3 Direction 2.
For Direction 2, select 
the edge on the opposite 
side as the direction, 
reversing the arrowhead. 
Set the instances to 2, 
spacing to 50mm.

Note As seen in the preview, the original (seed) feature is patterned in both 
directions. 
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4 Pattern seed only.
Click Pattern seed 
only to remove the extra 
instance.

Set the Direction 2 
Spacing to 30mm and 
click OK.

5 Save and close the 
part.

Up To 
Reference

The Up To Reference option is used to create a linear pattern based on 
geometry rather than the number of instances. It can be used when the 
spacing is known but the number of instances is based on how many 
instances can fit. This example uses a part similar to the Linear Pattern 
on page 121. 

The Up To Reference selection sets the limit. The 
Selected Reference, on the source feature, is compared to the limit. 
Only the instances that fall under the limit are used. 

If the Up To Reference selection is combined with an 
Offset Distance, the offset is from the Selected Reference.

Note The selections can be vertices, edges, faces, or planes.

Where to Find It Linear Pattern PropertyManager: Up to reference

1 Open the part named Up To Reference.

Selected Reference

Up To Reference

Selected Reference

Offset Distance
139



Lesson 4 SOLIDWORKS Education 2023
Patterning
2 Select reference.

Click Linear Pattern . Select the planar 
face as the Pattern direction. Set the Spacing 
to 30mm. Click in Features and Faces and 
select the cut feature and fillets. 

3 Seed reference.
Click Up to reference and select the (green) 
edge.

Click Selected Reference and select the 
(purple) edge of the seed feature as shown.

The number of instances its limited by the 
distance between the seed and the reference.
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4 Spacing and instances.
The spacing drives the number of instances.

Change the spacing to 80mm. Only three instances can fit at this 
spacing.The fourth instance would lie beyond the reference edge.

Change the spacing to 70mm. Only four instances can fit at this 
spacing. The up to reference and the selected reference edges line up. 
Any larger value than the current one (71mm) would drop the number 
of instances to three.

Change the spacing to 50mm.

5 Two direction pattern.
Optionally a two direction 
pattern can be added using 
35mm spacing and skipped 
instances as shown. 

6 Save and close the part.
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Sketch Driven 
Patterns

The Sketch Driven 
Patterns tool creates 
copies, or instances, in 
an arrangement 
controlled by sketch 
points. The pattern can 
be based on the 
centroid of the seed or 
a selected point off the 
centroid.

This example 
represents the holes in 
a structural steel plate.

Introducing: Sketch 
Driven Pattern

Sketch Driven Pattern creates multiple instances based on points in a 
selected sketch. The sketch must exist before the pattern is created.

Where to Find It  CommandManager: Features > Linear Pattern  > 

Sketch Driven Pattern 
 Menu: Insert, Pattern/Mirror, Sketch Driven Pattern

Tip Only point geometry is used by the Sketch Driven pattern. Other 
geometry, such as construction lines, can be used to position points but 
will be ignored by the pattern.

1 Open Sketch_Driven.
The part contains a seed feature (Hole) and an 
existing linear pattern feature (Standard 
Linear).
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Points Points are a useful type of sketch geometry used to position hole wizard 
holes and drive sketch driven patterns. They can be created individually 
or based on geometry.

Introducing: Point The Point tool creates point entities in the active sketch. The sketch 
entity Point can be used to locate a position in a sketch that other 
geometry (endpoints for example) cannot.

Where to Find It  CommandManager: Sketch > Point 
 Menu: Tools, Sketch Entities, Point
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Point 

Equal Spacing Use the Segment tool to create equidistant points along a line or arc/
circle. To create and maintain the spacing, an Equidistant relation  is 
applied to each sketch point. 

Where to Find It  Menu: Tools, Sketch Tools, Segment

2 Sketch with points.
Create a new sketch on the 
front face of the Plate feature. 
Create the centerline and add 
the points and dimensions as 
shown. 

Exit the sketch. 
143



Lesson 4 SOLIDWORKS Education 2023
Patterning
3 Sketch driven pattern.

Click Sketch Driven Pattern  and click the 
new sketch and the Centroid option. Under 
Features and Faces, select the Hole feature and 
click OK.

4 Add points.
Create another sketch and add points in the 
pattern shown, using inferencing to line up the 
rows horizontally as shown.

Automatic 
Dimensioning of 
Sketches

Fully Define Sketch creates relations and dimensions in a sketch. 
Several dimension styles, such as baseline, chain and ordinate are 
supported. The starting points for horizontal and vertical sets can be 
set.

Note In some examples, shaded sketch contours are toggled off for clarity.
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Introducing: Fully 
Define Sketch

Fully Define Sketch has options for relations to be added, dimension 
type, dimension start location, and dimension positions.

Note A special option Centerline appears when centerline geometry is used 
in the sketch. Dimensions can be based from the centerline.

Where to Find It  Menu: Tools, Dimensions, Fully Define Sketch

 CommandManager: Sketch > Display/Delete Relations  > 

Fully Define Sketch 
 Shortcut Menu: Right-click in the graphics area and click 

Fully Define Sketch

Under defined sketch with 
geometric relations.

Chain option selected with 
start point at origin.

Note: Some dimensions 
have been moved for 
clarity.

Baseline option selected 
with start points at origin.

Ordinate option selected 
with start points at origin.
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5 Relation and dimension setup.
Click Fully Define Sketch.

Under Relations leave the default, Select All.

In Dimensions, select the endpoint of the sketch 
centerline as the datum for dimensions in both 
directions.

Set both Schemes to Baseline.

Click Calculate and OK.

6 Relations and dimensions.
Horizontal relations and dimensions are added to fully define the 
sketch.

Set the values as shown and exit the sketch. 

Note Sketches dimensioned this way are fully defined but can be edited. You 
can delete and replace dimensions if required.
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7 Pattern.
Add another sketch driven pattern using the new 
sketch and the same seed feature, Hole.

8 Save and close the part.
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Exercise 12:
Linear Patterns

Create feature patterns in this part 
using a Linear Pattern with Spacing 
and Instances or Up to reference.

This lab uses the following skills:

 Linear Pattern on page 121
 Skipping Instances on page 123
 Up To Reference on page 139

Procedure Open an existing part.

1 Open the part Linear.
The part includes the “seed” 
feature used in the patterns.

2 Linear pattern.
Create a pattern using the seed feature. Use the dimensions below.

3 Save and close the part.
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Exercise 13:
Sketch Driven 
Patterns

Create feature patterns using a Sketch Driven Pattern. 
The model is an elevator panel.

This lab uses the following skills:

 Sketch Driven Patterns on page 142

Procedure Open an existing part.

1 Open the part Sketch Driven Pattern.
The part includes the “seed” feature used in the 
pattern.

2 Sketch driven pattern.
Use the dimensions shown 
to define the sketch. Use the 
sketch to create a sketch 
driven pattern.

3 Save and close the part.

Thanks to Marcus Brown of MLC CAD 
Systems for submitting this example.
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Exercise 14:
Skipping 
Instances

Complete this part using the 
information and dimensions provided.

This lab reinforces the following skills:

 Linear Pattern on page 121
 Skipping Instances on page 123
 Mirror Patterns on page 135

Units: millimeters

Procedure Create a new part.

1 New part.
Create a new mm part 

2 Base feature.
Create a block 
75mmx380mmx20mm.  
It will be useful to have a 
plane centered along the long direction.

3 Seed.
Create the seed feature using the 
Hole Wizard and an ANSI Metric 
drill.

4 Pattern.
Pattern the hole, skipping instances as shown in the diagram below.

5 Pattern of a pattern.
Mirror the pattern to create a symmetrical arrangement of holes.

6 Change.
Change the hole to 4mm diameter and rebuild.

7 Save and close the part.
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Exercise 15:
Linear and 
Mirror Patterns

Complete this part using the information and 
dimensions provided.

This lab reinforces the following skills:

 Linear Pattern on page 121
 Mirror Patterns on page 135
 Patterning a Solid Body on page 137

Procedure Open an existing part.

1 Open the part Linear & Mirror.

2 Linear pattern.
Using the existing feature, create a Linear Pattern 
that results in three grooves that are spaced 0.20”.

3 Mirror features.
Using a single pattern feature, create the duplicate 
boss and cut as shown.

4 Symmetry.
Use a third pattern feature to create the full model 
from the half model using Bodies to Mirror. 

5 Save and close the part.
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Exercise 16:
Mirror Body

Complete this part using the information and 
dimensions provided.

This lab reinforces the following skills:

 Mirror Patterns on page 135
 Patterning a Solid Body on page 137

Procedure Open an existing part.

1 Open the part Mirror Body.
At the feature recognition message, click No.

2 Mirror body.
Using the existing solid body, mirror about one, 
then two planar faces of the model.

3 Save and close the part.
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Exercise 17:
Circular 
Patterns

Complete this part using the 
information and dimensions 
provided.

This lab reinforces the following 
skills:

 Circular Patterns on page 127 

Procedure Open the existing part Circular. 
Use an equally spaced circular 
pattern to pattern the cut and 
fillet for 12 total instances. 
153



Exercise 18 SOLIDWORKS Education 2023
Axes and Multiple Patterns
Exercise 18:
Axes and 
Multiple 
Patterns

Complete this part using the information 
and dimensions provided.

This lab reinforces the following skills:

 Axes on page 128
 Linear Pattern on page 121
 Circular Patterns on page 127
 Sketch Driven Patterns on page 142

Procedure Open the existing part Single Die. Use the drawing below to pattern 
the Dot feature on the sides as shown. 

The face colors are used to help distinguish between the individual 
faces. See step 4 on page 156 for removing the colors. 

Note Orient the part as shown in each step before starting work.
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1 Axes. 
Create an axis using the Front and Right 
planes. 

Create two more axes using the Top and 
Front and the Right and Top reference 
planes. 

All three axes should pass through the 
cube center. 

2 Side Two.
Using a Linear Pattern with Instances to 
Skip, create the “two” side. 

3 Remaining sides. 
Complete the remaining sides using the descriptions of each one listed 
below. 

 Side Three
Use a Circular Pattern with an axis 
to create a cut at the center of the 
face. 

Create a sketch and use a Sketch 
Driven Pattern with Faces to 
Pattern to create the remaining cuts.

 Side Four
Use a Circular Pattern with an axis to 
create the remaining cuts. 
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 Side Five
Use a procedure similar to that of side 
three. 

 Side Six
Use a Circular Pattern with an axis to 
create a cut at the corner of the face. 

Use a Linear Pattern to create the 
remaining cuts.

4 (Optional) Remove face colors. 
Marking faces with colors is a modeling 
method that helps with face recognition. 
The face colors can be removed after the 
modeling is complete. Follow these steps:

1. Click Edit Appearance  from the Heads-up View toolbar.
2. Clear Select Geometry by right-clicking Clear Selections.
3. Click Select Faces and select the non-red faces.
4. Click Remove Appearance and OK.

5 Save and close the part.
156



Lesson 5
Revolved Features

Upon successful completion of this lesson, you will be able to:

 Create revolved features.

 Apply special dimensioning techniques to sketches for revolved 
features.

 Use the multibody solid technique.

 Create a sweep feature.

 Calculate the physical properties of a part.

 Perform rudimentary, first pass stress analysis.
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Case Study: 
Handwheel 

The handwheel requires 
the creation of revolved 
features, circular 
patterns and sweep 
features. 

Also included in this 
lesson are some basic 
analysis tools. 

Stages in the 
Process

Some key stages in the modeling process of this part are shown in the 
following list. 

 Design intent
The part’s design intent is outlined and explained.

 Revolved features
The center of the part is the Hub, a revolved shape. It will be created 
from a sketch with a construction line as the axis of revolution.

 Multibody solids
Create two discrete solids, the Hub and the Rim, connecting and 
merging them using a third solid, the Spoke.

 Sweep features
The Spoke feature is created using a sweep feature, a combination of 
two sketches that defines a sweep profile moving along a sweep path.

 Analysis
Using analysis tools, you can perform basic analysis functions such as 
mass properties calculations and first-pass stress analyses. Based on the 
results, you can make changes to the part’s design.
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Design Intent The design intent of this part is shown below:

 Spokes must be evenly spaced.
 The center of the rim of the handwheel lies at the end of the spoke.
 The hub and the rim share the same center.
 The spokes pass through the center of the hub.

Revolved 
Features

The Hub is a revolved feature that is created by revolving geometry 
around an axis. Revolved features require axisymmetric geometry and 
a line (used as the axis) in the sketch. This revolved feature will be used 
as the center of the wheel. Under the right circumstances, a sketch line 
or an edge may also be used as the centerline.

Procedure To begin this case study:

1 Create a new part using the Part_MM template.
Save the part as Handwheel. 

Sketch Geometry 
of the Revolved 
Feature

Geometry for the revolved feature is created using the same tools and 
methods as extruded features. In this case, lines and arcs will be used to 
form the shape and a centerline is used as the axis of revolution.

2 Rectangle.
Select the Right Plane and click Sketch. 

Create a rectangle from the Origin as shown. 

Rim

Handwheel
Hub

Spoke

Diameter
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3 Convert to construction.
Select the vertical line shown and click For 
Construction. The line is converted into a 
construction line.

The shading is removed because this is no longer a 
closed contour.

Introducing:
3 Point Arc

The 3 Point Arc option enables you to create an arc based on three 
points: the two endpoints followed by a point on the curve.

Where to Find It  CommandManager: Sketch > Centerpoint Arc  > 

3 Point Arc
 Menu: Tools, Sketch Entities, 3 Point Arc
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, 3 Point Arc 

4 Insert 3 Point Arc.

Click 3 Point Arc .

Begin the arc by positioning the 
cursor on the left vertical line and 
dragging downwards along that 
edge. Release the mouse button 
and then select and drag the point 
on the curve away from the 
sketch.

5 Trimming.
Use the Trim tool with the Power Trim option and 
trim away the portion of the line inside the arc.
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Rules Governing 
Sketches of 
Revolved Features

In addition to the general rules governing sketches that 
were listed in Lesson 2: Introduction to Sketching, some 
special rules apply to sketches of revolved features:

 A centerline, axis, sketch line or linear edge must be 
specified as the axis of revolution.

 The sketch must not cross the axis.

Special 
Dimensioning 
Techniques

Revolved geometry is dimensioned like any other with one additional 
option. Dimensions that measure diameters on the finished feature can 
be changed from linear to diameter dimensions.

We will also dimension to the outside of the arc in the sketch, rather 
than the center point which is the default. 

6 Arc dimension.
Dimension the arc by selecting the vertical line 
and then Shift-selecting the circumference of 
the arc. The result is a dimension between the 
line and the tangent of the arc.

7 Finished dimension.
Change the Value to 4mm.

8 Dimensions.
Add the following dimensions to the sketch.

Not Valid
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Diameter 
Dimensions

Some dimensions should be doubled dimensions in the finished 
revolved feature. For these dimensions, always select the centerline 
(axis of revolution) as one of the picks. You then have your choice of 
either a radius or diameter dimension, depending on where you place 
the dimension text. If you don’t pick the centerline, you won’t be able 
to change the dimension to a diameter.

Note This option is available only if a centerline is used as the axis of 
revolution. Doubled dimensions are not restricted to use in revolved 
feature sketches.

9 Dimension to centerline.
Dimension between the centerline and the 
outer vertical edge to create a horizontal 
linear dimension.

Do not click to place the dimension text just 
yet.

Notice the preview. If you place the text now, 
you will get a radius dimension.

10 Move the cursor.
Move the cursor to the right of the 
centerline. The preview changes to a 
diameter dimension.

Click to place the dimension text. Change 
the value to 25mm and press Enter.

Normally, a diameter dimension should 
have a diameter symbol preceding it, 

thus: . When the revolved feature is 
created from the sketch, the system will 
automatically add the diameter symbol to 
the 25mm dimension.

Note If you inadvertently place the dimension text in the wrong place, and 
get a radius dimension instead of a diameter, you can fix it. Click the 
dimension, and click the Leaders tab of the Dimension 

PropertyManager. Click the Diameter button  to make the 
dimension a diameter dimension.
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Creating the 
Revolved Feature

Once the sketch is completed, it can be made into a revolved feature. 
The process is simple, and a full (360°) revolution is almost automatic.

Introducing: 
Revolved Feature

The Revolve option enables you to create a feature from an 
axisymmetric sketch and an axis. This feature can be a base, boss or cut 
feature. The axis can be a centerline, line, linear edge, axis or 
temporary axis. If a single centerline is present in the profile, it is used 
automatically. If more than one is present, you must select it.

Where to Find It  CommandManager: Features > Revolved Boss/Base 
 Menu: Insert, Boss/Base, Revolve

11 Make the feature.

Click Revolved Boss/Base . 

A message will appear indicating that the sketch 
is an open contour and asking if you want to close 
the contour automatically. Click Yes.

Use the settings as shown.

 Direction1 = Blind

  (Angle) = 360° 

Click OK  to create the feature.

12 Finished feature.
The solid revolved feature is created as the first feature 
of the part.

Rename it Hub.
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13 Edit the sketch.
Click a face of the Hub. Click the sketch Sketch1 
from the Selection Breadcrumbs and click Edit 
Sketch.

Note You can right-click the feature in the FeatureManager design tree and 
achieve the same result.

14 Normal To.

Click Normal To  to change the view normal to the sketch. Do this 
to see its true size and shape.

Introducing:
Sketch Fillet 

Sketch Fillets can be used to trim and add tangent arcs in a single step. 
If the corner has been trimmed, select the vertex point to add the fillet. 

Where to Find It  CommandManager: Sketch > Sketch Fillet 
 Menu: Tools, Sketch Tools, Fillet
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Tools, Sketch Fillet 

15 Fillet settings.

Click Sketch Fillet  and set the value to 5mm. 
Make sure the Keep constrained corners option 
is checked.

16 Selections.
Select both endpoints of the arc and click 
OK. 

The dimension drives both but only 
appears once, at the last selection. 

Virtual Sharp symbols are added where 
the corners were. These symbols represent 
the missing corners and can be 
dimensioned to or used within relations.

Note Floating over an endpont shows a preview of the fillet. 
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17 Exit the sketch.
Exit the sketch to cause the changes to take effect.

Building the 
Rim 

The Rim of the Handwheel is 
another revolved feature. It too is 
revolved 360°. The profile of the 
Rim is a slot shape. 

The Rim will be created as a sep-
arate solid body, not merged to 
the Hub.

Slots Straight and arc Slots are common 
shapes based on lines and arcs. The 
slot is a single entity which is 
composed of lines, arcs, construction 
geometry and points. 

Introducing: Slots The Slot tool is used to create straight and arc slot shapes based on 
different criteria. There are two types based on lines and two types 
based on arcs. All slot types have the option to create dimensions with 
the geometry. The following types are available: 

Slot Type Resulting Geometry

Straight Slot The Straight Slot is created by locating 
the centerpoints of the arcs and then 
dragging outwards to create the width. 
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Where to Find It  CommandManager: Sketch > Straight Slot , 

Centerpoint Straight Slot 
 Menu: Tools, Sketch Entities, Centerpoint Straight Slot
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Centerpoint Straight Slot 

Centerpoint Straight 

Slot 

The Centerpoint Straight Slot is created 
by locating the geometric center, one of 
the arc centerpoints and then dragging 
outwards to create the width. 

3 Point Arc Slot The 3 Point Arc Slot is created like a 3 
Point Arc (see Introducing: 3 Point Arc 
on page 160) and then dragging outwards 
to create the width.

Centerpoint Arc Slot The Centerpoint Arc Slot is created like 
a Centerpoint Arc (see Sketch Geometry 
on page 33) and then dragging outwards to 
create the width.

Slot Type Resulting Geometry
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18 Sketch.
Create a new sketch on the Right plane. Orient the model in the same 
direction.

19 Centerpoint Straight Slot.

Click Centerpoint Straight Slot . Click 
Add dimensions and Overall Length. Click 
the location of the centerpoint and a location 
horizontally to the right. A third click sets the 
slot width. Click OK and set the dimension 
values as shown.

Tip The dimensions are added automatically if the Add dimensions option 
is clicked. 

20 Rotation axis.

Add a centerline using Centerline , setting 
Vertical and Infinite length. Place the line at the 
origin. This will be the axis of revolution for the 
revolved feature.

Add a diameter dimension from the centerline to 
the centerpoint of the slot, and from the slot 
centerline to the top edge of the Hub.

The sketch is now fully defined.
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Potential Ambiguity If the sketch contains more than one centerline, the system will not 
know which centerline is intended to be the axis of revolution. The 
centerline to be used can be selected either before or after selecting the 
Revolve tool.

21 Completed feature.

Select the infinite vertical centerline. Click Boss/Base, Revolve . 
Use an angle of 360°. Rename the feature to Rim.

Multibody Solids Multibody solids occur when there is more 
than one solid body in a part. In cases where 
discrete features are separated by a distance, 
this can be the most efficient method in 
designing a part.

The Solid Bodies folder holds the bodies and also 
lists how many bodies are currently housed in the 
folder (2). The bodies can be merged or combined 
later to create a single solid body.

For more information on multibody parts, see the 
Advanced Part Modeling training manual.

Building the 
Spoke 

The Spoke feature will be created using a Sweep feature that requires 
two sketches: a profile and a path. The sweep pushes a closed contour 
profile along an open contour path. The path is sketched using lines and 
tangent arcs. The profile is sketched using an ellipse. The feature will 
bridge the space between the existing Hub and Rim features and 
combine them into a single solid body.

The Spoke feature is important because it will be patterned to create 
any number of evenly spaced spokes.
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22 Open the Display Pane. 
In the FeatureManager design tree, click  to expand the Display 
Pane. It contains columns which can be used to change display 
properties of items in the tree. 

23 Search. 
Use the FeatureManager Search 

box  to search by the 
starting letters of a name or some 
portion of the name. 

Type ske into the FeatureManager 
Design Tree filter to show the sketches of the Hub and Rim. 

Click on the sketch icon for the Hub to show it. Repeat for the Rim.

24 Setup.
Create a new sketch on the Right plane and change the display to 
Hidden Lines Visible.

25 Sketch line.
Sketch a horizontal Line 
running from the centerline 
inside the Hub boundaries.

26 Tangent arc.
Create a Tangent Arc from 
the line endpoint in the 
direction shown. The actual 
values are not important as 
you sketch. They will be 
defined by dimensions later.

27 Connecting tangent arc.
With Tangent Arc still 
selected, continue sketching 
by using the previous arc’s 
endpoint as a start. Sketch this 
arc tangent to the first, ending 
at a horizontal tangency posi-
tion.
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Tip When the vertical inference line coincides with the arc’s center, the 
tangent of the arc is horizontal.

28 Horizontal line.
Sketch a final line. It is 
horizontal, with its length 
to be determined by 
relations and dimensions.

29 Relations.
Drag and drop the left 
endpoint of the line onto the 
centerpoint of the Rim sketch. 
A Coincident relation is 
added.

Add another relation between 
the line at the opposite end 
and the centerpoint of the arc.

30 Return to a shaded display.

Click Shaded  to change the display.

31 Fully define sketch.
Add an Equal relation to the 
arcs and add dimensions. 

Tip Picking end points and centers allows for more options when creating 
the dimensions.

32 Exit sketch.

Click Exit Sketch  to close the sketch without using it in a feature. 
Hide the Hub and Rim sketches.
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Introducing: 
Insert Ellipse

Sketching an ellipse is similar to sketching a circle. Position the cursor 
where you want the center and drag the mouse to establish the length of 
the major axis. Then release the mouse button. Next, drag the outline of 
the ellipse to establish the length of the minor axis.

Important! To fully define an ellipse you must dimension or otherwise constrain 
the lengths of the major and minor axes, and also constrain the orienta-
tion of one of the two axes. One way to do this is with a Horizontal 
relation between the ellipse center and the end of the major axis.

Where to Find It  CommandManager: Sketch > Ellipse 
 Menu: Tools, Sketch Entities, Ellipse
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Ellipse 

33 Ellipse.
Create a new sketch on 
the Front plane. Click 

Ellipse  and position 
the centerpoint at the end 
of the line. Move away 
from the center and 
position the major and 
minor axes with 
additional clicks.

34 Relations and 
dimensions.
Add relations to make the 
centerpoint and one of the 
major axis points 
Horizontal. Add the 
dimensions as shown.

Exit the sketch.
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Introducing: Sweep Sweep creates a feature from two sketches: a sweep profile and sweep 
path. The profile is moved along the path, creating the feature.

Note The Circular Profile option uses a path sketch with a circle diameter.

Where to Find It  CommandManager: Features > Swept Boss/Base 
 Menu: Insert, Base/Boss, Sweep

Note The Sweep command is covered in depth in the 
Advanced Part Modeling course.

35 Sweep.

Click Swept Boss/Base . Select the closed 
contour sketch as the Profile and the open 
contour sketch as the Path. 

Click OK. 

36 Results.
Name the new feature 
Spoke. There is a single 
solid body after the new 
feature is merged.

37 Pattern the Spoke.

Click Circular Pattern . Select the 
cylindrical face as the center of rotation for the 
pattern. Using the Spoke, set the Number of 
Instances to 3 with Equal spacing.
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Rotate View Rotate View  enables you to rotate the view of the model freely. To 
restrict that motion, you can choose an axis, a line or edge, a vertex, or 
a plane. Click the Rotate View tool and the center axis.

The same result can be obtained using the middle mouse button 
rotation. Select the entity to rotate about using the middle mouse 
button, then drag with the middle mouse button.

38 Rotate.
Rotate about the Handwheel center axis by 
clicking a circular edge or cylindrical face of 
the Hub with the middle mouse button. Then 
Drag the middle mouse button to activate the 
rotate command.

Edge Selection The Edge Selection toolbar can assist in selecting combinations of 
edges that are related to selected edge in some way. It is a multiple edge 
selection method that can be used in combination with any other 
selection methods. 

For example, selecting this single edge offers several different 
combinations of edges (shown as blue and dashed), each under a 
different icon and name.

Between right feature Between left feature

Between right feature

All All concave

and part and part

and left feature

Close Selection Toolbar
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Note The number of available edge combinations, along with the naming and 
icons, will vary based on the selected edge. This toolbar can also be 
toggled off or ignored in favor of direct selections.

Direct Selection Similar results can be achieved through the direct selection of six edges 
or two faces. Selection of a face selects all edges of that face.

Note Face selections make the model better suited to withstand dimensional 
changes.

39 Add fillets.
Click Fillet and click 
Show selection toolbar.

Select an edge, and use the 
All Concave selection. Add 3mm 
fillets to the edges as shown.

Other Selection 
Options

You can also select edges by dragging a window or using keyboard 
shortcut. 

 Drag the window from left to right, all the edges that are entirely 
inside the window are selected. 

 Press Ctrl+A to select all the edges. 
174



SOLIDWORKS Education 2023 Lesson 5
Revolved Features
Chamfers Chamfers create a bevel feature on edges or vertices of a model. The 
shape can be defined by two distances or a distance and an angle. In 
many ways, chamfers are similar to fillets in that you select edges and/
or faces in the same way.

Where to Find It  CommandManager: Features > Fillet  > Chamfer 
 Menu: Insert, Features, Chamfer

 Shortcut Menu: Right-click a face or edge and click Chamfer 

40 Chamfer.
Add a Chamfer feature using the top edge of 
the Hub feature. Select the Chamfer Type 
Distance Distance and the Chamfer Method 
Asymmetric. 

Set the distances using the values shown.

Fillets to Chamfers Another way to create a chamfer is by the conversion of an existing 
fillet. This can be done using the shortcut menu or while editing the 
feature.

Where to Find It  Shortcut Menu: Right-click a face or edge and click 

Convert Fillet to Chamfer 

RealView Graphics If you have a certified graphics accelerator, you may be able to use the 
RealView Graphics option. It provides high-quality, real time material 
shaders when available. 

Where to Find It  Menu: View, Display, RealView Graphics

 Heads-up View Toolbar: View Settings , 

RealView Graphics
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Note If you do not have RealView Graphics, skip to step 45 on page 178. 

Tip If RealView Graphics are not available, the icon will be grayed out. 

Appearances, 
Scenes and Decals 

The Appearances, Scenes and Decals tab of the Task Pane contains 
three main folders: Appearances(color), Scenes and Decals.

RealView On RealView Off
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41 RealView on.

Click RealView  to toggle it on.

42 Appearances and scenes. 
From the Appearances, 
Painted, Powder Coat 
folder, drag and drop 
aluminum powdercoat into 
the graphics window. 

From the Scenes, Basic 
Scenes folder, drag and 
drop Backdrop - Black 
with Fill Lights into the 
graphics window. 

Tip The Apply Scene  flyout tool on 
the Heads-up View toolbar allows 
you to select and apply a scene from 
the list. 

Another option is to click the icon to 
rotate through the list one at a time. 

Appearances Colors and textures are applied using Appearances. This menu has 
tabs for Color/Image and Mapping. 

 Color is used to apply a color to the texture added from the 
Appearance folder. 

 Mapping is used to change the mapping style of the texture added 
from the Appearance folder. 
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43 Color. 
Click Edit Appearance and change the color 
using a greyscale color swatch and light gray or 
white. Click OK. 

Note Applying an appearance does not apply a material to the part. For 
applying materials, see Edit Material on page 178. 

Tip Click View, Display, Ambient Occlusion to add realism to the shaded 
model. 

44 RealView off.

Click RealView  to toggle it off.

45 Save and close all files.

Edit Material The Edit Material dialog is used to add and edit the material associated 
with a part. The material is used for calculations that rely on material 
properties, including Mass Properties and SimulationXpress. The 
material can vary by configuration. 

It's important to understand that applying an appearance is not the same 
as defining a material for the part. Appearances control the display of 
the model, while editing the material will apply material properties for 
the calculation of mass and density and often associated appearances.

Tip Part templates (*.prtdot) can include a predefined material.

Where to Find It  Shortcut Menu: Right-click Material  and click 

Edit Material
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1 Open HW_Analysis.
Open the existing part HW_Analysis. This part has additional features 
needed for use in the analysis section of this lesson.

2 Materials.

Right-click Edit Material  and click SOLIDWORKS Materials, 
Copper Alloys, Aluminum Bronze. 
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Note The Properties, 
Appearance and 
CrossHatch are those 
assigned by the 
selected material. 

3 Color. 
Click Apply and Close. 
A change in material 
changes the color of the 
part. The material name is 
also updated in the 
FeatureManager design 
tree.
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Mass Properties One of the benefits of working with a solid model is the ease with 
which you can perform engineering calculations such as computing 
mass, center of mass, and moments of inertia.

Notes  Section Properties can also be generated from a planar face or a 
sketch in a model. The sketch can be active or selected.

 You can add a Center of Mass (COM) feature. You can measure 
distances and add reference dimensions between the COM and 
other entities. You add a COM point in the Mass Properties dialog 
box or by clicking Insert, Reference Geometry, Center of Mass.

Introducing:
Mass Properties

Mass Properties is used to generate the mass properties of the entire 
solid. The properties include mass, volume and a temporary display of 
the principal axes.

Where to Find It  CommandManager: Evaluate > Mass Properties 
 Menu: Tools, Evaluate, Mass Properties

4 Mass properties.

Click Mass Properties . The Density of Aluminum Bronze is 
used. The results of the calculations are displayed in the dialog box.

Note For those parts that do not posses an accurate physical description, you 
can click Override Mass Properties. You can override mass, center of 
mass, and the moments of inertia. This is helpful when you use 
simplified models of purchased components.
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To change the units, click Options, click 
Use custom settings, and set the units. 
There are other options you can set 
including the density and the accuracy 
level of the calculations.

Mass Properties 
as Custom 
Properties

Components of the Mass Properties of a part can be carried with the 
part as a Custom Property. This information can be extracted by a Bill 
of Materials report.

File Properties File properties are details about Windows based files that help identify 
it – for example, a descriptive title, the author name, the subject, and 
keywords that identify topics or other important information in the file. 
Document properties can be used to display information about a file or 
to help organize files so that they can be found easily. You can search 
for documents based on document properties.

There are file properties unique to SOLIDWORKS that are more suited 
to engineering than the default properties. Additional properties can be 
added based on the user’s needs.

Metadata File properties and attributes are sometimes referred to as Metadata.

Classes of File 
Properties

File properties can be grouped into several classes.

 Automatic
Automatic properties are maintained by the application that created 
the property. These include properties such as the date the file was 
created, last modified and file size.

 Preset
Preset properties already exist, but the user must fill in the text 
value. The preset file properties used in SOLIDWORKS are stored 
in the file Property.txt. This file may be edited to add or remove 
preset properties.

 Custom
Custom properties are defined by the user and apply to the entire 
document.

 Configuration specific
Configuration specific properties apply only to a specific 
configuration.
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 SOLIDWORKS custom properties
There are several custom properties that can be automatically 
updated by SOLIDWORKS. These include the part’s mass and 
material.

Where to Find It  Menu: File, Properties

Creating File 
Properties

File properties can be created directly in the file, or they can be created 
by other procedures.

 Direct method
File properties are added directly to the file by the user.

 Design tables
Design tables can create custom properties using a column header 
$PRP@property where property is the name of the property to be 
created and populated with the information created in the design 
table.

 Custom Properties Tab
Form templates for adding properties can be created using the 
SOLIDWORKS Property Tab Builder. These forms can then be 
accessed from the Task Pane using the Custom Properties tab.

 SOLIDWORKS PDM applications
SOLIDWORKS PDM applications will add several custom 
properties to files checked into the vault. These include: number, 
status, description, project and revision. SOLIDWORKS PDM 
applications can also be configured to add additional properties 
defined by the Vault Administrator.

Uses of File 
Properties

File properties can be used for several operations.

 Parts, assemblies and drawings 
File properties can be used to create parametric notes. Annotations 
linked to file properties will update as the properties change.

 Assemblies
Advanced Selection and Advanced Show/Hide can select 
components based on specific file properties. Specific procedures 
are found in the training course Assembly Modeling.

 Drawings
File properties can be used to fill in data in the title block, BOM, 
revision blocks and annotations. Specific procedures are found in 
the training course SOLIDWORKS Drawings.

To communicate the description of this model and it's weight, we'll 
add some custom properties to the file.
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5 File properties.

Click File Properties  and click the Custom tab. Activate the 
Property Name cell in the first row of the dialog. Use the arrow at the 
right of the cell to choose Description from the preset properties. In 
the Value/Text Expression cell, type Handwheel for Globe Valve 
as the description.

6 New custom property.
Activate the Property Name cell and type in the Name mass. In the 
Value/Text Expression cell, choose Mass from the preset properties. 
The Evaluated Value cell shows the current mass and how it would 
appear in a table or drawing title block. Close the dialog.

Note The Configuration Specific tab can also be used. This would allow the 
property to vary by configuration. 
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SOLIDWORKS 
Simulation-
Xpress

With the solid 3D geometry of the hand wheel and the material defined, 
we have all the information we need to simulate how this model would 
react to stresses applied to the part. We'll use the SimulationXpress tool 
to do this.

SOLIDWORKS SimulationXpress is a first pass stress analysis tool for 
SOLIDWORKS users. It helps you judge whether your part will 
withstand the loading it will receive under real-world conditions. 
SOLIDWORKS SimulationXpress is a subset of the SOLIDWORKS 
Simulation product.

Product Code In order to run SOLIDWORKS SimulationXpress, a product code is 
required. The product can be generated from your SOLIDWORKS 
serial number. See the Enable SimulationXpress dialog on start up.

Overview SOLIDWORKS 
SimulationXpress uses a 
wizard to provide an easy to 
use, step-by-step method of 
performing design analysis. 
The wizard requires several 
pieces of information in order 
to analyze the part: fixtures, 
loads and materials. This 
information represents the part 
as it is used. For example, 
consider what happens when 
you turn the handwheel. The 
hub is attached to something that resists turning. This is represented by 
a fixture. Fixtures are sometime called constraints. A force is applied to 
the hole in the rim as you attempt to turn the handwheel. This is a load. 
What happens to the spokes? Do they bend? Will they break? This 
depends on the strength of the material the handwheel is made of, the 
physical size and shape of the spokes, and the size of the load.

Mesh In order to analyze the model, SOLIDWORKS 
SimulationXpress automatically meshes the 
model, breaking it up into smaller, easier-to-
analyze pieces. These pieces are called elements.

Although you never see the elements, you can 
set the coarseness of the mesh prior to the 
analysis.

Externally applied load

Fixture
185



Lesson 5 SOLIDWORKS Education 2023
Revolved Features
Using 
SOLIDWORKS 
Simulation-
Xpress

SOLIDWORKS SimulationXpress walks you through the steps of 
analysis, from Options to Optimize. The steps are:

 Options
Setup the type of units that are commonly used for materials, loads and 
results.

 Fixtures
Select faces of the part that remain in place (fixed) during the analysis. 

 Loads
Add external loads such as forces and pressures to induce stress and to 
deform the part.

 Material
Choose a material for the part from the standard library or input your 
own.

 Run
Run the analysis, optionally setting the coarseness of the mesh used.

 Results
View the results of the analysis: Factor of Safety (FOS), Stress and 
Deformations. This is sometimes called postprocessing.

 Optimize
Optimize a result quantity using a selected dimension. 

Where to Find It  CommandManager: Evaluate > 

SimulationXpress Analysis Wizard 
 Menu: Tools, Xpress Products, SimulationXpress

1 Start SimulationXpress.

Click SimulationXpress . The 
analysis wizard appears in the Task Pane. 

Note The first time that the SimulationXpress Analysis Wizard is run, it 
will require a SimulationXpress Product Code. Follow the 
instructions on the dialog to receive a code.
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The Simulation-
Xpress 
Interface

The SOLIDWORKS SimulationXpress interface begins in the Task 
Pane, where the checklist of sequential tasks appears under the 

SOLIDWORKS SimulationXpress  tab. Selection options and the 
SimulationXpressStudy tree appear in the PropertyManager. 

Options The Options dialog contains settings for the System of units and 
Results location.

2 Click Options.
Set the units to SI and use the default Results location. Click 
Show annotation for maximum and minimum in the result plots. 

Click OK and click  Next. 

SOLIDWORKS
SimulationXpress
Task Pane Tab

PropertyManager and 
SimulationXpressStudy
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Phase 1: Fixtures Fixtures are used to “fix” faces of the model that should not move 
during the analysis. You must restrain at least one face of the part to 
avoid analysis failure due to rigid body motion. As you complete each 
phase in the wizard, a green check mark  is added to the list.

3 Fixtures page.
Click  Add a fixture.

Tip Move the cursor over the blue hyperlinks (such as Fixed Holes) for 
examples.

4 Face selection. 
Select the cylindrical face and the flat face that 
form the D-shaped hole.

Click OK and click Next. 

Simulation Study A SimulationXpress Study is being constructed 
as the wizard steps are completed. The 
FeatureManager design tree is split and the lower 
portion contains the SimulationXpressStudy tree. 

Eventually it will include fixtures, loads, mesh 
and the results of the analysis. 
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Phase 2: Loads The Loads page is used to add external forces and pressures to faces of 
the part. Force implies a total force, for example 200 lbs, applied to a 
face in a specific direction. Pressure implies that the force is evenly 
distributed on the face, for example, 300 psi, and is applied normal to 
the face.

Note The specified force value is applied to each face. For example, if you 
select 3 faces and specify a 50 lb. force, SimulationXpress applies a 
total force of 150 lbs. or 50 lbs. on each face.

5 Loads page.
In this example, we will use a Force type load. Click  Add a force.

6 Select the face. 
Select the cylindrical face as shown. Click 
Selected direction and click the Right plane. 

Set the Force to 3000.

Click OK and click Next. 

Phase 3: Material The next phase is selecting the Material. You can choose from libraries 
of standard materials or add your own.

7 Material page.
The current material, selected within 
SOLIDWORKS, is Aluminum Bronze from 
the Copper Alloys list.

To change the material, click 3 Material, click 
Change material and select from the list. 
This is the same list that appears when using 
Edit Material.

Click Next to keep Aluminum Bronze as the 
material. 
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Phase 4: Run SimulationXpress prepares the model for analysis, creates the mesh and 
calculates displacements, strains, and stresses.

8 Run page.
The required information has been provided and the analyzer is ready.

Click  Run Simulation. 

Phase 5: Results The Results page is used to display the 
results of analysis. The full 
SimulationXpressStudy tree is shown in 
the split FeatureManager design tree. 
This includes all the input and output of 
the study. 

Tip Double-click a result feature (such as Stress (-vonMises-)) to view it. 

9 Results. 
A preview of the deformation plot appears on the screen. The 
deformation is scaled to make it easier to visualize.

If the part is deforming as expected you can view the other result plots 
of the study. Click  Yes, continue to see the next result. 

Factor of Safety SimulationXpress uses the maximum von Mises stress criterion to 
calculate the factor of safety distribution. This criterion states that a 
ductile material starts to yield when the equivalent stress (von Mises 
stress) reaches the yield strength of the material. The yield strength 
(SIGYLD) is defined as a material property. SimulationXpress 
calculates the factor of safety at a point by dividing the yield strength 
by the equivalent stress at that point.

At any location, a factor of safety that is:

 Less than 1.0 indicates that the material at that location has yielded 
and that the design is not safe.

 Equal to 1.0 indicates that the material at that location has just 
started to yield.

 Greater than 1.0 indicates that the material at that location has not 
yielded.
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10 Factor of safety.
The FOS has areas that are less than 1. This indicates that areas of the 
part are overstressed and will fail.

Red areas indicate where the factor of safety is less than one. The Task 
Pane also shows the actual factor of safety value.

Click  Done viewing results and  Next. 

Phase 6: Optimize The Optimize tab can be used to bring Factor of Safety, Max Stress or 
Maximum Displacement values to acceptable levels by iterating the 
value of a dimension. The optimization is performed within set numeric 
boundaries with the above constraints. 

11 Optimize the model.
Click Yes for Would you like to optimize your model? and  Next. 

12 Value to change. 
Select the 14mm dimension (major axis of 
the ellipse) as the dimension to change. 
Click OK. 
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13 Variables and constraints. 
Set the Min and Max Variable values to 18mm and 22mm as shown. 
For Constraints, select Factor of Safety and set it to a minimum of 1. 

Click Run.

14 Results. 
After several iterations, the optimization is 
complete. Click the Results view tab. The 
resulting changes meet the FOS target with 
only a small increase in weight. 

15 Optimization results.
Click the Optimal Value option and click  Next. 

Click 4 Run and Run Simulation. 

Updating the 
Model

Changes performed in SOLIDWORKS or during optimization are 
detected by SimulationXpress. Changes can be made to the model, 
materials, fixtures or loads. The existing analysis can be re-analyzed to 
show the newest results.

16 Save data.
Click Close in the SOLIDWORKS SimulationXpress window and Yes 
to save the data. 

17 Change model. 
The optimization process changed the 
selected dimension value. Click the 
Model tab on the bottom of the 
graphics window and change that 
dimension to the rounded value 
20mm (in Sketch4 under the Spoke 
feature) and rebuild. 
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18 Retrieve data.
Start SimulationXpress again and run the simulation again to update 
the results.

19 Save and close.
Click Close in the SOLIDWORKS SimulationXpress window and Yes 
to save the data. 

20 Save and close the part. 

Results, Reports 
and eDrawings

The following are some examples of the different types of output that 
are available with an analysis. They include results, reports and 
eDrawing files. 

Note Some of the displays are exaggerated by a deformation scale. 

Type Display

 Stress (-vonMises-)

Displacement (-Res disp-)

Deformation 
(-Displacement-)
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Factor of Safety 
(-Max von Mises Stress-)

Word Report

eDrawings File

Type Display
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Exercise 19:
Flange

Create this part using the dimensions provided. Use 
relations wisely to maintain the design intent.

This lab uses the following skills:

 Revolved Features on page 159

Units: millimeters

Design Intent The design intent for this part is as follows:

1. Holes in the pattern are equally spaced.
2. Holes are equal diameter.
3. All fillets are equal and are R6mm.

Note that construction circles can be created using the Properties of a 
circle.

Dimensioned 
Views

Use the following graphics with the description of the design intent to 
create the part.

Top View

Front View
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Exercise 20:
Wheel

Create this part using the 
dimensions provided. Use 
relations wisely to maintain the 
design intent. 

This lab uses the following 
skills:

 Revolved Features on 
page 159

Units: millimeters

Design Intent The design intent for this part is as follows:

1. Part is symmetrical about the axis of the hub.
2. Hub has draft.

Dimensioned 
Views

Use the following graphics with the description of the design intent to 
create the part.

Front and Top views, and Section A-A from Front view.
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Optional: Text in a 
Sketch

Text can be added to a sketch and extruded to form a cut or a boss. The 
text can be positioned freely, located using dimensions or geometric 
relations, or made to follow sketch geometry or model edges.

Where to Find It  CommandManager: Sketch > Text 
 Menu: Tools, Sketch Entities, Text
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Text 

1 Construction geometry.
Sketch on the front face and add construction lines and arcs as shown.

Tip Use Symmetric relationships between the endpoints of the arcs and the 
vertical centerline.

2 Text on a curve.
Create two pieces of text, one attached to each arc. They have the 
following properties:

 Text: Designed using
 Font: Courier New 11pt
 Alignment: Center Align
 Width Factor: 100%
 Spacing: 100%

 Text: SOLIDWORKS
 Font: Arial 20pt
 Alignment: Full Justify
 Width Factor: 100%
 Spacing: not applicable when using Full Justify
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3 Extrude.
Extrude a boss with a Depth of 1mm and 
Draft of 1°.

Note Extruding text can be time consuming. 

4 Save the part and close it.
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Exercise 21:
Guide

Create this part using the information and 
dimensions provided. This lab reinforces the 
following skills: 

 Introducing: Slots on page 165

Units: millimeters

Procedure Create a new mm part and name it Guide. Create the geometry as 
shown in the following steps. 

Note These images show the sketch relations (View, Sketch Relations) for 
clarity. 

1 Lines and fillet. 
Open a sketch on the Front plane. 
Create the sketch lines, a sketch fillet 
and an angular dimension as shown. 

2 Offset. 
Use offset entities to create the 
20mm offset as shown. 

3 Close ends. 
Close the ends using a 
tangent arc and a line as 
shown. 
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4 Drag to origin. 
Drag the centerpoint of the arc to 
the Origin and drop it. This 
creates a Coincident relation. 

5 Virtual Sharp.
A Virtual Sharp is used to 
represent an imaginary corner 
where lines would meet.

Add a virtual sharp by selecting 
the two lines as shown and 

clicking Point .

6 Fully defined. 
Complete the sketch 
by adding dimensions 
as shown. 

7 Extrude.
Extrude the sketch 10mm.
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8 Circle and boss. 
Add a circle to a new sketch on the top face of the model. Use Tangent 
and Coincident relations to relate the circle to the geometry. Fully 
define and extrude the sketch 10mm as shown. 

9 Fillet. 
Add a fillet R20mm as shown. 
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10 Slot. 
Use Straight Slot with the options Overall Length and Add 
Dimensions to create the geometry shown below. Create a through all 
cut with the sketch geometry. 

Tip The slot sketch should be fully defined. It may require a Parallel 
relation. 

11 Hole.
Add a 20mm through all hole to complete the part. 

12 Save and close.
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Exercise 22:
Ellipse

Use an ellipse to create the part.

This lab reinforces the following 
skills:

 Introducing: Insert Ellipse on 
page 171

Units: millimeters

Procedure Create a new mm part. Create the geometry as shown in the following 
drawing.
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Exercise 23:
Sweeps

Create these three parts using swept features. These require a path and a 
section or a path and the Circular Profile option.

This lab uses the following skills:

 Introducing: Sweep on page 172

Units: millimeters

Slide Stop The Slide Stop uses a path that describes the centerline of the sweep.

Cotter Pin The Cotter Pin uses a path that describes the inner edge of the sweep.
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Paper Clip The Paper Clip is defined by a path that describes the centerline of the 
sweep. Use a path and a section or a path and the Circular Profile 
option.

Mitered Sweep The Mitered Sweep is defined by a path that describes the outer edge 
of the sweep.

Thanks to TriMech Solutions, LLC for submitting these examples.
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Exercise 24:
Simulation- 
Xpress

Perform a first pass stress analysis on an 
existing part.

This lab uses the following 
SimulationXpress skills:

 Phase 1: Fixtures on page 188
 Phase 2: Loads on page 189
 Phase 3: Material on page 189
 Phase 4: Run on page 190
 Phase 5: Results on page 190

Units: millimeters

1 Open Pump Cover.
This part represents a cover that will be filled with oil under high 
pressure.

Start the SimulationXpress wizard.

2 Set the options.
Click Options and set the units to SI. Also click Show annotation for 
maximum and minimum in the result plots. 

3 Define the fixture.
Select the uppermost faces of 
the four tabs and the 
cylindrical faces of the four 
bolt holes.

4 Define the load set.
Select Pressure for the 
type of load. Right-click 
one of the faces on the 
inside of the Pump Cover. 
Click Select Tangency 
from the shortcut menu.

5 Set the pressure value 
and direction.
Set the pressure value to 
250 psi. 
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6 Specify the material.
Select Aluminum Alloys and click 2014 Alloy from the list.

7 Run the simulation.

8 Results. 
The factor of safety is less than 1 indicating that the part is over 
stressed. Also view the stress and displacement plots. 

9 Change the material. 
Right-click the Pump Cover (-2014 Alloy-) icon in the 
SimulationXpressStudy and click Apply/Edit Material. 

Change the material to Other Alloys, Monel(R) 400.

10 Update.
Rerun the study to update the analysis using the new material. The 
factor of safety should be greater than 1. 

11 Save and close the part. 
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Lesson 6
Bottom-Up Assembly

Modeling

Upon successful completion of this lesson, you will be able to:

 Create a new assembly.

 Insert components into an assembly using all available techniques.

 Add mating relationships between components.

 Utilize the assembly-specific aspects of the FeatureManager design 
tree to manipulate and manage the assembly.

 Insert subassemblies.

 Use part configurations in an assembly.
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Case Study: 
Universal Joint

This lesson will examine assembly modeling through the construction 
of a universal joint. The joint consists of several components and one 
subassembly.

Bottom-Up 
Assembly

Bottom-Up assemblies are created by adding and orienting existing 
parts in an assembly. Parts added to the assembly appear as Component 
Parts. Component parts are oriented and positioned in the assembly 
using Mates. Mates relate faces and edges of component parts to planes 
and other faces/edges.

Stages in the 
Process

Some key stages in the modeling process of this assembly are shown in 
the following list. Each of these topics comprises a section in the 
lesson.

 Creating a new assembly
New assemblies are created using the same method as new parts.

 Adding the first component
Components can be added in several ways. They can be dragged and 
dropped from an open part window or opened from a standard browser.

 Position of the first component
The initial component added to the assembly is automatically fixed as it 
is added. Others components can be positioned after they are added.

 FeatureManager design tree and symbols
The FeatureManager design tree includes many symbols, prefixes and 
suffixes that provide information about the assembly and the 
components in it.

 Mating components to each other
Mates are used to position and orient components with reference to 
each other. Mates remove degrees of freedom from the components.

 Subassemblies
Assemblies can be created and inserted into the current assembly. They 
are considered subassembly components. 
210



SOLIDWORKS Education 2023 Lesson 6
Bottom-Up Assembly Modeling
The Assembly In this lesson we will make an assembly using existing components. 
The assembly is a universal joint, and is made up of a number of 
individual parts and one subassembly as shown below:

1 Open an existing part.
Open the part bracket. This part will be the 
base component of the new assembly.

The first component added to an assembly 
should be a part that will not move. By fixing 
the first component, others can be mated to it 
without any danger of it moving.

crank sub

Yoke_male

Bracket

pin[long]

pin[short]
(2 copies)

Spider

Yoke_female
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Creating a New 
Assembly

New assemblies can be created directly or be made from an open part 
or assembly. The new assembly contains an origin, the three standard 
planes and a Mates folder. 

Introducing: Make 
Assembly from Part/
Assembly

Use the Make Assembly from Part/Assembly option to generate a 
new assembly from an open part. The part is used as the first 
component in the new assembly and is fixed in space. 

Where to Find It  Menu Bar: New , Make Assembly from Part/Assembly  
 Menu: File, Make Assembly from Assembly

Introducing: New 
Assembly

A new assembly file can be created by clicking New  and selecting 
an assembly template. 

2 Choose template.

Click Make Assembly from Part/Assembly . Use the 
Assembly_MM template.

Note The units of the assembly can be different from the units of the parts. 
For example, you can assemble a mixture of inch and millimeter parts 
in an assembly whose units are feet. However, when you edit the 
dimensions of any of the parts in the context of the assembly, they will 
be displayed in the units of the assembly, not those of the part itself. 
Using Tools, Options, you can check the units of the assembly and if 
desired, change them.
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3 Locate component.
Place the component at the origin by placing 
the cursor at the origin or by simply clicking 
OK.

4 Save.
Save the assembly under the name Universal Joint. Assembly files 
have the file extension *.sldasm.

Close the bracket part file.

Position of the 
First 
Component

The initial component added to the assembly is, by default, Fixed. 
Fixed components cannot be moved and are locked into place wherever 
they fall when you insert them into the assembly. By clicking the green 
check or placing the cursor at the assembly origin, the component’s 
origin is at the assembly origin position. This also means that the planes 
of the component match the planes of the assembly, and the component 
is fully defined.

Consider assembling a washing machine. The first component logically 
would be the frame onto which everything else is mounted. By aligning 
this component with the assembly’s planes, we would establish what 
could be called “product space”. Automotive manufacturers refer to 
this as “vehicle space”. This space creates a logical framework for 
positioning all the other components in their proper positions.
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FeatureManager 
Design Tree and 
Symbols

Within the FeatureManager design tree of an assembly, the folders and 
symbols are slightly different than in a part. There are also some terms 
that are unique to the assembly. 

Degrees of 
Freedom

There are six degrees of freedom for any component 
that is added to the assembly before it is mated or 
fixed: translation along the X, Y, and Z axes and 
rotation around those same axes. How a component 
is able to move in the assembly is determined by its 
degrees of freedom. The Fix and Insert Mate 
options are used to remove degrees of freedom.

Components Parts that are inserted into the 
assembly, such as the bracket, are 
represented by the same top-level 
icon as is used in the part 
environment. Assemblies can also 
be inserted and are shown with an 
assembly icon preceding the 
assembly document name. 
However, when the listing of these 
icons is expanded, the subassembly 
components and even the 
component’s features are listed and 
accessible. 

Component Part 
Folder

Each component part contains the entire contents of the part, including 
all features, planes and axes. 

Note If the component is an assembly, the assembly, including all the parts, 
would be displayed. 

Component Name The component name in the FeatureManager design tree displays a 
wealth of information.

(f) bracket<1> (Default<<Default>_Display State 1>)

Display State

Configuration

Instance Number

File Name

State of the Component
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State of the 
component

There are several symbols that are used to represent the state of a 
component in the Assembly FeatureManager design tree. These are 
similar to the symbols that represent the state of a sketch.

Fixed The component is Fixed to the current position, but it is not mated.

Under Defined The component's position is Under Defined and still has some freedom 
of movement within the assembly.

Fully Defined Components that are not marked with a state indicator have a position 
within the assembly that is Fully Defined with mates.

Over Defined Conflicting information for the position of the component will cause it 
to be Over Defined. Another error state is Not Solved where a 
question mark is used as the state indicator.

File Name The name of the component, part or assembly, is listed. The icon 
will show whether it is a part or an assembly. For more information 
on assemblies, see Inserting Subassemblies on page 246. 

Instance Number The instance number is used internally to distinguish each instance 
of the component from each other when multiple instances of the 
component are included in the assembly. 
Instances are not renumbered for deletions. The highest instance 
number may not reflect the total.

Configuration The configuration, Default in this example, is the configuration of 
the component that is used by this assembly.

Display State The display state, <Default>_Display_State1 in this example, is 
the display state of the component that is used by this assembly. 

For more information on configurations and display states in 
assemblies, see the Assembly Modeling manual. 

External References 
Search Order

When any parent document is opened, all documents that are 
referenced by the parent document are also loaded into memory. In the 
case of assemblies, components are loaded into memory according to 
the suppression state they were in when the assembly was saved.

The software searches for referenced documents in paths you can 
specify, the path where you last opened a document, and other paths. If 
the referenced document is still not found, the software gives you the 
option to browse for it or open the assembly without the document. See 
the Search Routing for Referenced Documents topic in the online help 
for a complete list of the paths the software searches.

Note All updated reference paths in the parent document are saved when you 
save the parent document.
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File Names File names should be unique to avoid bad references. SOLIDWORKS 
cannot open two different documents with the same name at the same 
time. Assemblies can use the wrong part if you have two different parts 
with the same name. Here are two examples:

 Two different parts called bracket.sldprt are saved and closed. 
When you open an assembly that references bracket.sldprt, the 
software will use whichever comes first in the search order.

 A file named frame.sldprt is open in SOLIDWORKS. Then, you 
try to open an assembly that references a different file named 
frame.sldprt. The software gives the following message: 

The document being opened references a file with the 
same name as an already-open document. 

You can continue to open the assembly with all instances of 
frame.sldprt suppressed or you can accept the open file as a 
replacement.

Note Components can be renamed in the FeatureManager design tree if the 
option Tools, Options, System Options, FeatureManager, Allow 
component files to be renamed from FeatureManager tree has 
been clicked. 

Rollback Bar The Rollback Bar can be used in an assembly to rollback:

 Assembly planes, axes, sketches
 Assembly patterns
 In-context part features
 Assembly features

Any features below the marker are suppressed. Individual components 
cannot be rolled back.

Reorder Features of an assembly can be reordered in the same way as part 
features; using drag and drop. Assembly objects that can be reordered 
are:

 Components
 Assembly planes, axes, sketches
 Assembly patterns
 In-context part features
 Mates within the Mates folder
 Assembly features

Mates Folder The mating relationships in assemblies 
are grouped together into a Mate 
Folder named Mates. The mates get 
solved in the order in which they are 
listed. 

For more information, see Introducing: Insert Mate on page 219.
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Adding 
Components

Once the first component has been inserted and fully defined, other 
parts can be added and mated to it. In this example, the Yoke_male 
part will be inserted and mated. This part should be under defined so 
that it is free to rotate.

 There are several ways to add components to the assembly:
 Use Insert Component
 Drag them from the Windows 
 Drag them from an open document
 Drag them from the Task Pane

All these methods will be demonstrated in this lesson, beginning with 
use of Insert Component. This is the same dialog that appears 
automatically when Make Assembly from Part is used.

Note Unlike adding the first component, additional components will be 
added with their positions under defined.

Insert Component The Insert Component dialog is used to find, preview and add 
components to the current assembly. Click the Keep Visible (pushpin) 
button to add multiple components or multiple instances of the same 
component.

Where to Find It  CommandManager: Assembly > Insert Components  > 

Insert Components 
 Menu: Insert, Component, Existing Part/Assembly
 Windows: Drag a component into the graphics area

5 Insert Yoke_male.

Click Insert Components  and click 
the Yoke_male part using the Browse 
button. Position the component on the 
screen to the left of the bracket and click 
to place it.

The new component is listed as: 

(-) Yoke_male <1>

This means that the component is the first instance of Yoke_male and 
it's position is under defined.

Tip Clicking on a component in the FeatureManager design tree will cause 
that component to highlight. Also, moving the cursor to a component in 
the graphics window will display the feature name.
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Moving and 
Rotating 
Components

One or more selected components can be moved or rotated to 
reposition them for mating using the mouse, the Move and 
Rotate Component commands or the Triad. 

Move Using 
Dynamic Assembly 
Motion

Also, moving under defined components simulates movement of a 
mechanism through dynamic assembly motion. See Dynamic Assembly 
Motion on page 234. 

Move Move Component is used to move the component in space.

Where to Find It  Mouse Button: Drag a component with the left mouse button 

 CommandManager: Assembly > Move Component  
 Menu: Tools, Component, Move

Rotate Rotate Component is used to rotate the component in space. 

Where to Find It  Mouse Button: Drag a component with the right mouse button 

 CommandManager: Assembly > Move Component , 

Rotate Component  
 Menu: Tools, Component, Rotate

Triad The Triad is used to dynamically move along an axis or rotate about an 
axis.

Where to Find It  Shortcut Menu: Right-click a component 
and click Move with Triad 

Note Move Component and Rotate Component behave as a single, unified 
command. By expanding either the Rotate or Move options, you can 
switch between the two commands without ever closing the 
PropertyManager.

The Move tool has several options for defining the type of movement. 
The option Along Entity has a selection box, Along Assembly XYZ, 
By Delta XYZ, and To XYZ Position require coordinate values.

The Rotate tool also has options to define how the component will 
rotate.
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6 Move.
Drag the component Yoke_male with the left 
mouse button so it is closer to where it will be 
mated.

Other options for moving and rotating the 
component will be discussed later in this 
lesson. 

Mating 
Components

Obviously dragging a component is not sufficiently precise for building 
an assembly. Use faces and edges to mate components to each other. 
The parts inside the bracket are intended to move, so make sure that 
the proper degrees of freedom are left available.

Introducing: 
Insert Mate

Insert Mate creates relationships between component parts or between 
a part and the assembly.

Mates can be created using many different objects. You can use:

 Faces
 Planes
 Edges
 Vertices
 Sketch lines and points
 Axes and origins

Most mates are made between a pair of objects. Two of the most 
commonly used mates are Coincident and Concentric. 

Where to Find It  CommandManager: Assembly > Mate 
 Menu: Insert, Mate

 Shortcut Menu: Right-click a component and click Mate 

Note Mates icons are based on their type, for example Coincident .
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Mate Types and 
Alignment

Mates are used to create relationships between components. Faces are 
the most commonly used geometry in mates. The type of mate, in 
combination with the conditions Anti-aligned or Aligned, determines 
the result.

Note These tables outline the mates of the Standard Mates set. There are 
also Advanced Mates and Mechanical Mates sets that are discussed 
in more advanced manuals.

Aligned Anti-Aligned

Coincident 
(faces lie on the same 
imaginary infinite plane)

Parallel 

Perpendicular 
Aligned and anti-aligned do 
not apply to Perpendicular.

Distance 

Angle 
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Fewer options are available with cylindrical faces but they are every bit 
as important.

Distance  between cylindrical faces has several options.

Tip After the mate has been created, you can right-click the mate feature in 
the FeatureManager design tree, and click Flip Mate Alignment to 
reverse the alignment.

Aligned Anti-Aligned

Concentric 

Tangent 

Center to 
Center

Minimum 
Distance

Maximum 
Distance

Custom 
Distance

Lock 
Select 
anywhere 
on 
component.

Components that are locked together will move 
together. No alignment options.
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Things to which you 
can mate

There are many types of topology and geometry that can be used in 
mating. The selections can create many mate types.

Topology/
Geometry

Selections Mate

Faces or 
Surface

Line or Linear 
Edge

Plane

Axis or 
Temporary 
Axis

Point, Vertex, 
Origin or 
Coordinate 
System

Arc or Circular 
Edge
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Tip Although planes can be selected on the screen if they are visible, it is 
often easier to select them by name through the FeatureManager design 
tree. Click the “+” symbol to see the tree and expand individual 
components and features. 

Mating Concentric 
and Coincident

The Yoke_male component is to be mated so that its shaft aligns with 
the hole and the flat face contacts the bracket inner face. Concentric 
and Coincident mates will be used.

Tip Selection filters can be used to limit your selections by geometry type 
such as face or edge. Press the F5 key and select one or more filter 
types.

7 Mate PropertyManager.

Click Mate . If the PropertyManager is open, 
you can select the faces without using the Ctrl 
key.

The Standard tab opens by default.

Mate Options Several mate options are available for all mates:

 Add to new folder
Creates a new folder to hold all the mates created 
while the Mate tool is active. The folder resides in 
the Mates folder and can be renamed.

 Show pop-up toolbar
Toggles the Mate pop-up toolbar on and off.

 Show preview
Shows the positioning created by the mate as soon as the second 
selection is made. It is not finalized until the dialog OK is clicked.
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 Use for positioning only
This option can be used to position geometry without constraining it. 
No mate is added.

 Make first selection transparent
This option forces the component selected first to be transparent while 
adding the mate.

Introducing: Mate 
Pop-up Toolbar

The Mate pop-up toolbar is used to make 
selections easier by displaying the 
available mate types on the screen. The 
mate types that are available vary by geometry selection and mirror 
those that appear in the PropertyManager. The mate pop-up toolbar 
appears on the graphics but can be dragged anywhere.

After the selection, a separate dialog appears (in this example 
for a Concentric mate) to Lock Rotation or Flip Mate 
Alignment.

Either the on-screen or PropertyManager dialog can be used. This 
lesson uses the on-screen pop-up toolbar. All types are listed in the 
chart Mate Types and Alignment on page 220.

8 Selections and preview.
Select the cylindrical faces of the Yoke_male and the bracket as 
indicated.

As the second face is selected, the mate is previewed by moving to the 
position that would result from the mate, and the Mate pop-up toolbar 
is displayed.

Concentric is selected as the default and the mate is previewed.
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Note When the cursor floats over cylindrical or 
conical faces, temporary axes appear. These 
axes can be selected to form a Coincident 
mate, similar to the Concentric mate. 

9 Add a mate.
The faces are listed in the Mate Selections list. Exactly two items 
should appear in the list. Accept the Concentric mate and click OK.

10 Planar face.
Rotate the view slightly and select the 
underside planar face of the bracket 
component.

11 Select through component.
Return to the Isometric view and select the top face of the Yoke_male 
through the transparent bracket component. Add a Coincident mate 
to bring the selected faces into contact.

12 Mates listed.
The mates, concentric and coincident, remain 
listed in the Mates group box. They will be 
added to the Mates folder when the Mate 
command is completed. Click OK.
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13 State of constraint.
The Yoke_male component is listed as under 
constrained. It is still able to move by rotating 
around the axis of its cylindrical surface. 

Test the behavior of the Yoke_male by 
dragging it.

14 Breadcrumbs.
Click on a face of Yoke_male. The 
Breadcrumbs for that selection appear in the 
upper left portion of the Graphics Area. 

The icon strip identifies the hierarchy upward 
starting with the face and moving to the 
feature, body, component, and finally the top 
level assembly. Below the strip is the sketch 
associated with the selected feature. Above 
the strip are the mates associated with the 
selected component.

Note Right-clicking on any of the icons allows you to edit that feature. 
Clicking ‘air’ deselects the face.
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Adding Components 
Using Windows 
Explorer

Another way to add components to the assembly is through Windows 
Explorer or My Computer. The part or assembly file(s) can be dragged 
and dropped into the active assembly.

15 Open Windows Explorer.
Since SOLIDWORKS is a native Windows application, it supports 
standard Windows techniques like “drag and drop”. Component files 
can be dragged from the window into the assembly to add them. Drag 
and drop the spider into the graphics area. 

16 Concentric mate for spider.
Add a Concentric mate between the two 
cylindrical faces of the spider and 
Yoke_male components.
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Width Mate The spider component will be centered within the Yoke_male and 
Yoke_female components using a Width, Centered mate. The Width 
mate is one of the Advanced Mates from the Mate dialog. Selections 
include a pair of Width selections (the “outer” faces) and a pair of 
Tab selections (the “inner” faces). The Tab faces are centered 
between the Width faces to locate the component.

Note The Width mate contains other options that can be used with the same 
selections: Free, Dimension and Percent.

17 Width mate.

Click Insert Mate  and click the Advanced tab. Click the Width  
mate and click Centered.

Advanced mates often require additional selections; in this example, 
two pairs of selections are required. 

Width selections Tab selection(s) Result

(Front view)

(single selection)

(Front view)

(Front view)
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Hiding Faces with 
the Alt Key

There are several ways to select hidden faces when adding or editing 
mates. The Alt key can be used to hide one or more faces and provide 
access to select hidden faces. The hide is temporary. 

Where to Find It  Keyboard Shortcut: Move the pointer over a component face and 
press Alt to hide a face or faces. 

18 Hide and select.
Click in Width selections and click the first of the pair of inner faces 
from the Yoke_male. 

Position the cursor on a face to hide and press the Alt key. The outer 
face is temporarily removed; select through to the inner face. 

19 Remaining selections. 
Click in Tab selections and click the second of the pair of outer faces 
from the spider as shown. Click OK.

The Width mate keeps the spider centered inside the Yoke_male with 
equal gaps on each side.
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20 Mates by component.
Expand the spider component in the FeatureManager design tree. A 
folder named Mates in Universal Joint is added to each component 
that is mated. The folder contains the mates which use geometry of that 
component. 

Note The icon  indicates that the mate is in the path to ground, or, it is one 
of the mates that keeps the component in position. 
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Rotating Inserted 
Components

Components inserted using Insert Component on 
page 217 can be rotated after they are inserted but 
before they are placed using Rotate Inserted Component. The angle 
can be set and the direction buttons can be clicked as many times as 
desired. 

Where to Find It Shortcut Menu: Click Insert Components and click a rotation 
direction

Note The option Show Rotate context toolbar on the Insert Component 
PropertyManager must be clicked.

21 Insert and rotate.
Click Insert Components and select 
the Yoke_female part. 

Do not click to place the component 
yet.

Click Rotate component 

about Z  twice and click to place 
the component.

Rotate about 

X 

Rotate about 

Y 

Rotate about Z 
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22 Concentric mate.
Select the cylindrical faces as shown and 
add a Concentric mate between them.

Using the 
Component 
Preview Window

The Component Preview Window is a handy tool that can be used to 
make mate selections easier. When a component is selected for use, a 
separate viewport is created for the assembly and for the component. 
Each viewport can be manipulated by zooming, scrolling, and rotating. 

Where to Find It  Menu: Click a component and click Tools, Component, 
Preview Window 

 Shortcut Menu: Right-click a component and click 

Component Preview Window 

23 Preview window.
Click the spider component and click 

Component Preview Window . The window splits to include both 

the assembly and the spider component. Click Mate .
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24 Selections.
Click Width. Select the pairs of faces that make up the width and tab 
selections. Use view manipulation, the Alt key, or select other to make 
the selections. The spider is centered on the Yoke_female 
component. Click OK.

Note The orientation of the component in the Preview Window is the same 
orientation as the assembly. 

25 Exit preview window.
Click Exit Preview.

Potential Over 
Defined Condition

Because of the clearance between the Yoke_female and the bracket, a 
Coincident mate is unsolvable. The gap prevents coincidence.

Parallel Mate A Parallel mate keeps the selected planar faces or 
planes parallel to each other without forcing 
contact between them.
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26 Parallel mate.
Select the faces of the 
Yoke_female and bracket as 
shown above. Add a Parallel mate 
to maintain the gap between the 
faces. Press G to use the 
magnifying glass and view the gap.

Dynamic 
Assembly Motion

Drag under defined components to display the motion allowed by the 
remaining degrees of freedom. 

Note Components that are fixed or fully defined cannot be dragged.

27 Drag components.
Drag the Yoke_male component to turn it. 
The mated components spider and 
Yoke_female move with it.

Displaying Part 
Configurations in 
an Assembly

When you add a part to an assembly you can choose which of its 
configurations will be displayed.

Or, once the part is inserted and mated, you can switch its 
configuration.
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The Pin The part named pin has two configurations: 
SHORT and LONG. Any configuration can be 
used in the assembly. In this case, two 
instances will use SHORT and one will use 
LONG.

Using Part 
Configurations 
in Assemblies

Multiple instances of the same part can be used in an assembly, with 
each instance referencing a different configuration. We will use 
multiple instances of a part with different configurations in this 
assembly.

There are several ways to create this type of configuration within a part 

 Use Modify Configurations. 
 Applying different dimension values to individual configurations.
 Design tables.

Drag and Drop from 
an Open Document

The pin will be inserted by dragging it in from an open document 
window into the assembly.

Note If the bracket window is still open, close it before the next step.

28 Drag and drop.
Open the part pin and tile the windows of the assembly and part. Drag 
and drop the pin into the assembly window by dragging the top-level 
component ( ) from the FeatureManager design tree. An 
instance of the pin is added to the assembly.

LONG

SHORT
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Important! The pin is a component that contains multiple configurations. Like all 
components, only the configuration that is used (LONG in this case) 
appears in the component name.

Note Display States are primarily used in assemblies, but can be used in 
multi-body parts. For more information on display states, see the 
Assembly Modeling training manual. 

29 Concentric mate.
Select the cylindrical faces as shown. Add a 
Concentric mate between the cylindrical 
face in the Yoke_female and pin using the 
context toolbar.

Note To prevent rotation of the pin, click the Lock Rotation option.

Drag the pin through the Yoke_female as 
shown.
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30 Tangent mate.
Add a Tangent mate between the planar end 
face of the pin and the cylindrical face in the 
Yoke_female using the context toolbar.

The Second Pin Another instance of the pin is needed. This one will be the shorter 
version, SHORT. We will open the pin, tile the windows of the part and 
assembly, and show the part’s ConfigurationManager.

Opening a 
Component

When you need to access a component while working in an assembly, 
you can open it directly, without having to use the File, Open menu. 
The component can be either a part or a subassembly.

31 Cascade the windows.
Click Window, Cascade to see both the part and assembly windows. 
Switch to the ConfigurationManager of the pin.

32 Drag and drop a configuration.
Drag and drop the configuration SHORT into the graphics window of 
the assembly. You can drag and drop any configuration from the 
ConfigurationManager, not just the active one.
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Other Methods of 
Selecting 
Configurations

There are several more methods for selecting the configuration of a 
component used in an assembly.

 To get the same result using Insert Component, browse for the 
part and associated configuration.

 Parts that contain configurations 
trigger a message box when dragged 
and dropped. Select the desired 
configuration from the list.

 After the component has been 
added, click on it and select the 
configuration name from the 
context toolbar or Component 
Properties (see Component 
Properties on page 242).

33 Second instance.
The second instance of the pin 
component was added, this time 
using the SHORT configuration. 
The component is added and it 
displays the proper configuration 
name in the FeatureManager 
design tree.

34 Mate the component.
Add Concentric and Tangent mates to mate the 
second instance of the pin.
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Recent Documents SOLIDWORKS maintains a list of recently opened documents that can 
be used to access documents quickly. Type the shortcut key R and click 
the document to open. 

The pin can be used to keep documents on the recent documents list. 
The Show in Folder link is used to open the folder where the 
document resides.

Where to Find It  Keyboard Shortcut: R

Tip Clicking  in the lower right hand corner of the image brings up a 
dialog with several options when opening the file including selection of 
the mode, configuration, and display state. Clicking Show in Folder 
opens Windows showing the component location. 

35 Switch documents. 
Switch to the pin.SLDPRT document, close it and maximize the 
assembly window.

Creating Copies of 
Instances

Many times parts and subassemblies are used more than once in an 
assembly. To create multiple instances, or copies of the components, 
copy and paste existing ones into the assembly.

36 Drag a copy.
Create another copy of the pin 
component by holding the Ctrl key 
while dragging the instance with 
the SHORT configuration into the 
graphics area. The result is another 
instance that uses the SHORT 
configuration, since it was copied from a component with that 
configuration.

Tip You can drag a copy from the FeatureManager design tree or the 
graphics area of the assembly.
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Component Hiding 
and Transparency

Hiding a component temporarily removes the component’s graphics 
but leaves the component active within the assembly. A hidden 
component still resides in memory, still has its mates solved, and is still 
considered in operations like mass property calculations.

Another option is to change the transparency of the component. 
Selections can be made through the component to others behind it.

Introducing:
Hide Component
Show Component

Hide Component turns off the display of a 
component, making it easier to see other parts of the 
assembly. When a component is hidden, its icon in the 
FeatureManager design tree appears in outline form 
like this: .

Show Component turns the display back on.

Where to Find It  Shortcut Menu: Right-click a component and click 

Hide Components  or Show Components 

 Display Pane: Hide/Show  in the component row
 Keyboard Shortcut. Move the pointer over a component and press 

Tab to hide. Move the pointer over a hidden component and press 
Shift + Tab to display.

Introducing: Change 
Transparency

Change Transparency toggles the component 
transparency between 0% and 75%. Selections 
pass through the transparent component unless the 
Shift key is pressed during selection. The 
FeatureManager design tree icon does not change 
when a component is transparent.

Where to Find It  Shortcut Menu: Right-click a component and click 

Change Transparency 

 Display Pane: Transparency  in the component row

37 Hide the bracket.
Change the view orientation from the default 
Isometric by pressing Shift+Left Arrow once. 

Click on the bracket component and 

Hide Component .
240



SOLIDWORKS Education 2023 Lesson 6
Bottom-Up Assembly Modeling
38 Complete the mating.
Complete the mating of this component by adding 
Concentric and Tangent mates using Insert Mate.

39 Show the component.
Select the bracket again and click Show 

Component  to toggle the graphics back 
on.

40 Return to previous view.

Previous view states can be recalled by clicking Previous View  on 
the Heads-up View Toolbar. Each time you press the button, the view 
display backs up through the display list, whether the view state was 
saved or not. Click once to return to the previous Isometric view.

41 Visual references.
Dynamic Reference Visualization can be used with assemblies to 
visually identify components from a mate and mates from a 
component. 
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Component 
Properties

The Component Properties dialog controls several aspects of a 
component instance.

 Model Document Path
Displays the part file that the instance uses. To replace the file instance 
references with a different file, use File, Replace.

 Display State specific properties
Hides or shows the component. Also enables you to select a display 
state by name. 

 Suppression state
Suppress, resolve or set the component to lightweight status.

 Solve as
Makes the subassembly rigid or flexible. This allows dynamic 
assembly motion to solve motion at the subassembly level.

 Referenced configuration
Determines which configuration of the component is being used.

Where to Find It  Shortcut Menu: Right-click a component and click 

Component Properties 

42 Component properties.
Right-click the pin<3> component and click 

Component Properties . The Referenced configuration option is 
set to SHORT. This dialog box can be used to change the configuration, 
suppress, or hide an instance. Click Cancel.
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Subassemblies A new assembly will be created for the components of the crank. It will 
be used as a subassembly.

Existing assemblies can also be inserted into the current assembly 
using any of the techniques previously introduced for parts. When an 
assembly file is added to an existing assembly, we refer to it as a 
subassembly. However, to the SOLIDWORKS software, it is still an 
assembly (*.sldasm) file.

The subassembly and all its component parts are added to the 
FeatureManager design tree. The subassembly can be mated to the 
assembly by one of its component parts or its planes. The subassembly 
is treated as a single piece component, regardless of how many 
components are within it.

1 New assembly.
Create a new assembly using the Assembly_MM template. 
Click Keep Visible  on the Begin Assembly 
PropertyManager and add the crank-shaft component. 
Locate it at the origin of the assembly. 

It is Fixed.

2 Add components.
Using the same dialog, add the 
crank-arm and crank-knob 
components.

Close the dialog.
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Smart Mates Mates can be added between components while dragging and dropping 
them. This method, called Smart Mates, uses the Alt key in 
conjunction with standard drag and drop techniques.

These mates use the same Mate pop-up toolbar as the Mate tool uses to 
set the type and other attributes. Many mate types can be created with 
this method.

Certain techniques generate multiple mates and do not use the toolbar. 
These require the use of the Tab key to switch mate alignment.

3 Smart Mate concentric.
Follow these steps to add a Concentric mate through the Smart Mate 
technique:

1. Press and hold the Alt key.
2. Click and hold the circular face of 

the crank-arm.
3. Move the component over the 

circular face of the crank-shaft.
4. Drop the component when the  

tooltip appears, indicating a 
concentric mate.

5. Confirm the Concentric type from 
the Mate pop-up toolbar.

A Concentric mate is added between the crank-arm and the crank-
shaft components.

Tip The Alt key can be pressed before or after selecting a face to mate.

4 Smart Mate parallel.
Spin the crank-arm around so the flat 
of the "D" cut is selectable using 
dragging. Select the flat and Alt-+drag 
it to the flat on the crank-shaft. Drop 
the component when the  symbol 
appears, indicating a Coincident mate 
between planar faces.

Use the Mate pop-up toolbar to switch 
to a Parallel mate.
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5 Coincident.
Select the edge of the crank-arm and Alt-+drag it to 
the flat on the crank-shaft. Drop the component 
when the  symbol appears, indicating a Coincident 
mate between and edge and a planar face. Use the 
Mate pop-up toolbar to confirm the Coincident mate.

6 “Peg-in-hole”.
Rotate the crank-knob using Move 
with Triad (Triad on page 218). 

The “Peg-in-hole” option is a special 
case of the Smart Mate that creates 
two mates from one drag and drop. 
This operation is easier if the crank-
knob has been rotated.

Select the circular edge on the crank-
knob. Press Alt and drag it to the 
circular edge on the top of the crank-
arm. 

Release the Alt key when the  
symbol appears, indicating that both 
Coincident and Concentric mates 
will be added.

Press the Tab key, if necessary, to 
reverse the alignment. Drop the 
component.

7 Save.
Save the assembly, naming it crank sub. Leave the assembly open.

Hide and Show All 
Types

All of the visual symbols used in SOLIDWORKS including: axes, 
coordinate systems, origins, planes, and sketches can be toggled on and 
off all at once using Hide All Types and Show All Types. Currently 
the only visible type are the blue View Origins.

Where to Find It  Heads-up View Toolbar: Hide All Types  
 Menu Bar: View, Hide/Show, Hide All Types
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8 Hide all types. 

Click Hide All Types  to toggle all 
the visual symbols in this assembly off. 

Inserting 
Subassemblies

Subassemblies are existing assemblies that are added to the active 
assembly. All of the subassembly components act as a single 
component.

9 Select the subassembly.
Switch to the main assembly. Using Insert Component, the dialog is 
set to list any open parts or assemblies under Open documents. The 
crank sub is listed and selected.

10 Place the subassembly.
Place the subassembly near the top of the Yoke_male component. 
Expanding the subassembly component icon shows all the component 
parts within it, including its own mate group.
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Mating 
Subassemblies

Subassemblies follow the same rules for mating as parts. They are 
considered components and can be mated using the Mate tool, 
Alt+drag mating or any of the other methods that have been discussed.

11 Smart Mate concentric.
Add a Concentric mate, using Alt+drag, 
between the cylindrical surfaces of the post on 
the top of the Yoke_male and the crank-shaft.

12 Parallel mate.
Mate the flat on the Yoke_male with the 
flat in the D-hole in the crank-shaft 
with a Parallel mate.

13 Alignment.
Click the Flip Mate Alignment button to 
test Anti-Aligned (above) and Aligned 
(right). 

Use the anti-aligned condition (above) for 
this mate.
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Distance Mates Distance mates allow for gaps between mating components. You can 
think of it as a parallel mate with an offset distance. There is generally 
more than one solution so the options Flip Mate Alignment and 
Flip Dimension are used to determine how the distance is measured 
and which side it is on.

Unit System The Unit System controls input to the document as well as the units of 
mass property calculations. The unit system can be set using Tools, 
Options, Document Properties, Units. You can also set the unit 
system by clicking Unit System on the status bar.

Alternatively, you can enter dimensions in a 
unit system other than the document’s units. 
In the dimension value fields, you can type 
the abbreviation for the desired units, or 
choose the units from a drop down list.

14 Select the faces.
Select the top face of the bracket and the 
bottom face of the crank-shaft 
component to create the mate.

15 Add a Distance mate.
Specify a distance in units that are 
different than the document’s units. Type 
1/32 in. If the crank-shaft penetrates into 
the bracket select the Flip Dimension  
button. Click OK to create the mate.

Tip Double-clicking a Distance or Angle mate 
in the FeatureManager design tree displays 
it on the screen. The value displays in the 
units of the assembly, in this case 
millimeters.
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16 Select in the FeatureManager design 
tree.
Select the subassembly crank sub in the 
FeatureManager design tree. All 
components in the subassembly will be 
selected and highlighted.

Tip From the graphic window, right-click a component of the subassembly 
and click Select subassembly.

17 Dynamic Assembly Motion.
Use Change Transparency on the yokes. 
Drag the crank-arm to see the motion of 
the spider. 

Use For Positioning 
Only

The mate option Use for positioning only can be used to position 
geometry without adding the restriction of a mate. This is a useful 
method for setting up a drawing view.

18 Mate.

Click Mate  and click Use for positioning 
only. Select the planar faces shown and a Parallel 
mate. Click OK.

The geometry is positioned like a parallel mate 
condition but no mate is added.

Save the assembly.
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Pack and Go Pack and Go is used to collect and copy all the files used by the 
assembly into a single folder or zip file. It is especially useful when the 
entire assembly must be sent to another user and the files are stored in 
many different folders. Additional related files can be included.

Where to Find It  Menu: File, Pack and Go

19 Pack and Go.
Click Pack and Go and click Save To Zip File. Use a file name of 
your choice, click Flatten to single folder, and click Save.

20 Save and close all files.
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Exercise 25:
Mates

Create this assembly by adding 
components to a new assembly and using 
mates.

This lab uses the following skills:

 Creating a New Assembly on page 212
 Adding Components on page 217
 Mating Components on page 219

Units: millimeters

Procedure Create a new assembly. All the component parts can be found in the 
folder Mates. 

1 Add the component RectBase.
Create a new assembly, using the RectBase 
part as the base component. It should be 
fixed at the assembly origin.

2 Add the EndConnect.
Add an instance of the EndConnect to the 
assembly. Mate it to the RectBase using a 
distance of 10mm and two coincident mates as 
shown. 

3 Add the Brace. 
Add an instance of the Brace to the assembly. 
Mate it to the RectBase using coincident 
mates as shown. 

The Brace is centered on the hole in the 
EndConnect component. 

 

Tip Coincident mates between planes or Width mates can be used to center 
components. 
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4 Additional components. 
Add more instances of the Brace and EndConnect components, 
placing them as shown. 

5 Save and close all files.
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Exercise 26:
Gripe Grinder

Assemble this device by following the steps 
as shown.

This lab uses the following skills:

 Creating a New Assembly on page 212
 Adding Components on page 217
 Mating Components on page 219
 Dynamic Assembly Motion on page 234
 Smart Mates on page 244

Units: millimeters

Procedure Create a new assembly. All the component parts can be found in the 
folder Grinder Assy. 

1 Add the component Base.
Create a new assembly, using the Base 
part as the base component. It should be 
fixed at the assembly origin.

2 Add the Slider.
Add the Slider to the assembly. Mate it 
to one of the dovetail slots. A width and 
coincident mate are required.

3 Add a second copy of the Slider.
Mate it to the other dovetail slot. Both 
Sliders should be free to move back and 
forth in their respective slots.
253



Exercise 26 SOLIDWORKS Education 2023
Gripe Grinder
4 Crank assembly.
Open a new assembly using the 
Assembly_MM template. Build the 
Crank assembly as shown at the right. 
Consider using “peg-in-hole” 
SmartMates to add the coincident and 
concentric mates in one step. The Crank 
is shown in both exploded and collapsed 
states.

The Crank assembly consists of:

 Handle (1)
 Knob (1)
 Truss Head Screw (1)  

[#8-32 (.5” long)] configuration
 RH Machine Screw (2)  

[#4-40 (.625” long)] configuration

Note Both machine screws contain multiple 
configurations. Be sure you use the correct ones.

5 Insert the Crank assembly into the 
main assembly.
Tile or cascade the two assembly 
windows, and drag and drop the 
subassembly into the main assembly.

6 Mate the Crank assembly to the 
Sliders.
The two RH Machine Screws go 
into the holes in the Sliders. The 
underside of the Handle mates to the 
top face of one of the Sliders.

7 Turn the Crank.
The movement of the Knob follows an elliptical path. The movement 
of each Slider traces the major and minor axes of that ellipse.

8 Save and close all files.
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Exercise 27:
Using Hide and 
Show 
Component

Create this assembly by using mates.

This lab uses the following skills:

 Creating a New Assembly on 
page 212.

 Adding Components on page 217
 Mating Components on page 219
 Component Hiding and Transparency 

on page 240
 Smart Mates on page 244

Units: millimeters

Procedure Create a new assembly. All the component parts can be found in the 
folder Gearbox Assy. 

1 Create assembly.
Open the Housing component. Use Make Assembly from Part/
Assembly to create a new assembly with the Assembly_MM 
template. It should be fixed at the assembly origin.

2 Add the components.
Drag or insert the remaining component parts into the assembly.

3 Mates.
Mate the Cover Plate and both 
Cover_Pl&Lug components to the 
Housing as shown. 
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4 Hide. 
Hide the Cover Plate and one of the 
Cover_Pl&Lug components as shown. 

5 Add more components. 
Add the Worm Gear Shaft and Worm 
Gear components as shown. 

Tip Mate the Worm Gear to the 
Housing using a Width mate. 

6 Detail.
Show the hidden components. Use Change Transparency to change 
the appearance of the Housing. 

Add the Offset Shaft component and mate it. 

Tip A detail for mating the Offset Shaft to 
the Housing is shown at right. 

7 Save and close all files.
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Exercise 28:
Part 
Configurations 
in an Assembly

Using the parts included, complete this 
bottom up assembly. Use several con-
figurations of the same part in the 
assembly to create a set of allen 
wrenches. 

This lab reinforces the following skills:

 Adding Components on page 217
 Mating Components on page 219
 Using Part Configurations in Assemblies on page 235
 Opening a Component on page 237

Procedure Open an existing assembly.

1 Existing assembly.
Open the assembly part 
configs from folder 
part configs. The 
assembly contains three 
components, two of 
which have multiple 
instances. One 
component, the Allen 
Wrench, uses a different 
configuration for each 
instance.

2 Open part.
Select any instance of the 
Allen Wrench component and 
open the part.
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3 Configuration. 
Use the values in the Length column for each configuration as shown.

Tip Right-click the dimension and click Configure Dimension. 

4 Add and mate components.
Add and mate three more components, 
noting the configurations of the Allen 
Wrench parts. The sizes, positions and part 
names are detailed in the accompanying 
illustrations.

Tip The Allen Wrench axis center_axis is useful for mating. 

5 Save and close all files.

Length

Size01 50

Size02 60

Size03 70

Size04 80

Size05 90

Size06 100

Size07 100

Size08 90

Size09 80

Size10 100

Size 7

Size 8

Size 9
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Exercise 29:
U-Joint 
Changes

Make changes to the assembly created in the 
previous lesson.

This exercise uses the following skills:

 Insert Component on page 217
 Mating Components on page 219
 Opening a Component on page 237
 Component Hiding and Transparency on 

page 240

Procedure Open an existing assembly.

1 Open the assembly named Changes.
Open the assembly Changes from 
folder U-Joint Changes.

2 Open the bracket component.
From the FeatureManager design tree or 
the screen, open the component 
bracket<1> for editing.

3 Changes.
Double-click the first feature and 
change the dimensions that are shown 
as bold and underlined.

Rebuild the part.

4 Close and save.
Close the bracket part, saving the 
changes that you have made. Respond 
Yes to rebuilding the assembly.

5 Changes.
The changes made in the part also appear in the 
assembly.

6 Turn the crank.
The crank should turn freely, turning the two yokes, 
the spider, and the pins with it.

7 Delete mate.
Expand the Mate folder and delete the mate 
Parallel2.

bracket
259



Exercise 29 SOLIDWORKS Education 2023
U-Joint Changes
8 Turn the crank.
The crank should turn freely but it is no 
longer connected to the yokes and spider.

9 Insert a set screw.
Insert the existing component named 
set screw. Mate it to the small hole in the 
crank-shaft with a Concentric mate.

Optionally, click the Lock Rotation option.

10 Hide component.
Hide the crank-shaft component. Add a 
Coincident mate between the flat faces of the 
set screw and the Yoke_Male.

11 Show component.
Show the crank-shaft component.

12 Turn the crank.
The crank should turn freely and once again, 
the two yokes, the spider and the pins should 
rotate with it.

13 Save and close the assembly.
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Objectives Upon successful completion of this lesson, you will be able to:

 Navigate the SOLIDWORKS Simulation user interface.

 Analyze a linear static study using solid elements.

 Understand the influence of mesh density on displacement and 
stress results.

 Employ various methods to present FEA results.

 Manage SOLIDWORKS Simulation result files.

 Access available help and assistance.
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The Analysis 
Process

All SOLIDWORKS Simulation studies follow a similar process, 
regardless of the model or simulated event. This lesson explores the 
analysis process with a simple example and shows all the fundamental 
steps required to set up, run and analyze a simulation.

Stages in the 
Process

Some key stages in the analysis of a model are shown in the following 
list:

 Create a study
A study is an analysis performed on a model. A model can contain 
multiple studies.

 Apply material
Material properties, such as the Elastic Modulus, define a 
structure’s response to a load.

 Apply fixtures
Fixtures represent the way the physical model is held.

 Apply loads
Loads represent the forces on the model.

 Mesh the model
The model is divided into finite elements.

 Run the study
The solver calculates the displacement, strain and stress in the 
model.

 Analyze the results
The results are interpreted.

Case Study: 
Stress in a Plate

Determine the stress in a rectangular plate with a hole in its center 
while subjected to a tensile load.

View this case study as a means to familiarize yourself with the 
software's basic functionality.
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Project 
Description

A rectangular plate with a hole in its 
center is fixed at one end. A 
uniformly distributed 110,000 
newton load applies tension to the 
other end.

In addition to learning 
SOLIDWORKS Simulation functions, our objective is to investigate 
the impact of mesh density on the results. Using FEA terminology, the 
aim is to examine the effect of different discretization choices on the 
data of interest; in our case, on deformation and stress. Therefore, we 
will perform the analyses using meshes with varying element sizes to 
gain more insight into how FEA works.

14 Open a part file.
Open rectangular hollow plate from the Lesson01\Case Studies 
folder. Review the dimensions of the model and note the length, width, 
and thickness of the part in millimeters.

15 Start SOLIDWORKS Simulation.
From the CommandManager, browse to SOLIDWORKS Add-Ins, and 
click SOLIDWORKS Simulation.
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SOLIDWORKS 
Simulation 
Interface

The SOLIDWORKS Simulation user interface is similar to the 
SOLIDWORKS user interface. As we work, a tree structure records 
performed steps. Access features using the Simulation Study tree, the 
Simulation pull-down menu, Toolbars, and the CommandManager.

Simulation Study 
Tree

Once we create a simulation study, the 
Simulation Study tree appears over the 
SOLIDWORKS FeatureManager design 
tree. Switch between the SOLIDWORKS 
FeatureManager and the Simulation Study 
tree using tabs below the graphics area. 
(The Model tab displays the 
FeatureManager, and a Simulation Study 
tab displays its Simulation Study tree.)

Simulation

Simulation Study

CommandManager tab

Study tree

tabs

Simulation 
Advisor
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Simulation Pull-
down Menu

The Simulation pull-down menu provides 
access many simulation commands.

Toolbars The Shortcut toolbar allows you to access 
commands quickly by clicking the S key on the 
keyboard. Customize the Shortcut toolbar to 
include the commands you use frequently.

CommandManager The CommandManager provides a universal toolbar for simulation 
features. The Simulation tab provides the tools to set up a study and 
analyze results.
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Context Menus Right-click geometry and Simulation Study 
tree items to access relevant features and 
functions.

SOLIDWORKS 
Simulation 
Options

The Options on the Simulation pull-down menu enable you to 
customize the Simulation software to reflect your company's analysis 
standards. There are two categories of options, system and default.

 System Options
System options apply to all studies. Included are the settings for the 
way the errors are displayed and the location of the default libraries.

 Default Options
Default options apply to new studies. As we do not use templates 
for simulation studies, this is where the options are set for units, 
default plots, etc.

Where to Find It  Menu: Simulation, Options

16 Open Simulation Options window.

Click Options .

17 Set default units for SOLIDWORKS Simulation.
Under Default Options, select Units.

Ensure that the Units system is set to SI (MKS) and Length/
Displacement and Stress are in mm and N/mm^2(MPa), respectively.
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18 Mesh settings.
Under Default Options, select Mesh.

Ensure the option Mesh all solid bodies with solid mesh is cleared.

Select the Curvature-based Mesher type.

19 Define the solver and the results folder.
Click Solver and Results.

Under Default solver, select Automatic.

Under Save Results, select SOLIDWORKS document folder.

Click Under sub folder and enter Results.

Note The SOLIDWORKS document folder is your working directory; it is 
where the rectangular hollow plate.SLDPRT file resides.

This step directs the software to create a Results folder in the working 
directory for storing simulation data.

Plot Settings By default, SOLIDWORKS Simulation 
automatically creates the following 
result plots after running a study:

 Stress1
 Displacement1
 Strain1

Define new automatically created plots 
in Default Options, or create plots 
manually in postprocessing.
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20 Set default plots.
Expand the Default Plots subfolder located under the Plot folder. This 
section defines the automatically generated result plots that appear in 
postprocessing.

Explore the Default Plots without editing their values.

21 Specify color chart options.
Under the Plot folder, click Color Chart.

Set Number format to Scientific and No. of decimal places to 6.

Explore the chart options in this window.

Click OK to close the Options window.
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Preprocessing In the following steps, we will prepare the model for analysis. The 
preprocessing steps include:

 Create a study 

 Apply material 

 Apply fixtures 

 Apply external forces 

 Mesh the model 

New Study Creating an FEA model always starts with the 
definition of a study, where we define the type of 
analysis we wish to perform.

SOLIDWORKS Simulation treats each analysis 
as a separate study. New studies feature an 
automatically created tree structure populated 
with icons. Some icons are folders, or nodes, for storing features. Other 
icons graphically indicate study information, such as whether or not a 
step was completed.

Use Part  to define and assign material properties, 

External Loads  to define forces, Fixtures  to define restraints, 

and Mesh  to create the finite element model.

Connections  define how components interact with one another. In 
this study, only one component named rectangular hollow plate 

resides in the Part  folder, so we will not use Connections in this 
lesson.

Studies containing multiple bodies have a Parts  folder, containing 

a Part  for each body in the model.

Where to Find It  CommandManager: Simulation > New Study 

 Menu: Simulation, Study 

Renaming Studies Change the name of the study by click-pause-clicking on the study 
name, by clicking the study name and selecting the F2 button on the 
keyboard, or by right-clicking on the study tab and selecting Rename. 
(SOLIDWORKS Simulation uses many standard Windows 
conventions.)

22 Create a study.

Click Study .
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23 Name the study.

Under General Simulation click Static .

Type default analysis for the Name.

Click OK .

Assigning Material 
Properties

SOLIDWORKS Simulation and SOLIDWORKS share a common 
Material database, which allows you to assign material properties in 
either environment. - A material assigned in SOLIDWORKS 
automatically transfers to SOLIDWORKS Simulation when defining a 
new study.

A material can store mechanical property values, appearance 
information, and sheet metal bending data. SOLIDWORKS Simulation 
requires specific mechanical properties, color-coded within the 
SOLIDWORKS Simulation environment. Material constants displayed 
with red text are mandatory for all Static studies. Particular situations 
require the blue constants. (E.g., a Temperature load requires the 
Thermal Expansion Coefficient).

Add frequently used materials to a Favorites folder. Use Favorites to 
apply material without opening the material window. To manage the 

Favorite material list, right-click Material  in the SOLIDWORKS 
FeatureManager design tree and select Manage Favorites.

Where to Find It:  Menu: Simulation, Material, Apply Material to All 
 CommandManager: Select the component in the Simulation Study 

tree, Simulation > Apply Material
 Shortcut Menu: Right-click a body from the tree and click  

Apply/Edit Material (alternatively: Apply Favorite Material)

Note The first method assigns the same material properties to all components 
in the model. The second method assigns material properties to the 
components that were selected. The third method assigns material 
properties to one particular body.
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24 Assign material properties.

Click Apply/Edit Material .

Expand SOLIDWORKS Materials and select AISI 304 from the Steel 
folder.

Click Apply and Close.

The rectangular hollow plate icon in the Parts folder now displays a 
green check mark and the name of the assigned material.
271



Lesson 7 SOLIDWORKS Education 2023
The Analysis Process
Fixtures Restraints allow a structure to maintain stability when subjected to 
loads. Fixtures represent a connection between the model and the 
ground (geometry that is not explicitly modeled). SOLIDWORKS 
Simulation provides various fixtures to restrain the model. Generally, 
fixtures can be applied to faces, edges and vertices.

Fixture Types SOLIDWORKS Simulation groups fixtures into two categories, 
Standard and Advanced, summarized in the tables below:

Standard Fixtures

Fixture Type Definition

Fixed Geometry Also called a rigid support, all translational and all rotational degrees of 
freedom are constrained.

Immovable This restraint locks translational movement but allows rotational 
movement. This option is only available when working with shell and 
beam elements but not solid elements. (Solid elements can not rotate.)

Roller/Slider Use the Roller/Slider restraint to specify that a planar face can move 
freely in its plane but cannot move in the direction normal to its plane. 
The face can shrink or expand under loading.

Fixed Hinge Use the Hinge restraint to specify that a cylindrical face can move only 
about its axis. The radius and the length of the cylindrical face remain 
constant under loading.

Elastic Support This fixture defines an elastic foundation between the selected faces of a 
part or assembly and the ground. The faces do not have to be planar.

An Elastic Support fixture with infinite stiffness behaves the same as the 
Fixed Geometry fixture.

Bearing Fixture This fixture defines a connection between a cylindrical face and the 
ground with elastic characteristics. A Bearing fixture with infinite 
stiffness and unconstrained rotation behaves the same as a Fixed Hinge 
fixture.

Foundation Bolt This fixture connects the model to the ground by applying an elastic 
force to areas around a circular hole on a planar face. Define Foundation 
Bolts in conjunction with Virtual Walls.
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Where to Find It  CommandManager: Simulation > Fixtures Advisor > 

Fixed Geometry 
 Menu: Simulation, Loads/Fixture, Fixtures
 Shortcut Menu: Right-click Fixtures and click Fixed Geometry

Advanced Fixtures

Fixture Type Definition

Symmetry This option is available on flat faces and allows the structure to translate 
and rotate along the selected face.

Cyclic Symmetry This option is used to restrain segments which, if periodically revolved 
around a specified axis of revolution, would form a rotationally 
symmetrical body.

Use Reference 
Geometry

This option restrains a face, edge, or vertex only in desired direction(s), 
while leaving the other directions free to move. You can specify the 
desired direction(s) of restraint in relation to the selected reference 
plane, axis, edge, or face. The SOLIDWORKS Flyout FeatureManager 
is useful for selecting reference geometry (plane and axis).

On Flat Faces This option provides restraints in selected directions, which are defined 
by the three principal directions of the flat face where restraints are 
being applied. 

On Cylindrical 
Faces

This option is similar to On flat face except that the three principal 
directions of a cylindrical reference face define the directions in a 
cylindrical coordinate system; this option is very useful because you can 
apply a restraint that allows for rotation about the axis associated with 
the cylindrical face.

On Spherical 
Faces

Similar to On flat faces and On cylindrical faces; the three principal 
directions of a spherical face define the directions of the applied 
restraints in a spherical coordinate system.
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Fixture Symbols After defining a Fixture, fixture symbols appear on 
affected faces, edges, and vertices.

In this case study, we select Fixed Geometry  as the 
fixture type, meaning that all six degrees of freedom 
(three translations and three rotations) are restrained.

Arrows indicate translational restraint and discs indicate 
rotational restraint. In this lesson, the fixtures are defined by the 
directions of the global coordinate system, visible in the lower-left 
corner of the model window.

If, instead of selecting Fixed Geometry  as the type 

of fixture, we selected Roller/Slider , then the 
rotational degrees of freedom would not be constrained 
and the corresponding fixture symbols would feature 
only arrows, not discs.

25 Define Fixed Restraints.

Click Fixed Geometry .

Rotate the model and select the face as shown.

Click OK .

Having defined fixtures, we have fully restrained the model in space. 
Therefore, the model cannot displace without elastic deformation.
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Renaming Folders Edit feature names within the Simulation tree for fixtures, loads, 
connectors, and result plots, to organize work and state intent. Use 
click-pause-click or select the object and use the F2 button on the 
keyboard to rename an object.

26 Rename the fixture.
Rename the fixture named Fixed-1 to Fixed side.

External Loads Once the model is restrained, we must apply external loads or forces to 
the model. Generally, forces are applied to faces, edges, and vertices 
using various methods. These external forces and their properties are 
summarized below:

Standard External Forces

Force Type Definition

Force This option applies a force or moment to a face, edge, or vertex in the 
direction defined by selected reference geometry (plane, edge, face, or 
axis).

Note that a moment can only be applied if shell or beam elements are 
used. Shell and beam elements have six degrees of freedom per node 
(translations and rotations) and can assume a moment load. Solid 
elements have only three degrees of freedom per node (translations only) 
and, therefore, cannot assume a moment load directly.

If you need to apply a moment to solid elements, it must be represented 
by appropriately distributed forces, or remote loads.

Torque This option applies torque about a reference axis using the Right-hand 
Rule. This option requires that the axis be defined in SOLIDWORKS.

Advanced External Forces

Force Type Definition

Pressure Applies a pressure to a face. Can be directional and variable, such as 
hydrostatic pressure.

Gravity Applies linear accelerations to parts or assemblies.

Centrifugal Force Applies an angular velocity and acceleration to a part or assembly.

Bearing Load Bearing loads are defined between interacting cylindrical faces.
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Where to Find It  CommandManager: Simulation > External Loads Advisor > 
click one of the available Force Types

 Menu: Simulation, Loads/Fixture, click one of the available 
Force Types

 Shortcut Menu: Right-click External Loads and click one of the 
available Force Types

Note The presence of an external force is indicated by arrows symbolizing 
the load and by the corresponding icon.

Remote Load/
Mass

Remote loads apply loads that would normally be transferred by 
connecting structure.

Distributed Mass Distributed masses are applied to selected faces to simulate the mass of 
components that are suppressed or not included in the model.

Temperature Temperatures are applied to components for thermal expansion effects.

Advanced External Forces

Force Type Definition
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27 Define Force.
We will apply a tensile force of 110,000 N [24,729 lbf] to the face 
opposite the fixture.

Rotate the model’s orientation to view the face opposite the fixture.

Click Force .

Click the face opposite the fixture.

Select Normal to specify that the force acts normal to the selected face. 
In the Units dialog ensure SI is selected and in the Force Value box, 
type 110,000.

Select Reverse direction. (This is required to define a tensile force.)

When defining a normal force we do not need to use any reference 
geometry. Load direction is sufficiently defined by the orientation of 
the loaded face with Normal selected.

Click OK .

28 Rename the force.
Rename the force created in the previous step to Tensile force.
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Size and Color of 
Symbols

The size and color of 
restraint and load symbols 
can be controlled both 
locally and globally.

The local settings of the 
symbols are controlled from 
the Symbol settings dialog 
in the Fixtures and External 
Loads PropertyManagers.

The global definitions for the symbols are controlled by the 
SOLIDWORKS Simulation Options in the Load/Fixture folder.

Display/Hide 
Symbols

The model now shows both load and restraint symbols. To hide or 
show the symbols:

 Right-click a particular restraint or load icon in the Fixtures or 
External Loads folder and choose Show or Hide.

 Right-click the Fixtures or External Loads folder to globally display 
or hide loads and restraints and choose Show All or Hide All.
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Preprocessing 
Summary

Now that we have assigned material properties, fixtures, and external 
loads, we have fully defined the mathematical model, which we will 
discretize into a finite element model (mesh) before solving. Let us 
make a few observations about the following terms:

 Geometry preparation
 Material properties
 External loads definition
 Fixtures definition

Geometry 
Preparation

Geometry preparation is a well-defined step with few uncertainties. 
Geometry that is simplified for analysis can be checked visually by 
comparing it with the original CAD model.

Material Properties Material properties are most often selected from the material library 
and do not account for local defects, surface conditions, and so on. 
Generally, material definition has more uncertainties than geometry 
preparation.

External Loads 
Definition 

Defining external loads involves many background assumptions 
because in real life, the load magnitude, distribution, and time 
dependence are often approximated and must be roughly estimated in 
FEA with many simplifying assumptions. Therefore, significant 
idealization errors can be made when defining loads. Nonetheless, 
loads can be expressed in numbers, which makes loads easier for FEA 
users to relate to.

Fixtures Definition Defining restraints is where severe 
errors are most often made. A 
common error is over-constraining 
the model, which results in an overly 
stiff structure that underestimates 
deformations and stresses.

The relative level of uncertainties in 
defining geometry, material, loads, 
and fixtures is qualitatively shown.

MaterialGeometry FixturesLoads
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Idealizations and 
Assumptions

Geometry is the easiest to define, while fixtures are the most difficult, 
but the difficulty level has no relation to the time required for each step, 
so the message in this bar graph may be counterintuitive. Preparing 
CAD geometry for FEA may take hours while defining material, and 
applying loads and fixtures involves only a few mouse clicks.

In all examples here, we assume we know the material properties, 
external forces, and supports with certainty, and the way we define the 
model represents an acceptable idealization of real conditions. 
However, we need to emphasize that it is the software operator's 
responsibility to determine if all those idealized assumptions made 
during the creation of the mathematical model are indeed acceptable. 
The best automesher and the fastest solver do not help if the 
mathematical model submitted for FEA analysis is based on erroneous 
assumptions.

Meshing The last step before processing the FEA model is to mesh the geometry. 
In this step, the geometry will be divided into finite elements by an 
automatic mesher. While the automatic mesher will take care of the 
tedious part of the problem, we have input into the process to control 
the size and quality of the mesh.

Standard Mesh This mesh type was the first developed 
for SOLIDWORKS Simulation and 
makes use of Voronoi-Delaunay 
meshing scheme. However, when 
representing small features and curved 
geometries the mesh can experience 
large aspect ratios or failure. When a 
symmetrical mesh is required, this mesh type is ideal.

Curvature-Based 
Mesh

The Curvature-based mesh algorithm 
generates a mesh with a variable 
element size that allows the accurate 
resolution of small features in the 
geometry. The curvature based mesher 
supports multi-threading. This mesh 
can result in large aspect ratios.

Blended 
Curvature-Based 
Mesh

Models which produce large aspect 
ratios or failure from the curvature 
based mesher can often be resolved 
with this mesher. This mesher supports 
multi-threading but does not support 
adaptive mesh refinement.
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Mesh Density Mesh density directly affects the accuracy of results. A mesh consisting 
of small elements will provide results with lower discretization errors, 
but this comes at the cost of increased mesh creation and solving times.

Element Sizes Elements are often irregular. For simplification, we define the size of 
an element by its characteristic length, which is the diameter of a 
sphere circumscribing the element (on the left in the following figure). 
This representation is easier to illustrate with the 2-D analogy of a 
circle circumscribing a triangle (on the right in the following figure).

Because the Curvature-based mesh algorithm generates a mesh with a 
variable element size, the Maximum element size and Minimum 
element size define how big and small the elements are. These 
parameters are established automatically, based on the geometric 
features of the SOLIDWORKS model.

SOLIDWORKS Simulation uses the units of length specified in the 
SOLIDWORKS model for the element size. Remember, however, that 
we can enter analysis data and analyze results in any one of three unit 
systems: SI, Metric and English.

Minimum Number 
of Elements in a 
Circle

The Min number of elements in a circle 
parameter defines how the small features in 
the geometry will be resolved. For example, 
if the model had a hole, the number of 
elements in a circle will define how many 
elements will surround that circle. In the 
image to the right, we have defined a 
minimum of 10 elements to surround the 
hole.

h
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Ratio The ratio defines the transition of the mesh from the 
Minimum element size to the Maximum element size.

The Ratio parameter specifies the ratio between element sizes in 
consecutive transitional element layers. 

The following shows the use of this option.

Tip In the majority of analyses with SOLIDWORKS Simulation, the 
default mesh settings produce a mesh that provides acceptable 
discretization errors while keeping solution times reasonably short.

Where to Find It  CommandManager: Simulation > Run This Study > 

Create Mesh
 Menu: Simulation, Mesh, Create
 Shortcut Menu: Right-click Mesh and click Create Mesh

29 Generate the mesh.

Click Create Mesh .

Ratio = 2.0

 a)

Maximum element
size = 1mm

Minimum element 

size = 0.1 mm

Ratio = 1.1

 b)

Maximum element
size = 1mm

Minimum element 
size = 0.1 mm
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30 Set the mesh properties.
Expand all the sections within the 
PropertyManager.

The slider in the Mesh Density section 
controls the Maximum element size and 
the Minimum element size. The slider 
always starts in the center by default, but 
the geometry determines the default 
element size values.

For this analysis, keep all default settings.

Mesh Quality Two element types exist in SOLIDWORKS Simulation; first-order 
(Draft) and second-order (High quality). Each body within an analysis 
is assigned an element type, with High quality being the default 
specification.

There are two ways to assign element types to bodies - through the 
Simulation tree, and the Mesh dialogue.

The Simulation tree provides insights into the element type assigned to 

bodies. A curvy edge tetrahedral  indicates High quality elements, 

while a straight edge tetrahedral  indicates Draft quality.

Where to Find It  Shortcut Menu: Right-click a body and click Apply Draft 

Quality Mesh  or Apply High Quality Mesh
 Within the Mesh command: Click the Mesh Quality tab
283



Lesson 7 SOLIDWORKS Education 2023
The Analysis Process
31 Set mesh quality.
Click the Mesh Quality tab.

The rectangular hollow plate body is specified 

as High Quality .

Click OK  to generate the mesh.

Icons in the SOLIDWORKS Simulation Study tree display a green 
checkmark to indicate a successfully created mesh.

Note We named this study default analysis with the intention of using the 
default mesh size. Later in this lesson, we solve the same model with a 
coarse and fine mesh.

Display/Hide Mesh The Create Mesh command automatically generates a Mesh Quality 
Plot, which displays the mesh on the screen. Hide or show this plot to 
toggle the mesh visibility.

Where to Find It  Shortcut Menu: Mesh, Mesh Quality Plot, Right-click Quality1 
and click Hide or Show
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Processing Once the preprocessing operations are complete, the study is ready to 
run. This stage is known as “processing.” In the processing stage, 
matrices are obtained from the preprocessing operations that describe 
the structure’s stiffness and loads. These matrices are then combined to 
obtain the response of the structure. The response of the structure is 
what is then analyzed in the postprocessing stage of the analysis.

Where to Find It  CommandManager: Simulation > Run This Study > 

Run This Study 
 Menu: Simulation, Run, Run
 Shortcut Menu: Right-click on 

the study name and click Run

32 Run the analysis.

Click Run .

You can monitor or pause the 
solution in the solver window 
while the analysis is running.

Postprocessing Once processing completes, SOLIDWORKS Simulation automatically 
creates a Results folder containing the Default Plots (as defined in the 
Default Options in step 20 on page 268) that you can view or modify. 
You can also create new Result Plots or list values, such as the force or 
pressure acting on a face.

Result Plots A Result Plot is a color-coded plot 
overlaid on top of the model's geometry, 
indicating its response to the applied load.

There are two ways to view an existing 
plot:

 Double-click the desired plot (Stress1, 
for example).

 Right-click the desired plot (Stress1, 
for example) and select Show.
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Stress Plots Analyze directional stress components and combined stress values 
(such as the von Mises stress) with Stress Plots.

Displacement Plots Analyze the directional components of displacement and total 
displacement with Displacement Plots.

Strain Plots Analyze strain to understand a structure's response to load with Strain 
Plots.

33 Show and edit Stress1.
Activate Stress1 under Results.

Observe the maximum value of Von Mises stress is 408 MPa, which 
significantly exceeds the yield stress of the material, 206 MPa, 
indicated by the red arrow in the chart.

Modifying Result 
Plots

All Result plots are customizable and share a common 
PropertyManager structure. The Definition, Chart Options and Settings 
provide options for controlling a plot's content, units, display and 
annotations.

 Definition
A plot's Definition controls its most significant attributes, including 
the plotted Component, Units and Deformation scale. For example, 
you can edit the Definition of a stress plot and change the 
Component to display principal stress instead of the von Mises 
stress.

 Chart Options
Chart Options control a plot’s annotations, colors, legend, and how 
the units display (scientific, floating, general).
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 Settings
The Settings control a plot’s style and allow you to add plot 
overlays.

Where to Find It  Shortcut Menu: Right-click a plot and select either 

Edit Definition , Chart Options  or Settings

Nodal vs. Element 
Stresses

Stress and strain plots allow you to toggle between node and element 
values when editing the Definition. The following figures show the 
nodal and elemental values of the von Mises stress in our model.

The stress plot that displays Nodal values appears “smooth,” while the 
stress plot that displays Element values appears “rough.”

To understand the reasons for these different appearances, we need to 
explain the differences between nodal and element stresses.

Node Values

Element Values
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During the solution process, in each element, stress results are 
calculated at certain locations called Gauss points. First order 
tetrahedral elements (draft quality) have one Gauss point in their 
volume. Second order tetrahedral elements have four Gauss points. 
First order shell elements have one Gauss point. Second order shell 
elements have three Gauss points.

Nodal Values Stresses in Gauss points can be extrapolated 
to element nodes. Most often, one node is 
shared by several elements, and each 
element reports different stresses at the 
shared node. Reported values from all 
adjacent elements are then averaged to 
obtain a single value. This method of stress 
averaging produces averaged (or nodal) 
stress results.

Element Values Alternately, the stress values from all Gauss points within each element 
can be averaged to report a single elemental stress. Although these 
stresses are averaged between Gauss points, they are called non-
averaged stresses (or element stresses) because the averaging is done 
internally within the same element only.

Element stresses and nodal stresses are always different, but too large a 
difference indicates that the mesh is not sufficiently refined in that 
location. See the exercise Exercise 30: Bracket on page 309 for the 
practical use of these quantities.

Show as Tensor 
Plot Option

Edit the Definition of a stress plot and click Show as tensor plot to 
visualize the directions and magnitudes of the principal stress 
components, P1, P2, and P3. Due to the differences in magnitudes 
between these stress values, one must zoom in considerably to see all 
three arrows.
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Average stresses 
at mid-nodes

This stress averaging method improves the calculation of stresses at 
mid-side nodes for High-quality tetrahedral elements with high aspect 
ratios.

34 Edit the Definition.

Right-click Stress1 and select Edit Definition .

Select Average stresses at mid-nodes under Advanced Options.

Click OK .

The stress values change slightly (3%).

Note A mesh may require further refinement to obtain accurate results if the 
option Average stresses at mid-nodes significantly alters observed 
stress values.

35 Modify the plot settings.

Right-click Stress1 and select Settings .

Under Boundary Options, select Mesh.
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Tip Use the Definition, Chart Options, and Settings tabs within the 
PropertyManager to save time modifying result plots.

36 Modify the chart options to highlight yield points.
Click the Chart Options tab.

Check Show min annotation and Show max annotation to display 
annotations pointing to the model’s highest and lowest stress points.

Clear Automatically defined maximum value and enter 206.8 MPa, 
which is the yield stress limit for AISI 304.

Click Specify color for values above maximum value. 

Click the Dropper . Specify a black color to represent stress values 
over 206.8 MPa.

Click OK .

Note Black regions indicate where stress exceeds the yield point.

37 Rename plot.
Rename the Result plot Stress1 to Yield.
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38 View displacement plot.
Activate Displacement1 under Results.

The plot shows a maximum resultant displacement of 0.1435 mm.

39 Animate displacement plot.
Right-click Displacement1 and 

select Animate .

In the Animation PropertyManager you can 
start and stop the animation, set the number of 
frames, control the speed, and save the 
animation as an *.avi file.

Explore the Animation command options.

Click OK .

40 Superimpose undeformed shape.

Access Settings  for Displacement1.

Select Superimpose model on the deformed 
shape. 

Use the Transparency slider and find a value 
that allows you to see the deformed and undeformed states.
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41 Display the true scale.
The plot visually exaggerates the shape by default because 
deformations are typically small in static studies.

Click the Definition tab.

Click True scale under Deformed shape.

Click OK .

Zoom in on the model to observe the displacement with an accurate 
perspective.

42 Plot strain results.
Activate Strain1 under Results.

Strain values are dimensionless and provide an intermediate step for 
validating results.

Note Strain results display with element values by default as opposed to 
stress results, which display with node values by default.
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Managing Result 
Plots

SOLIDWORKS Simulation allows you to add and delete Result plots. 
Create additional Stress, Strain, and Displacement Plots to highlight 
areas of interest.

Where to Find It:
Add Plots

 Shortcut Menu: Right-click the Results folder and select 

Define Stress Plot , Define Displacement Plot  or 

Define Strain Plot
 CommandManager: Simulation > Results Advisor > 

New Plot > Stress, Displacement or Strain

Where to Find It:
Delete Plots

 Right-click a Result plot and click Delete
 Select a plot and click the Delete key from the keyboard

Additional Plot 
Controls

There are several other plot types available to display analysis results.

Section Plot Use Section Plots to position one or more cutting planes through the 
model to examine interior results.

Where to Find It  Menu: Simulation, Result Tools, Section Clipping 
 Shortcut Menu: Right-click an existing plot and select 

Section Clipping

Iso Plots Use Iso Plots to show model regions above or below a specified result 
value.

Where to Find It  Menu: Simulation, Result Tools, Iso Clipping 
 Shortcut Menu: Right-click an existing plot and select Iso Clipping

Probe Use the Probe tool to select one or more points on a model to display 
result and location data.

Where to Find It  Menu: Simulation, Result Tools, Probe 
 Shortcut Menu: Right-click a plot and select Probe

43 New stress plot.
Let's define a new von Mises stress plot with default values to explore 
the additional plot tools.

Click Define Stress Plot .

Accept the default parameters and click OK .
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44 Create section plot.

Click Section Clipping .

From the SOLIDWORKS fly-out menu, select the Right plane as the 
Reference entity.

Drag the triad to move the cut plane through the model.

Use Reverse Clipping Direction  to control the cutting direction.

Explore options and parameters in the Section dialog.

Click Clipping On/Off  to disable the section plot.

Click OK  to close the Section dialog.

Important! If you click OK without disabling the section plot, it will remain 
displayed. To turn it off, reopen the Section Clipping command, 
toggle Clipping On/Off, and click OK.
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45 Create Iso plot.
Let’s define an Iso Plot to display portions of the model where the von 
Mises stress is between 170 MPa and 275 MPa.

Click Iso Clipping .

Enter 275 N/mm^2 [MPa] under Iso value.

Check Iso 2 and enter 170 N/mm^2 [MPa] for the second Iso value.

Experiment with Reverse Clipping Direction  under Iso 1 and 
Iso 2 to match the plot below.

The black arrows on the legend indicate the Iso values.

Click Clipping On/Off  to disable the plot.

Click OK  to close the Iso Clipping dialog.
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46 Probe stress results.

Click Probe .

Use the cursor to select plot locations, as shown in the image below. 
(Change the View Orientation as needed.)

The stress results display in a table under Results and annotations at 
selection points.

Use the Report Options tools to save Probe Results.

Select points
in  this  direction
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Click Plot .

The figure above shows a Von Mises stress path plot for the selected 
locations.

Click OK .

Other Plots There are several other postprocessing quantities available to view at 
the end of the analysis.

Factor of Safety Plot A Factor of Safety Plot shows the safety of a design based on the 
design strength of the material (typically the yield strength). 

Where to Find It  Shortcut Menu: Right-click the Results folder and select 

Define Factor of Safety Plot 
 CommandManager: Simulation > Results Advisor > 

New Plot > Factor of Safety

Fatigue Check Plot The Fatigue Check Plot serves as a quick indicator if the fatigue may be 
of any concern in the design of the component.

Where to Find It  Shortcut Menu: Right-click the Results folder and select 

Define Fatigue Check Plot 

Important! The fatigue check plot is only available if you have Simulation 
Professional.
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47 Plot Fatigue Check Plot.

Click Define Fatigue Check Plot .

Set the Loading type to On/Off Loading to 
indicate that the Tensile force may oscillate 
between 0 and 110,000 N.

Set the Surface Finish Factor to Machined. 
Keep the Loading Factor and Size Factor at 
their default values.

Under Material keep the Scale this value and 
Minimum safety factor fields at their default 
values of 1.

Click OK .

The areas in red indicate potential fatigue problems.

Note If fatigue appears to be a concern, a more precise fatigue analysis 
should be considered. Analyses such as these are often performed using 
the SOLIDWORKS Simulation Professional fatigue module.
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48 Define P1: 1st Principal Stress plot. 

Click Define Stress Plot .

Select P1: 1st Principal Stress as the stress 
component, keep all other default options, 

and click OK .

We observe that the maximum value of the 1st principal stress, 
416 MPa, is very close to the maximum value of the Von Mises stress, 
408 MPa. This is because the specified Tensile force is the only 
dominant load component resulting in predominantly tensile stress 
along the longitudinal direction of the plate.
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Multiple Studies We have completed the analysis mainly using default mesh settings and 
now wish to see how changing the mesh density affects the results. For 
this reason, we will repeat the analysis two more times using both 
coarser and finer density meshes.

To repeat the analysis with coarsened mesh, we can create a new mesh 
while still in the default analysis study, but this action would 
overwrite the old results.

To preserve the results of the current study, we will create a new study, 
coarse analysis. Creating a new study can be done in several ways.

Creating New 
Studies

New studies can be created in one of two ways:

 Create a new study from scratch.

 Copying an existing study: right-click the tab for the study you 
want to duplicate and click Copy Study.

When we copy a study, SOLIDWORKS Simulation displays the 
Copy Study window. This will allow us to name the duplicated study 
and choose the SOLIDWORKS configuration.

Copy Parameters When we create a new study, we can copy material, fixtures and 
external forces from existing studies rather than recreating them in the 
new study. To copy parameters, drag the parameter from the Simulation 
Study tree to the tab of the new study.

Note When a study is copied, the study settings, Fixtures, External Forces, 
Mesh, and the study results will be copied as well.

49 Copy the study.
Right-click the default analysis tab and click 
Copy Study.

Type coarse analysis for the study name. The 
model only has one configuration, so we cannot 
change it.

Click OK .
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50 Draft Quality Mesh.
Right-click the rectangular hollow plate body from the Simulation 

tree and click Apply Draft Quality Mesh . 

Note Warnings appear in the Simulation tree once you specify draft quality 
elements, indicating that the study is now out of date.

51 Create new mesh in coarse analysis study.

In the coarse analysis study, click Create Mesh . 

Move the Mesh Density slider all the way to 
the left. The Maximum element size should 
read 11.4491 mm [0.4508 in].

Click OK .

The generated mesh is displayed below.

Note The mesh is orange to indicate draft quality, and without the curvature 
created by mid-side nodes, the hole appears tessellated. Additionally, 
there is only one element across the thickness of the part; in the default 
analysis, there were two elements. Later, we will discuss why this sort 
of mesh is not acceptable for reliable analysis results.
301



Lesson 7 SOLIDWORKS Education 2023
The Analysis Process
52 Display mesh details.
Having created the mesh, we can 
access the detailed mesh 
information by right-clicking 

Mesh and selecting Details .

The same detailed information can 
of course be displayed for the 
“old” mesh in the default 
analysis study.

Many of the items in this list will 
be discussed in later lessons.

53 Run the analysis.

Click Run .

54 View displacement and stress results.
Record the maximum displacement from the Displacement1 plot 
(0.137 mm) and the maximum von Mises stress from the Stress2 plot 
(245 Mpa).

Note All plot settings remain the same as the default analysis study 
because the plot definitions are copied from that study.

55 Re-run the analysis with fine mesh.
Repeat step 49 to copy the default analysis study. Name the new 
study, fine analysis.

Ensure the mesh uses High Quality  elements.

Click Create Mesh . When re-generating the mesh, move the slider 
all the way to the right. The Maximum element size should read 
2.86227 mm [0.1127 in].

Click OK .

The fine mesh generated 
using the above settings is 
shown to the right.

Notice that we now have 
several elements in the 
through-thickness 
direction. You will later 
learn that this mesh is 
acceptable for reliable 
analysis results.

Click Run .
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56 View displacement and stress results.
Record the maximum displacement from the Displacement1 plot 
(0.144 mm) and the maximum von Mises stress from the Stress2 plot 
(416 Mpa).

Check 
Convergence and 
Accuracy

Now we must collect information from all of the studies (default, 
coarse and fine analysis) to compare the displacement and 
maximum von Mises stress results for the various mesh refinements. 
We can determine the maximum displacement and the maximum von 
Mises stress results in plots.

We must also determine the number of elements and the number of 
nodes in each mesh. These can be found in the Mesh Details window 
of each respective mesh.

Finally, we must determine the number of degrees of freedom (DOF) in 
each model. To calculate this number, we could count the number of 
unconstrained nodes by subtracting the number of nodes on the 
constrained face from the number nodes reported in mesh details. Then 
we could multiply this number by three because each node in a solid 
element mesh has 3 DOF. An easier method, however, is to right-click 
the Results folder in each study and select Solver Messages 
(see below).

57 View solver messages.
Right-click Results folder and select Solver Messages . Note the 
number of elements, nodes, and degrees of freedom.

Results Summary The summary of the results produced by the three studies is shown in 
the following table:

Mesh 
density

Max. 
displace-

ment
[mm]

Max. von 
Mises stress

[MPa]

Number 
of DOF

Number 
of 

elements

Number 
of nodes

coarse 
analysis

.1374 245.5 1,221 1,173 425

default 
analysis

.1435 408.5 44,037 8,677 14,844

fine 
analysis

.1435 415.7 310,977 68,511 104,248
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Note that all of the results of this table pertain to the same problem. The 
only difference is in the mesh density. You may find small differences 
between your own results and those presented in this table. This is due 
to service pack upgrades, etc. Having noted that the maximum 
displacement increases with mesh refinement, we can conclude that the 
model becomes less stiff (or softer) when the number of degrees of 
freedom increases. In our case, by selecting second order elements, we 
impose the assumption that the displacement field in each element is 
described by second order polynomial functions.

With mesh refinement, the displacement field in each element is still 
described by second order polynomial functions; however, the larger 
number of elements makes it possible to approximate the real 
displacement and stress fields more accurately. 

We can say that the artificial constraints resulting from element 
definition become less imposing with mesh refinement. Displacements 
are always the primary unknowns in FEA, and stresses are calculated 
based on displacement results. Therefore, stresses also increase with 
mesh refinement. If we continued with mesh refinement, we would see 
both displacement and stress results converge to a finite value. This 
limit is the solution of the mathematical model. Differences between 
the solution of the FEA model and the solution of the mathematical 
model are due to discretization error. Discretization error diminishes 
with mesh refinement.

The process of consecutive mesh refinements that we have completed 
is called the convergence process. Its objective is to determine the 
impact of our discretization choices (element size) on the data of 
interest, which, in this lesson, are the maximum resultant displacements 
and the maximum von Mises stress.
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Comparison with 
Analytical Results

An infinitely long rectangular hollow plate under a tensile load 
possesses an analytical solution [1]. We compare FEA results with 
analytical results.

W, D and T denote plate width (100 mm), hole diameter (40 mm) and 
plate thickness (10 mm). P is the tensile load 110,000 N or 24,729 lb. 
For comparison with analytical results, it is more convenient to use the 
SI system because the SOLIDWORKS model have been defined in 
mm.

n is the normal stress in the cross section where the hole is located, Kn 
is the stress concentration factor, and max is the maximum principal 
stress.

Review the P1: 1st principal stress plot for study default analysis. 
The maximum value reached 415.59 MPa, which corresponds to 
approximately 60.3 ksi.

Therefore, the difference is:

The difference of 1.40% between the SOLIDWORKS Simulation 
result and the analytical solution does not necessarily mean that the 
SOLIDWORKS Simulation result is worse and has a 1.40% error. 

We must be very careful in how we compare these results. Note that the 
analytical solution is valid only for a very thin plate where a plane 
stress condition is assumed. SOLIDWORKS Simulation calculates a 
solution for a 3D model with substantial thickness (10 mm) and 
accounts for realistic stress distribution across the plate thickness. 
SOLIDWORKS Simulation also takes into consideration the fact that 
the plate has a finite length (200 mm) rather that an infinite one, as the 
analytical solution does.

Furthermore, detailed inspection of the stress results show the stress 
gradient across the plate thickness, which is not accounted for in the 
analytical model. Thus, we can conclude that SOLIDWORKS 
Simulation provides more detailed stress information than the 
analytical solution.

n
P

W D– xT
---------------------------- 110000

100 40– x10
----------------------------------- 183.33MPa= = =

Kn 3 3.13
D
W
----- 
 – 3.66

D
W
----- 
  2

1.53
D
W
----- 
  3

–+ 2.23568= =

max Knxn 183.33 2.23568  409.87MPa= = =

difference
NumericalSolutions THEORY–

NumericalSolutions
-------------------------------------------------------------------------------------- 415.7 409.9–

415.7
--------------------------------- 1.4= = =
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Reports Results may need to be recorded in report form for review, presentation 
or archive purposes.

Reports can be published in Microsoft Word format. Different sections 
can be added to the report from a list of predefined commonly used 
topics. The default settings for the Reports can be found in the 
Simulation, Options menu.

Predefined sections include:

 Description  Assumptions
 Model Information  Study Properties
 Units  Material Properties
 Loads and Fixtures  Connector Definitions
 Contact Information  Mesh Information
 Sensor Details  Resultant Forces
 Beams  Study Results
 Conclusion  Appendix

To edit the content of a section, select the section in the Included 
sections and fill in the appropriate section properties.

Where to Find It  Menu: Simulation, Report 
 CommandManager: Simulation > Report 

58 Generate report in Microsoft Word format.

Ensure fine analysis is active and click Report .

The Report Options window opens.
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59 Add sections.
Under Report sections, ensure each selection is relevant to this 
analysis. (For example, you could deselect the option Contact 
Information, as we do not have any in this analysis.)

Enter your Header information and click Publish.

60 Examine the report.
Open the report in Microsoft Word and examine the results.

61 Save and Close the file.
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Summary We used a model of a hollow rectangular plate to introduce the 
SOLIDWORKS Simulation interface and set up a simulation from start 
to finish.

We created multiple studies to execute a linear static analysis with 
three different meshes. 

While preparing models for analysis and examining results obtained 
with different meshes, we introduced the concept of modeling error and 
discretization error. 

This first lesson was intended to provide an understanding of FEA 
methodology and the software skills necessary to complete the lessons 
that follow.

References 1. Young and Budynas, Roark’s Formulas for Stress and Strain, 7th 
Edition.

Questions  The preprocessing stage of the FEA includes the following steps:
1. _________________________________________________
2. _________________________________________________
3. _________________________________________________
4. _________________________________________________
5. _________________________________________________

 The density of finite element mesh (does / does not) have 
considerable impact on the analysis results.

 In general, we would favor (finer / coarser) meshes to obtain 
reliable analysis results. Therefore, the time required to solve the 
analysis will (increase / decrease), but this is an unavoidable 
consequence.

Ultimately, we will try to design optimum meshes providing 
reasonable accuracy levels and resulting in acceptable run times.

 The primary unknown in finite element analysis is (displacements / 
strains / stresses). This quantity is therefore the most accurate.

 The accuracy levels of (displacements / strains / stresses) and 
(displacements / strains / stresses) are approximately the same, but 
significantly worse than that of (displacements / strains / stresses). 
Therefore, to obtain good (displacement / strain / stress) results, the 
mesh must be reasonably fine.

 (Refining / Coarsening) the mesh results in solutions approaching 
the analytical solution of a mathematical model.
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Exercise 30:
Bracket

In this first exercise, you will analyze a simple part with an External 
Load and a single Fixture applied to two faces.

This exercise reinforces the following skills:

 SOLIDWORKS Simulation Options on page 266
 Fixtures on page 272
 External Loads on page 275
 Meshing on page 280
 Multiple Studies on page 300

Problem 
Statement

The aluminum part of an 
assembly will be analyzed for its 
maximum stresses and 
displacements. The part is bolted 
to the rest of the assembly 
through the two bolt holes, as 
indicated in the figure. The part 
is then subjected to a normal 
force of 500 N, applied to the counter bored face.

1 Open a part file.
Open Bracket.SLDPRT from the Lesson01\Exercises\Bracket 
folder.

2 New Default Plot.
Browse to the Default Options tab.

Right-click the Static Study Results folder and click Add New Plot.

Under Results type, specify Nodal Stress, and under Results 
component, specify P1: 1st Principal Stress.

Bolt holes
309



Exercise 30 SOLIDWORKS Education 2023
Bracket
3 Number format.
Click Color chart. 

Under Number format, specify 
Scientific and 2 decimal places.

4 Define a static study.
Create a new static study named stress analysis.

5 Apply material properties.

Click Apply/Edit Material .

Specify Aluminum 1060 Alloy from the SOLIDWORKS materials 
library.

Click Apply and Close.

6 Apply Fixtures.

Click Fixed Geometry .

Apply the fixture to the faces as shown in the figure below.

Click OK .

This Fixed Geometry fixture represents two bolts that mount the 
bracket to a larger assembly. In SOLIDWORKS Simulation, Fixtures, 
External Loads, and Connections represent geometry not explicitly 
modeled.

In later lessons, you will learn more accurate and elegant methods to 
simulate these conditions.
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7 Apply external load.

Click Force .

Select the inner face as 
indicated in the diagram and 
specify the direction of the 
load as Normal to the selected 
face with a Force Value of 
500 N.

Click OK .

8 Mesh.

Click Create Mesh .

Specify a Blended curvature-based mesh with default element sizes.

Click OK .

9 Run the study.
311



Exercise 30 SOLIDWORKS Education 2023
Bracket
10 Plot stress results.
We observe that the maximum von Mises stress in the model is 
approximately 37.7 MPa, which is above the yield strength of the 1060 
Aluminum Alloy (27.6 MPa).

11 Principal stress.
The distribution of the P1: 1st principal stress indicates a maximum 
value of approximately 45 MPa. This value corresponds to the 
maximum tensile stress in the part (maximum compressive stress 
where the value is negative).

12 Probe von Mises stress on the fillet.
Later in the course you will learn that the 
fixtures may result in stress intensifications 
which are not real. For this reason, we will 
focus our attention to the filleted region 
between the horizontal and vertical bosses on 
the part.

Click Stress1.

Click Probe .
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Select On selected entities, then pick the seven faces of the fillet 
between the two bosses.

Click Update.

Note the values in the Summary section.
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13 Plot displacement results.
We observe the maximum resultant displacement of approximately 
0.068 mm.

Coarse Mesh and 
Element Stress

Are the current results accurate enough? Visual inspection of our finite 
element mesh suggests that it may be rather coarse, especially in the 
regions where the fillets are present. Furthermore, inspection of the 
distribution of the elemental values of the von Mises stress indicates 
considerable stress jumps from element-to-element in the higher stress 
concentration areas.

We will repeat the analysis with a finer mesh.

14 Create new static study.
Copy the study stress analysis as a new study named 
stress analysis - refined.

The folders Fixtures, External Loads, Parts, Mesh, and Results are 
copied into the new study as well.
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15 Create fine mesh.
Slide the Mesh Density slider all the way to the right which will result 
in an Maximum element size of 2.198 mm and a 
Minimum element size of 0.733 mm.

The resulting mesh shows significantly improved mapping of the 
model geometry.

16 Run the study.

17 Plot stress results.
We now observe that the maximum von Mises stress increased to 
39.8 MPa, which is still above the material yield strength of the 27.6 
MPa. However, if we examine the plot, we will see that the maximum 
stress is at the sharp corner of the bolt holes. We will discuss this 
further in the next lesson.
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18 Probe stress on the fillet.
Using the identical procedure described in step 12, probe the stress 
results on the filleted geometries.

The maximum von Mises stress on the fillet increased from 28.8 MPa 
to 30.5 MPa. 

19 Plot displacement results.
The maximum resultant displacement increased, but only slightly.

20 Delete plot. 
The plot created in step 2 on page 309 
will be propagated to all future 
simulations unless it is deleted.

Click Options from the Simulation 
menu.

Right-click Plot4 and click Delete.

Click OK. 

21 Save and Close the file.
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Summary This exercise reinforced the processes required to set up a linear static 
study and post-process the results. Demonstrations showed how the 
size and the quality of the mesh affects result outputs, particularly 
stress results. While the deviation in the resultant displacements 
between the two studies was less than 1%, the deviation for maximum 
von Mises stresses was more significant, which is often the case. We 
attribute the high difference in maximum stress results to the following 
two phenomena:

 Displacements are the primary unknown in the finite element 
analysis and, as such, will always be significantly more accurate 
than strains and stresses. A relatively coarse mesh is sufficient for 
satisfactory displacement results, while significantly finer mesh is 
generally required for satisfactory stress results.

 The extreme values of the stresses occur in the vicinity of the 
fixture where the stresses often assume unrealistically high values. 
This is a subject studied in the next lesson. The stresses at the 
filleted regions reported in both studies were closer in their 
magnitudes with a negligible difference. Finer meshes are required 
in filleted regions as stress results are of importance to us.
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Exercise 31:
Compressive 
Spring Stiffness

In this exercise, you will determine the 
compressive stiffness of a coil spring.

This exercise reinforces the following skills:

 New Study on page 269
 Fixtures on page 272
 External Loads on page 275
 Meshing on page 280
 Result Plots on page 285

Problem 
Statement

Following Hooke’s law, a “spring constant” defines a spring’s stiffness 
by relating displacement to an applied load through the equation f= kx, 
where “f” is force, “x” is displacement, and “k” is the spring constant. 
Create a simulation to determine the spring constant for a model of a 
spring made from Alloy Steel.

1 Open a part file.
Open spring from the Lesson01\Exercises\Spring - 
Compressive Spring Stiffness folder.

Note For convenient application of fixtures and external loads, disks have 
been added to both ends of the spring. The distance between the disks 
corresponds to the active length of the uncompressed spring.

2 Set SOLIDWORKS Simulation options.
Set the system of Units to SI (MKS) and the units of Length and 
Stress to mm and N/m2 (Pa).

3 Static Study Results.
Ensure the Default Plots are set to create plots for Nodal von Mises 
Stress, Resultant Displacement, and Elemental Equivalent Strain.

4 Create study.
Create a Static study named spring stiffness.

5 Review material properties.
The material properties (Alloy Steel) are transferred from 
SOLIDWORKS.
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6 Apply Fixed restraint.
Apply a Fixed Geometry fixture to the end face of one disk (item 1 
from the image below).

7 Apply radial restraint.
Use an advanced fixture to apply a restraint in 
the radial direction to the cylindrical face of the 
other disk (item 2).

This restraint only allows the spring to be 
compressed (or expanded) in its axial direction 
and to rotate about the longitudinal axis.

8 Apply compressive force.
Apply a 0.1 N compressive force to the end face of the disk with the 
cylindrical face constrained in the radial direction.

9 Mesh the model and run the analysis.
Select Curvature based mesh under Mesh Parameters.

Specify a Maximum element size and Minimum element size of 
2.787 mm and 0.557 mm, respectively.

10 Run the study.

1

2
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11 Plot z displacements.
Displacement results indicate an axial displacement of 0.426 mm. The 
axial displacement is in the z direction. 

Coil Spring Axial 
Stiffness

The axial stiffness of the spring can be calculated from the equation 
k = f/x. Using this equation, we determine that the spring stiffness (k) 
for this example is .235 N/m (or 234.7 N/mm). 

Alternately, we could use an approximate formula for the stiffness of a 
helical spring (Mechanical Vibrations by S. S. Rao, 1995).

where:

 G is the material shear modulus
 d is the diameter of the wire
 D is the mean coil diameter 
 n is the number of active turns

Substituting our values (n = 8.75, d = 1 mm, D = 17 mm, and G = 
7.9e10 Pa) into the above formula gives an axial stiffness of 
approximately 230 N/mm. This result is very close to our actual result 
of 234.7 N/mm.

12 Save and Close the file.

KAxial
Gd

4

8nD
3

--------------=
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Exercise 32:
Container 
Handle

In this exercise, you will 
assess the safety of the waste 
container handle. 

This exercise reinforces the 
following skills:

 New Study on page 269
 Fixtures on page 272
 External Loads on 

page 275
 Meshing on page 280
 Result Plots on page 285

Problem 
Description

The handle attaches to a wench hook to lift the container. The entire 
container is manufactured from AISI 304 steel. The handle is welded 
(double-sided fillet weld) to the two square base plates located 
symmetrically on both sides. The diameter of the handle is 30mm; the 
thickness of the steel plates is 5mm. Apply the most suitable fixtures to 
simulate the connection between the handle and the steel plates.

Loading 
Conditions

In the most extreme loading situation, 
when the container is pulled onto the 
truck rails, the handle is loaded by a 
3000 N force inclined at 15 degrees. 
The force should be applied on the 
circular split face indicated in the figure above.

The geometry of the handle 
structure with the base plates is 
shown in the figure to the right.

Goal Decide whether the design of this handle is safe. Pay attention to the 
most appropriate representation of the fixture.

The part for this exercise is located in the 
Lesson01\Exercises\Container Handle folder.

Base plates

Handle
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Lesson 8
Introduction to

Motion Simulation
and Forces

Objectives Upon successful completion of this lesson, you will be able to:

 Use Assembly Motion to animate the motion of a car jack 
assembly.

 Use SOLIDWORKS Motion to simulate physical behavior of the 
car jack and determine the torque required to lift a vehicle.
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Basic Motion 
Analysis

In this lesson, we will perform a basic motion analysis using 
SOLIDWORKS Motion to simulate the weight of a vehicle on the jack 
and determine the torque required to lift it. Engineers can then use this 
information to choose the required electric motor to drive the car jack.

Case Study: Car 
Jack Analysis

A mechanical jack is a device that lifts heavy equipment. The most 
common form is a car jack, floor jack, or garage jack which lifts 
vehicles so that maintenance can be performed. Car jacks usually use 
mechanical advantage to allow a human to lift a vehicle. More 
powerful jacks use hydraulic power to provide more lift over greater 
distances. Mechanical jacks are usually rated for a maximum lifting 
capacity (e.g., 1.5 tons or 3 tons).

Because this is our first motion analysis, no contact is used and the 
tilting motion of the jack is prevented with the help of the mates.

Problem 
Description

The car jack will be driven at a rate of 100 RPM and will be loaded 
with a force of 8,900 N, representing the weight of a vehicle. 
Determine the torque and power required to lift the load through the 
range of motion of the jack.
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Stages in the 
Process

 Create a Motion Study.
This will be a new motion study.

 Add a rotary motor.
The rotary motor will drive the jack.

 Add gravity.
Normal gravity will be added so that the weight of the car jack 
components are considered in the calculations.

 Add the weight of the car.
The weight of the car will be added as a downward force on the 
Support.

 Calculate the motion.
The default analysis will run for five seconds but we will increase it 
to allow the jack to extend fully.

 Plot the results.
We will create various plots to show the torque and power required.

1 Ensure that 
SOLIDWORKS Motion is 
added in.
Under Tools, Add-ins, 
make sure SOLIDWORKS 
Motion is checked.

Click OK.

2 Open an assembly file.
Open Car_Jack from the 
Lesson01\Case Studies 
folder.
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3 Set the document units.
SOLIDWORKS Motion uses the document units set in the 
SOLIDWORKS document.

Click Tools, Options, Document Properties, Units.

Select MMGS (millimeter, gram, second) for the Unit system. This 
will set our length units to millimeters and force to Newtons.

Click OK.
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4 Change to the Motion Study.
Click on the Motion Study 1 tab that appears at the bottom left-hand 
corner of the window. If this tab is not visible, click View, 
User Interface, MotionManager.
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5 Activate the Motion Type of Study.
Select Motion Analysis from the list of available study types.

Note An Animation is used to create animations for illustration purposes. A 
Basic Motion analysis can be used to create animations where gravity, 
mass and collisions are applied to the parts in the model. Motion 
Analysis is a complete rigid body simulation environment used to 
obtain numerically accurate, physics based data and animations. 

Driving Motion Motion can be driven by gravity, springs, forces or motors. Each has 
different characteristics that can be controlled.

Introducing: Motors Motors can create either linear, rotary or path dependent motion or 
prevent motion. This motion can be defined in a number of different 
ways.

 Constant Speed
The motor will drive at a constant velocity.

 Distance
The motor will move for a fixed distance or degrees.

 Oscillating
Oscillating motion is a back and forth motion at a specific distance 
at a specified frequency.

 Segments
Motion profile is constructed from segments of the most commonly 
used functions such as linear, polynomial, half-sine and others.

 Data Points
Interpolated motion is driven by a tabular set of values.

 Expression
The motor can be driven by a function created from existing 
variables and constants.

 Servo Motor
The motor used to implement control actions for the event-based 
triggered motion.

Where to Find It  MotionManager toolbar: Click Motor 
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6 Create a Motor that drives the Screw_rod at 100 RPM.

Click Motor .

Under Motor Type, select Rotary Motor.

Under Component Direction, select the cylindrical face of the 
Screw_rod part as shown in the figure. The Motion Direction field 
will automatically populate the same face to specify the direction.

Use the Reverse Direction button to orient the motor (see the figure).

Leave the Component to Move Relative to field empty. This ensures 
that the motor direction is specified with respect to the global 
coordinate system.

Under Motion, select the Constant speed and enter a value of 
100 RPM.

Important! Make sure that the motor is oriented as shown in the figure.
329



Lesson 8 SOLIDWORKS Education 2023
Introduction to Motion Simulation and Forces
Click the graph to enlarge in the PropertyManager to view the enlarged 
plot.

Close the graph plot.

Click OK .

Gravity Gravity is an important quantity when the weight of a part has an 
influence on its simulated motion, such as a body in free fall. In 
SOLIDWORKS Motion, gravity consists of two components:

 Direction of the gravitational vector
 Magnitude of the gravitational acceleration

The Gravity Properties allows you to specify the direction and 
magnitude of the gravitational vector. You can specify the gravitational 
vector by selecting the X, Y and Z direction or by specifying a 
reference plane. The magnitude must be entered separately. The default 
value for the gravitational vector is Y and the magnitude is 

9806.55 mm/sec2 or the equivalent in the currently active units.

Where to Find It  MotionManager toolbar: Click Gravity 

7 Apply Gravity to the assembly.

Click Gravity .

For Gravity Parameters, Direction Reference, 
select the Y direction.

Under Numeric gravity value, type in a value of 
9806.65 mm/sec^2.

Click OK .
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Forces Force entities (including both forces and moments) are used to effect 
the dynamic behavior of parts and sub-assemblies of a motion model 
and are usually a representation of some external effect acting on the 
analyzed assembly.

Forces may resist or induce motion, and are defined using similar 
functions that are used to define motors (constant, step, function, 
expression or interpolated).

Forces in SOLIDWORKS Motion can be divided into two basic 
groups:

 Action Forces
A single applied force or moment 
representing the effect of the external 
objects and loadings on the part or sub-
assembly. The weight of the vehicle 
applied on the car jack or an 
aerodynamic force on the car body are examples of action forces.

 Action and Reaction Forces
A pair of forces or moments, both action and corresponding 
reaction, are applied on the parts or sub-assemblies.

A spring force could be understood as action and reaction force 
because both the forces on both end of the spring are on the same 
line of action. Another example would be a person pushing with 
his/her arms on the two opposing parts of an assembly. Such a 
person can then be represented in the motion analysis by a pair of 
two opposing forces of equal magnitude on the same line of action, 
i.e. action and reaction forces.

Understanding 
Forces

A force can define load or compliance on a part. SOLIDWORKS 
Motion provides the following type of forces:

Applied Forces Applied forces are forces that define loads at specific locations on a 
part. You must provide your own description of the force behavior by 
specifying a constant force value or a function expression. The applied 
forces available in SOLIDWORKS Motion are the applied force, 
applied torque, action/reaction force and action/reaction torque.

The orientation of action-only forces can be fixed or relative to the 
orientation of any part in the mechanism.

Applied forces are used to model inputs such as actuators, rockets, 
aerodynamic loads and many more.

Force Definition To define a force the following information must be specified:

 Part or parts on which the force acts
 Point of the force application
 Magnitude and direction of the force

Where to Find It  MotionManager toolbar: Click Force  
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Force Direction The force direction is based on the reference part 
you select in the Force Direction box. An 
illustration below gives you the three cases on how 
the force direction changes based on the selected 
reference parts.

Case 1 Direction of force is based on a fixed component.

If a fixed component is selected in the Force Direction box then the 
direction of the force will remain constant throughout the simulation.

Case 2 Direction of force is based on the selected moving component, 
which is also the component on which you want to apply the 
force. 

If the part to which the force is applied is used as the reference datum, 
then the force will remain locked in its relative orientation to the body 
over the entire simulation time (i.e. it will stay in alignment with the 
geometry on the body used to define the direction).

F1

Reference Fixed Component

F1
F1

F1

Reference Rotating Component

F1

F1

Fixed Component
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Case 3 Direction of force is based on the selected moving component 
which is different from the component on which you want to 
apply the force.

If another moving part is used as the reference datum, the direction of 
the force will change based on the relative orientation of the reference 
body to the moving body. This is hard to visualize easily, but if you 
apply the force on a body that is held locked in position, and use a 
rotating part as the reference datum, you should see the force rotate in 
concert with the reference body.

Note Make sure that the gravity symbol shows the orientation in the 
negative Y direction.

8 Create a force of 8900 N to simulate the weight of the car on the 
car jack.

Click Force .

For Type, select Force.

Under Direction, select Action Only.

Under Action Part and Point of Application of Action, select the 
circular edge on component Support-1 (see image below).

For Force Direction, select the vertical edge on the Base-1 
component.

Note The default force direction is defined by the circular edge selected in 
the Action Part and Point of Application of Action field, i.e. 
perpendicular to the plane of the edge. Because the default direction is 
correct in this case, the edge selected in the Force Direction field is not 
required and is done solely for the educational purpose.

F1

Reference Rotating Component

F1
F1
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Under Force Function, select Constant. Enter a force value of 
8900 N.

Note Make sure that the force is directed downwards.

Click OK .

9 Run the Simulation. 

Click Calculate . The simulation will calculate for 5 seconds.

10 Run the Simulation again for 8 seconds.
Drag the end time key to 8 seconds on the timeline.

Click Calculate .
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Results The primary output from a motion study is a plot of one parameter 
versus another, usually time. 

Once the motion is calculated plots can be created for a variety of 
parameters. All existing plots will be listed at the bottom of the 
MotionManager tree.

Plot Categories Plots of the following categories can be created:

 Displacement  Velocity
 Acceleration  Forces
 Momentum  Energy
 Power  Other quantities

Sub-Categories Within each of the categories, plots can be created for:

 Trace Path  XYZ Position
 Linear Displacement  Linear Velocity
 Linear Acceleration  Angular Displacement
 Angular Velocity  Angular Acceleration
 Applied Force  Applied Torque
 Reaction Force  Reaction Moment
 Friction Force  Friction Moment
 Contact Force  Translational Momentum
 Angular Momentum  Translational Kinetic Energy
 Angular Kinetic Energy   Total Kinetic Energy
 Potential Energy Delta  Power Consumption
 Pitch  Yaw
 Roll  Rodriguez Parameters
 Bryant Angles  Projection Angles

Resizing Plots Plots can be resized by dragging any border or corner.

Where to Find It  MotionManager toolbar: Click Results and Plots 
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11 Plot the torque required to lift the weight of the car.

Click Results and Plots .

Under Result, select the category as Forces.

Under Sub-category, select Motor Torque.

Under Result component, select Magnitude.

Under Select rotational motor object to create result, select the 
motor that we created (see image below).

Click OK .

The plot of torque required appears in the graphics area.

The required torque is about 7244 N-mm.
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Note Once the Rotary Motor1 is selected, a triad is displayed in the 
graphics area. This triad indicates the local X, Y and Z axes of the 
motor in which the output quantities may be displayed. In the present 
case we require the plot of the magnitude which is independent of the 
coordinate system. The post-processing is described in greater detail in 
the next lesson.

12 Plot the power consumed to lift a weight of 
8900 N. 
We will add this plot into an existing graph. 

Click Results and Plots .

Under Result, select the category as 
Momentum/Energy/Power.

Under Sub-category, select Power 
Consumption.

Under Select motor object to create result, 
select the same motor that you selected in the 
previous step.

Under Plot Results, select Add to existing 
plot and select Plot1 from the pull down 
menu.

Click OK .

The power consumption is 76 Watts. Based on the torque and the 
power information, we can select an electric motor and use it to drive 
the Screw_rod instead of a human hand.
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13 Play animation.

Click Play .

The vertical time bar in both the MotionManager and the graph 
indicates the time.

Click Stop .

14 Plot the vertical position of the Support.

Click Results and Plots .

Under Result, select the category as Displacement/Velocity/
Acceleration.

Under Sub-category, select Linear Displacement.

For Result Component, select Y-component.

For Select two points/faces, select the top face of the support. If no 
second item is selected, the ground serves as the default second 
component, or the reference.

Leave the Component to define XYZ directions field empty. This 
indicates that the displacement is reported in the default global 
coordinate system.

Note The displacement is measured at the origin of the Support part file, 
indicated as the small blue sphere in the above figure, with respect to 
the origin of the Car_Jack assembly file. The result is reported in the 
default global coordinate system.
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Click OK .

The above graph indicates change of the global Y coordinate of the 
origin of the Support part file. The displacement is therefore 51mm 
(212-161mm) in the positive global Y axis.

15 Modify the graph.
Modify the ordinate of the graph to show the 
angular displacement of the motor.

In the MotionManager tree, expand the 
Results folder. Right-click Plot2 and click 
Edit Feature.

Under Plot Results, select New Result.

For Define new result, select Displacement/
Velocity/Acceleration.

Select Angular Displacement under sub-
category.

Select Magnitude for result component.

Select RotaryMotor1 for the simulation 
element.

Click OK .
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16 Examine the graph.
The result plot is a little coarse and the data ordinate does not cover the 
full range of -180 to 180 degrees. To generate a graph with finer detail, 
more data must be saved to disk.

Introducing: Study 
Properties

SOLIDWORKS Motion has its own set of properties to control the way 
the study is calculated and displayed.

Study properties will be discussed throughout the book.

Where to Find It  MotionManager toolbar: Click Motion Study Properties 

Introducing: Frames 
per Second

Frames per second controls how often the data is saved on the disk. The 
higher the frames per second, the more dense the data recorded.

Where to Find It  In the Motion Study Properties, expand Motion Analysis and either 
type the number, use the spinbox arrows or adjust the slider

17 Modify Motion Study properties.

Click Motion Study Properties .

Change the Frames per second to 100.

Click OK .
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18 Calculate the study.

Click Calculate .

Notice that we have more detail and the angular displacement is nearly 
from -180 to 180 degrees.

19 Save and close the file.
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Exercise 33:
3D Fourbar 
Linkage

This assembly is a simple mechanism called 3D Fourbar linkage. 
There are only four parts in the mechanism. The Support part is 
grounded, and the rotation of the Lever part will cause a sliding motion 
of the SliderBlock part. 

This exercise reinforces the following skills:

 Basic Motion Analysis on page 324
 Results on page 335

Project 
Description

The LeverArm will be simply rotated with a constant 360 deg/sec 
angular velocity. Determine the amount of torque required to drive this 
mechanism and plot it from the motion simulation.

1 Open an assembly file.
Open 3D Fourbar linkage from the Lesson01\Exercises folder.

2 Verify fixed and moving 
components.
Make sure that support is fixed 
while the other components can 
move.

3 Motion study.
In the MotionManager, select Motion Analysis.

The default Motion Study 1 will be used for the analysis.

4 Add gravity.
Apply gravity in the negative Z direction.

LeverArm

linkage

SliderBlock

Support
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5 Define motion of the Lever Arm.
Define a Rotary Motor at 360 deg/sec.

Tip You can enter 360 deg/sec directly into the PropertyManager and it will 
automatically be converted to RPM.

6 Motion study properties.
Set the Frames per second to 100. 

Set the time key to 4 seconds.

7 Calculate the simulation.

8 Determine the torque and power required to drive the mechanism.
Define a graph showing Motor torque and the required power as a 
function of time. Define both quantities in a single graph.
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9 Linear velocity of the SliderBlock.
Plot a graph showing the linear velocity in the Y direction of the 
SliderBlock as a function of time.

10 Modify the graph.
Modify the ordinate of the graph to show the angular displacement of 
the Rotary Motor. This way the graph will show the variation of the 
SliderBlock velocity relative to the angular displacement of the 
LeverArm.

11 Save and close the file.
344



Lesson 9
Creating a SOLIDWORKS

Flow Simulation Project

Objectives Upon successful completion of this lesson, you will be able to:

 Understand the model preparations required for a Flow Simulation 
Project.

 Create simple lids.

 Check the geometry for invalid contacts.

 Calculate the internal volume.

 Create a SOLIDWORKS Flow Simulation Project using the Project 
Wizard.

 Apply flow boundary conditions.

 Apply Goals.

 Run an analysis.

 Use the Solver Monitor window.

 View the results.
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Case Study: 
Manifold 
Assembly

In this lesson, we will learn how to set up a SOLIDWORKS Flow 
Simulation project using the Wizard. Prior to setting up our project, we 
will learn how to properly prepare our model for the analysis. We will 
run the simulation and learn how to interpret the results. In addition, we 
will see the many options available when post-processing the results.

Problem 
Description

Air enters an intake manifold 
assembly at 0.05 m3/s and flows out 
through the six openings as seen in 
the figure. The common goal of 
intake manifold design is even 
distribution of the combustion 
mixture to the piston heads. This will 
insure optimum engine efficiency. 
We will keep this in mind when 
analyzing our intake assembly.

The objective of this lesson is to 
introduce the complete set up of a 
SOLIDWORKS Flow Simulation project within SOLIDWORKS, from 
model preparation to post-processing. Study goals will be defined and 
discussed. In addition, the results will be post-processed using the 
various options in SOLIDWORKS Flow Simulation.

Stages in the 
Process

 Prepare model for analysis.
Use the Lids tool to close the model in preparation for an internal 
analysis. The Check Geometry command will be used to make 
sure that your model is ready for a flow simulation.

 Set up flow simulation.
Use the Wizard to set up the flow simulation project.

 Apply boundary conditions.
Boundary conditions are applied to inlets and outlets.

 Declare calculation goals.
Goals can be defined that are special parameters that the user will 
have information for after the analysis is run.

 Run the analysis.

 Post-process the results.
The results can be processed using many available options in 
SOLIDWORKS Flow Simulation.
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1 Open SOLIDWORKS.

2 SOLIDWORKS Flow Simulation Add-Ins.
Once installed, SOLIDWORKS Flow Simulation can be activated on 
SOLIDWORKS Add-Ins tab of the CommandManager.

Note Alternatively, add-ins can be activated using the Tools, Add-Ins menu.

3 Open Assembly.
Open Coletor from the Lesson01\Case Study folder.

Model 
Preparation

In any static analysis, it is often necessary to modify the 
SOLIDWORKS geometry to allow the simulation to run. The same is 
true in flow simulations. SOLIDWORKS Flow Simulation groups flow 
analysis into two separate categories, internal analysis and external 
analysis. Before beginning model preparations, it is necessary to ask 
yourself which type of analysis you wish to perform.

Internal Flow 
Analysis

Internal flow analysis involves fluid flow bounded by outer solid 
surfaces, e.g. flows inside pipes, tanks, HVAC systems, etc. Internal 
flows are confined inside the SOLIDWORKS geometry. For internal 
flows the fluid enters a model through the inlets and exits the model 
through the outlets with the exception of some natural convection 
problems that have no openings.

To perform an Internal flow analysis, the SOLIDWORKS model must 
be fully closed (no openings) using lids. The SOLIDWORKS Flow 
Simulation, Tools, Check Geometry command tool can be used to 
ensure that the model is fully closed.

External Flow 
Analysis

External flow analysis involves a solid model which is fully surrounded 
by the flow, e.g., flows over aircraft, automobiles, buildings, etc. The 
fluid flow is not bounded by an outer solid surface, but bounded only 
by the Computational Domain boundaries and does not require a lid 
unless the application involves a flow source (such as a fan). 

If both internal and external analysis is required simultaneously, e.g., 
flows over and through a building, the analysis is treated as an External 
analysis in SOLIDWORKS Flow Simulation.
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Manifold Analysis Now that we know the difference between internal and external 
analysis, we can characterize our manifold analysis as internal. We will 
only study the flow on the inside of the manifold assembly and are not 
concerned with any flows around the body. As mentioned previously, to 
perform an internal flow analysis, the SOLIDWORKS model must be 
fully closed using Lids.

Lids Lids are used in internal flow analysis. In this type of analysis, all 
openings within a model must be covered using the SOLIDWORKS 
“lids” features. The surfaces of the lids (which contact the fluid) are 
used to apply boundary conditions which introduce a mass flow rate, 
volume flow rate, static /total pressure, of Fan condition within a fluid 
volume.

Note Situations that do not require the use of lids include external analysis 
that measure flow over bodies such as: cars, planes, buildings, ...etc. In 
addition, lids are not used in natural convection problems.

Introducing: Create 
Lids

The Create Lids tool automatically creates lids for all openings in the 
selected planar surface of the model. This tool is available for both part 
and assembly files. The lids are necessary for an internal analysis 
(problems such as flow through a ball valve or pipe).

Where to Find It  CommandManager: Flow Simulation > Create Lids 
 Menu: Tools, Flow Simulation, Tools, Create Lids
 Flow Simulation Main toolbar: Create Lids 

4 Create a lid on the inlet face.
Under Tools, Flow Simulation, Tools, select Create Lids .

Select the annular face defining the plane of the inlet that should be 
closed by the lid.

In the Create Lids PropertyManager, click Adjust Thickness  and 
enter 1 mm as the Thickness.

Click OK.
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You’ll notice that a new part called LID1 gets created in the 
FeatureManager design tree. The part is a blind extrusion from the 
selected planar face into the opening with a distance that was specified 
as the Thickness.

Note Multiple planar faces can be selected using the Create Lids tool. If the 
user is working with an assembly, new parts named LID1, LID2... will 
be created. If the user is working with a single part, new LID1, 
LID2...features will be created.

Tip It is good practice to rename your lids when working in an assembly. 
This can avoid problems with multiple assemblies with lids open at the 
same time.

Lid Thickness If necessary, the thickness of the lid can be adjusted by clicking the 
Adjust Thickness button  and input the value in the Thickness box 
(as done in the previous step).

The thickness of an external lid for an internal analysis is usually not 
important for the analysis. However, the lid should not be so thick that 
the flow pattern is affected downstream in some way. If this is both an 
external and internal analysis then creating a lid that is too thin will 
cause the number of cells to be very high. For most cases the lid 
thickness could be the same thickness used to create the neighboring 
walls.

Manual Lid 
Creation

The Create Lids tool cannot be used if there are no planar faces to use 
as references. In this instance, the user must create the lids manually by 
creating lid parts or features.

Adding a Lid to a 
Part File

 Click on the surface adjacent to where you would like to add the lid 
and open a sketch.

 Select the inside edge(s) and select Sketch Tools, 
Convert Entities.

 Insert, Boss/Base, Extrude and select the Mid Plane option.
349



Lesson 9 SOLIDWORKS Education 2023
Creating a SOLIDWORKS Flow Simulation Project
Note Selecting the Mid Plane option is very important. The Blind option 
would create an invalid contact (disjointed body) between the lid and 
the body. SOLIDWORKS Flow Simulation is unable to apply 
boundary conditions onto a surface when there is an invalid contact.

Adding a Lid to an 
Assembly File

There are several ways to create lids within a SOLIDWORKS 
assembly file. The following steps outline one of these recommended 
ways.

 Within the SOLIDWORKS assembly mode go to Insert, 
Component, New Part.

 Select the surface adjacent to where you would like to add the lid.
 Select the inside edge(s) and select Sketch Tools, 

Convert Entities.
 Insert, Boss/Base, Extrude and select the Mid Plane option.
 Click OK to close the part edit mode. A new Part will be added to 

the assembly.

Note It's usually a good idea to create the lids as a part file within an 
assembly especially if your analysis involves heat transfer. These lids 
can then be assigned a different material, such as an insulator so that 
the lid does not affect the heat transfer analysis.

Correct Lid Creation In-correct Lid Creation

Mid-Plane extrusion Blind extrusion
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5 Remaining lids.
Create the remaining lids on the outlet faces using the manual lid 
creation method described above. Use a Mid Plane extrusion of 2 mm.

Note We could have used the Create Lids tool to create the remaining lids, 
however the tool would have closed all of the openings on the selected 
face, therefore closing the bolt holes. This is not necessary, and this 
also gives us the opportunity to practice manual lid creation.

Discussion When creating lids before the analysis, keep in mind that they have two 
purposes; closing off any openings and allowing for solid geometry on 
which boundary conditions (i.e. static pressure, mass flow rate, etc.) are 
defined. In this model, we could have used a single part to close off all 
six outlet ports as shown in the figure. This type of lid would not be 
applicable if we required different boundary conditions on each outlet. 
In addition, this lid is inappropriate because to evaluate the design, we 
require information about the flow through each individual outlet 
(remember, a well designed manifold will distribute the combustion 
mixture evenly). We will see that this type of lid will make it more 
difficult to obtain the information about each port.
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Checking the 
Geometry

The SOLIDWORKS model must be checked to determine if there are 
any problems with the geometry that may cause problems meshing the 
body and fluid regions.

There are two main reasons that prevent meshing of the solid and fluid 
bodies.

 Openings in the geometry that prevent SOLIDWORKS from fully 
defining a fully closed internal volume. This is for an internal 
analysis only.

 Invalid contacts exist between parts in an assembly. (An invalid 
contact is defined as a line or point contact between part files.) 
These will be discussed later in the lesson.

Note Invalid contacts affect both internal and external analysis.

Introducing: Check 
Geometry

A SOLIDWORKS Flow Simulation tool 
called Check Geometry allows users to 
check the SOLIDWORKS geometry. This 
tool also allows you to check bodies for 
possible geometry problems (e.g., tangent 
contact) that cause SOLIDWORKS Flow 
Simulation to create an inadequate mesh.

The State field allows you to disable some of 
the assembly components from the geometry 
check.

Create solid body assembly and 
Create fluid body assembly options are 
used to create part files of solid and fluid 
regions respectively. These part files help 
verify that the software has created the 
correct fluid and solid regions. 

The Check Geometry tools allow you to 
create a solid and fluid body when Improved 
geometry handling mode is activated.

Provided the fluid volume exists, Show Fluid 
Volume command will graphically indicate it.

The Check command will run the geometry check on the assembly.

Where to Find It  CommandManager: Flow Simulation > Check Geometry
 Menu: Tools, Flow Simulation, Tools, Check Geometry
 Flow Simulation Main toolbar: Check Geometry
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6 Check for invalid fluid geometry.
Access Check Geometry tool.

Keep all assembly components selected.

Under Analysis Type, select Internal.

Click Check.

The results are presented in the text field below 
the graphics area.

The non-zero values for the fluid and solid 
volumes indicate that the internal fluid volume is 
water tight and suitable for flow simulation.

Close the text area with the results, and the Check Geometry 
PropertyManager.

Note The Check Geometry command will check for possible invalid 
contacts, e.g., tangency, zero thickness, etc. If a problem has been 
detected, the message appears in the Invalid contacts output box.

Tip When the geometry is deemed ready for analysis, it is good practice to 
set all components as fixed. This insures that none of the components 
move when defining boundary conditions, etc.

Internal Fluid 
Volume

SOLIDWORKS Flow Simulation will also calculate the total volume 
of solid components and the total fluid volume.

For internal flow analysis, the internal fluid volume must be greater 
than zero. If there are no invalid contacts and the internal fluid volume 
is still zero, then there is a small gap or an opening that connects the 
internal domain to the external space. Once the small gap or opening is 
detected and corrected, rerun the Check Geometry tool to ensure that 
the internal fluid volume is greater than zero.

Invalid Contacts If invalid contacts exist, SOLIDWORKS Flow Simulation will not be 
able to calculate an internal fluid volume (within the computational 
domain), and the Check Geometry tool will report the internal fluid 
volume to be zero even if the model is perfectly closed and has no 
openings or gaps. Invalid contacts must be fixed before a flow analysis 
can be performed. 

The invalid contacts can be fixed by either separating the two parts 
with a very small distance so that they are no longer touching, or by 
creating an interference fit between the two parts.
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Invalid Contact 
Examples

Some typical types of invalid contact are 
shown in the figure.

In our example, if a Blind extrusion was 
used, an invalid line contact would be 
created as shown in the figure.

If an invalid contact is detected, you may 
click the contact in the list of invalid 
contacts to show the location.

Note Not every tangent contact causes an invalid contact. SOLIDWORKS 
Flow Simulation uses SOLIDWORKS API boolean operations to 
compute fluid and solid bodies. If SOLIDWORKS is able to construct 
the resulting bodies successfully, then SOLIDWORKS Flow 
Simulation will consider the bodies as valid for its analysis even with 
potentially bad contacts, like “line contact.”

In some models, even with invalid contacts the user will be able to 
apply boundary conditions and solve the analysis. Users in these cases 
may receive the Failed to complete error message when trying to 
define Cut Plots. The user would have to correct the invalid contact to 
plot and rerun the analysis before defining Cut Plot images.

Important! For internal flow analysis, boundary conditions can not be applied until 
all openings are closed.
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7 Modify lid position.
To demonstrate lid positions that 
are not ideal, you will now 
change the position of the last lid.

Edit the position of the last lid so 
that its internal edge forms a line 
contact along the edge of the 
outlet.

8 Check Geometry.
Follow step 6 on page 353 to check geometry for invalid contacts. 
Make sure you specify Internal analysis type.

The result text window indicates 16 detected unresolved contacts, 
which were fixed.

Because the invalid contacts were fixed, the Check Geometry tool was 
also able to calculate both the fluid and solid volumes.

Note In most of such situations, software is able to heal invalid contact and 
calculate the fluid and solid volumes.

Click on any of the invalid contacts to see it in the graphics area.

Close the text area with the results, and the Check Geometry 
PropertyManager.

Edge contact
355



Lesson 9 SOLIDWORKS Education 2023
Creating a SOLIDWORKS Flow Simulation Project
9 Modify lid position again.
Follow step 7 and change the 
position of the lid to form a clear 
gap between the lid and the outlet.

10 Check Geometry.
Follow step 8 to check the geometry for invalid contacts. Make sure 
you specify Internal analysis type.

The result text window indicates that the geometry 
check failed. Both the solid and fluid volumes 
show zero volumes indicating that they could not 
be calculated.

Introducing: Leak 
Tracker

Leaks in geometry are sometimes difficult to detect. Leak tracker tool 
makes this task easy.

Where to Find It  Menu: Tools, Flow Simulation, Tools, Leak Tracking
 Flow Simulation Main toolbar: Leak Tracking

11 Leak tracker.
Go to Tools, Flow Simulation, Tools 
and select Leak Tracking .

Select one face on the inside of the 
manifold, and one face on the outside of 
it.

Click Find Connection.

Gap (leak)

Inside face

Outside
face
356



SOLIDWORKS Education 2023 Lesson 9
Creating a SOLIDWORKS Flow Simulation Project
The trajectory from the inside face 
to the outside face will be 
graphically shown on the model.

12 Close Leak Tracer.

13 Modify lid position.
Return the lid to its correct 
position where it forms the 
face to face contact with the 
outlet.

Note You may run the Check Geometry command for the last time to verify 
that your geometry is water tight.

Face to face contact
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Project Wizard Project wizard is the most convenient way to create and specify the 
basic configuration of your simulation project.

Introducing: Wizard The flow simulation project Wizard is used by even the most 
experienced users of SOLIDWORKS Flow Simulation. It walks you 
through the basic steps of setting up a flow analysis. Additional 
commands may then be needed to complete the definition of more 
complicated analyses. The Wizard addresses the following parts of 
modeling:

 Project Configuration
Select the configuration that you want to use with the simulation. 
You can create a new configuration or use one that is currently 
defined. It is recommended that you associate each flow simulation 
project to a new configuration. This insures that your files and 
results will be organized.

 Unit System
Defines the unit system that will be used in the simulation. This can 
be changed after finishing the Wizard in the Flow Simulation 
menu by selecting Units. In addition, each custom defined unit 
systems can be created that mix and match from the different 
universal systems. 

 Analysis type
The analysis is defined as internal or external. In addition other 
features about the analysis can be defined (i.e., reference axis).

 Default Fluid
Defines the default fluid that is used in the analysis as well as the 
type of flow it will encounter (i.e., laminar, turbulent, both).

 Wall Conditions
Defines the boundary conditions for the flow at the walls of the 
SOLIDWORKS geometry.

 Initial Conditions
Defines the initial and ambient conditions of the solids and fluids in 
the model.

 Results and Geometry Resolution
Can define the density of the mesh based on the geometrical 
features of the model (thickness of thin wall and gaps) as well as 
the overall result accuracy.

Where to Find It  CommandManager: Flow Simulation > Wizard 
 Menu: Tools, Flow Simulation, Project, Wizard

 Flow Simulation Main toolbar: Wizard 
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14 Create a project using a wizard.
From the Tools, Flow Simulation menu, choose: Project, Wizard .

15 Create a new project.
Under Configuration, click Use Current (default setting). 

Note You can also select Create New to create a new configuration, or 
Select to associate your project with any of the existing 
SOLIDWORKS configurations.

In the Configuration Name box, enter Project 1.

SOLIDWORKS Flow Simulation will store all data in a separate folder 
numbered sequentially, i.e. “1”, “2”, “3”,...etc. based on how many 
projects have been defined. This folder is located in the same directory 
as the assembly file.

Click Next.
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16 Select units.

Select SI (m-kg-s) as the Unit System for this project.

You can change the unit system anytime by going to Tools, 
Flow Simulation, Units.

Click Next.

Note You can also create your own system of units (by mixing and matching 
unit systems). This is done by checking the Create New check box and 
entering the custom name for the new unit system.

17 Select analysis type.
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Select Internal under Analysis Type.

Under Consider closed cavities, clear Exclude cavities without 
flow conditions.

Accept all other default settings.

Click Next.

Dependency Dependency can be used to define the dependency of a specific 
quantity (i.e., radiation).

Exclude Cavities 
Without Flow 
Conditions

The status of the Exclude cavities without flow conditions option is 
not important in this analysis; there is only one internal space within 
this model. If there were multiple unconnected internal spaces, then 
selecting this box would prevent SOLIDWORKS Flow Simulation 
from meshing and solving for any internal spaces that do not have 
boundary conditions.

18 Select fluid type (gas or liquid).

Expand the Gases tree. Using the scroll box in the database of fluids, 
click Air.

Click Add. This will move Air under the Project Fluids list.

Accept all other default settings.

Click Next.
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19 Set wall conditions.

In the Parameter list, the value for Default wall thermal condition is 
Adiabatic wall and the value for Roughness is 0. 

Click Next.

Adiabatic Wall Since this project does not involve any type of heat transfer, the default 
Adiabatic wall selection is recommended. Adiabatic wall assumes the 
walls are perfectly insulated. In reality, there has to be some heat 
transfer across the wall. The manifold considered for the case study is 
an intake manifold of an engine. Air from the atmosphere will enter 
into the manifold at normal pressure and temperature therefore we will 
assume that the walls of the manifold are perfectly insulated. 

Roughness This value is used in the calculation of the velocity profile within the 
boundary layer. If the default value of zero is used (recommended if the 
roughness is not known), the solver assumes the walls are smooth. 
Please consult the Flow Simulation help on how to determine 
appropriate roughness parameters. 
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20 Initial and ambient conditions.

Click Finish to accept the default standard ambient conditions as the 
initial conditions for this analysis.

Note The closer the initial values are set to the final values determined in the 
analysis, the quicker the analysis will finish. Since we do not have any 
knowledge of the expected final values, we will not modify them in this 
lesson.

21 Review input data in the SOLIDWORKS Flow Simulation 
analysis tree.
SOLIDWORKS Flow Simulation will create a new project associated 
with the Default SOLIDWORKS configuration and a SOLIDWORKS 
Flow Simulation analysis tree will also be created.

The Flow Simulation analysis tree tab  in the SOLIDWORKS 
FeatureManager should be automatically created and selected.

If, after a later date, changes are 
needed to be made to the input data 
within the project, the user can right-
click Input Data in the 
SOLIDWORKS Flow Simulation 
analysis tree and select the 
appropriate option to update the 
input information.
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Expand the options under Input Data 
within the SOLIDWORKS Flow Simulation 
analysis tree. The SOLIDWORKS Flow 
Simulation analysis tree is used to define 
additional analysis settings for the project.

The Computational Domain, shown as a 
wireframe box enveloping the model, is used 
to visualize the volume being analyzed.

Computational 
Domain

The Computational Domain is defined as a volume fixed with respect 
to a coordinate system within a fluid flow field. Although the fluid 
moves into and out of the computational domain, the computational 
domain itself remains fixed in space.

SOLIDWORKS Flow Simulation analyzes the model geometry and 
automatically generates a Computational Domain in the shape of a 
rectangular prism enclosing the model. The computational domain’s 
boundary planes are orthogonal to the model’s Global Coordinate 
System axes. For external flows, the computational domain’s boundary 
planes are automatically distanced from the model capturing the fluid 
space around the model. However, for internal flows, the computational 
domain’s boundary planes automatically envelop the model walls only.

Introducing: 
Boundary 
Conditions

A boundary condition is required to describe where the fluid enters or 
exits the system (Computation Domain) and can be set as a pressure, 
mass flow, volume flow or velocity. Boundary conditions can also 
specify parameters of a wall such as ideal, stationary, or rotating.

The boundary condition can be entered in various ways allowing users 
to describe complex simulation scenarios.

 Constant: Boundary condition is entered as a 
constant value.
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 Formula: Formula 
Definition allows for 
creation of dependence using 
mathematical and logical 
functions. The dependence 
can be on time (transient 
simulations only), on the 
monitored analysis outputs 
(such as outlet volume flow), 
on the defined analysis 
parameters, and on spatial 
coordinates. Most of the 
standard and advanced 
mathematical functions are 
supported. Logical function 
IF is supported along with 
the Boolean operators AND, 
OR, XOR and NOT.

 Table: Robust tabular 
dependencies allow you to 
specify discrete dependencies of 
boundary conditions on spatial 
coordinates, on time (transient 
simulations only), on monitored 
analysis outputs (such as outlet 
volume flow rate), and on the 
defined analysis parameters. The list of exact available tabular 
dependencies can vary depending on the Flow Simulation feature 
and boundary condition used.

Where to Find It  Shortcut Menu: Right-click Boundary Conditions in the 
Flow Simulation analysis tree and click 
Insert Boundary Condition 

 CommandManager: Flow Simulation > Boundary Conditions 
 Menu: Tools, Flow Simulation, Insert, Boundary Condition 
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22 Insert boundary condition.
In the SOLIDWORKS Flow 
Simulation analysis tree, under 
Input Data, right-click 
Boundary Conditions and 
select Insert Boundary 
Condition.

Select the inside surface of the 
SOLIDWORKS feature 
representing the inlet, as shown 
in the figure.

Note To access the inner face, right-click the outer face on the lid and click 
Select Other. In the Select Other window, cycle through the faces by 
moving the pointer to highlight each face dynamically in the solid 
geometry.

23 Set up the boundary condition.
In the Boundary Conditions 
PropertyManager, under Type, select the 
Flow openings button .

Still under Type, select Inlet Volume Flow.

Under Flow Parameters, click the 
Normal to face button  and enter 
0.05 m3/s.

Click OK.

The new Inlet Volume Flow1 item appears in 
the SOLIDWORKS Flow Simulation analysis 
tree under Boundary Conditions. 
SOLIDWORKS Flow Simulation will apply a 
0.05 m3 of air per second across the inlet area, 
normal to the selected face.

Note Since the volume flow rate is required as an output at each outlet, a 
pressure condition should be used to identify the outlet condition. If the 
pressure is not known at the outlet of each port, an ambient static 
pressure condition can be used as the boundary condition across each 
outlet face for this analysis.
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24 Insert boundary condition.
In the SOLIDWORKS Flow Simulation 
analysis tree, under Input Data, right-click the 
Boundary Conditions icon and select 
Insert Boundary Condition.

Select the inner face of one of the outlet ports.

25 Set up the boundary condition.
In the Boundary Conditions window, under 
Type, select the 
Pressure openings button .

Still under Type, select Static Pressure.

Click OK to accept the default ambient values.

The new Static Pressure1 item appears in 
the SOLIDWORKS Flow Simulation analysis 
tree.

26 Create additional outlet boundary conditions.
Each outlet port should have a static pressure boundary condition 
assigned to the inside outlet lid surface. Create five additional static 
pressure boundary conditions for the remaining five outlets.

Introducing: 
Engineering Goals

SOLIDWORKS Flow Simulation contains built-in criteria to stop the 
solution process. However, it is best to use your own criterion by using 
what SOLIDWORKS Flow Simulation calls Goals. You can specify 
the Goals as physical parameters at areas of interest in the project, so 
that their convergence can be considered as obtaining a steady state 
solution from the engineering viewpoint.

Engineering goals are user specified parameters of interest, which the 
user can display while the solver is running and obtain information 
about after convergence is reached. Goals can be set throughout the 
entire domain (Global Goal), in a selected area (Surface Goal, 
Point Goal), or within a selected volume (Volume Goal). Furthermore, 
SOLIDWORKS Flow Simulation can consider the average, minimum 
or maximum value when examining goals.
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In addition, you can also define an Equation Goal, which is a goal 
defined by an expression (basic mathematical functions) using the 
existing goals as variables. This allows you to calculate a parameter of 
interest (e.g., pressure drop) and keeps this information in the project 
for later reference.

There are five different types of goals that can be defined in 
SOLIDWORKS Flow Simulation:

 Global Goal  Point Goal
 Surface Goal  Volume Goal
 Equation Goal

Where to Find It  Shortcut Menu: Right-click Goals in the Flow Simulation analysis 
tree and click Insert Goals

 CommandManager: Flow Simulation > Goals 
 Menu: Tools, Flow Simulation, Insert

Use in Instructions Choose the type of goal you want to define.

27 Insert surface goal.
In the SOLIDWORKS Flow Simulation 
analysis tree, right-click Goals, and select 
Insert Surface Goals.

To select the inlet surface for the surface 
goal, split the feature pane and in the 
upper portion click the boundary 
condition Inlet Volume Flow1 item in 
the SOLIDWORKS Flow Simulation 
analysis tree to input the face where the 
surface goal is to be applied.

In the Parameter list, locate 
Volume Flow Rate and click the check 
box next to it.

Click OK. 

The new SG Volume Flow Rate1 item 
appears in the SOLIDWORKS Flow 
Simulation analysis tree under Goals.
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28 Rename surface goal.
Rename the SG Volume Flow Rate1 in the SOLIDWORKS Flow 
Simulation analysis tree so that it appears as Inlet SG Volume Flow 
Rate.

29 Insert surface goal.
Repeat the earlier steps 27 and 28 to apply 
a surface goal for the volume flow rate at 
the outlet ports.

When selecting the Static Pressure 
boundary conditions, hold the control key 
and select all of the outlet boundary 
conditions.

Click the Create goal for each surface 
check box. This will create 6 surface goals 
for each of the 6 outlets.

Optionally, rename each surface goal to 
reflect the outlet port.
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30 Insert equation goal.
The Equation Goal is used in this lesson to sum the outlet volume flow 
rates. The Equation Goal will determine the total Volume flow rate 
leaving the manifold.

In the Flow Simulation analysis tree, right-click the Goals icon and 
select Insert Equation Goal.

Select the Outlet SG Volume Flow Rate1 surface goal from 
SOLIDWORKS Flow Simulation analysis tree to add it to the 
Expression box.

Click + in the Equation Goal window.

Repeat the last 2 steps to add each of the remaining 5 outlet flow rates 
to complete the equation.

In the Dimensionality list, select Volume Flow Rate.

Click OK.

31 Rename the equation goal.
Rename the equation goal to Sum of outlet flow rates.

Once the solution has converged, the sum of the outlet volume flow 
rates should approximately be equal to the inlet volume boundary 
condition.
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Mesh Density and quality of mesh influences the result resolution, or in other 
words the level of accuracy of the results. In general, to achieve higher 
level of result accuracy, the finer mesh is in general required which 
means higher total cell counts and increased physical RAM 
requirements.

Higher mesh density will require longer CPU time to solve. Thus, the 
optimum mesh density requires a balance between precise results and 
computation time.

32 Set initial global mesh parameters.
In the SOLIDWORKS Flow Simulation 
analysis tree, under Input Data, expand the 
Mesh folder, right-click Global Mesh and 
select Edit Definition.

Under Type keep Automatic. 

Under Settings accept the default 
Level of initial mesh of 3.

Click OK.

Note In some situations, entering values for the Minimum gap size is 
important and ensures that any small gaps are not ignored during 
meshing. Since this model has a fairly uniform diameter, no minimum 
gap is required.

33 Save file.
Click File, Save to save the assembly file.

Introducing: Run The Run command solves the simulation.

Where to Find It  Shortcut Menu: Right-click the project folder (Project 1) in the 
SOLIDWORKS Flow Simulation analysis tree and click Run

 CommandManager: Flow Simulation > Run 
 Menu: Tools, Flow Simulation, Solve, Run

Load Results 
Option

Because the results from SOLIDWORKS Flow Simulation may 
become large, it is necessary to Load them for post-processing. This 
option automatically loads SOLIDWORKS Flow Simulation results 
once the solver completes.

Note If multiple configurations/solutions are obtained, only a single solution 
set can be loaded at a time. Before loading a new set of results, the 
currently loaded results must be unloaded.
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Monitoring the 
Solver

The solution monitor window will appear after the solver has started. 
On the left of the Solver window is a log of each step taken in the 
solution process. On the right is an information dialog box with mesh 
information and any warnings concerning the analysis.
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Goal Plot Window The Goal Plot window will list each goal selected in the Add/Remove 
Goals window. Here you can see the current value and graph for each 
goal as well as the current progress towards completion given as a 
percentage. The progress value is only an estimate, and the rate of 
progress generally increases with time.

Warning Messages Warning messages are also displayed in the Info section of the Solver 
window. In this analysis, you may see a warning message that reads “A 
vortex crosses the pressure opening”. This message indicates that 
there is a pressure difference across the outlet, which sometimes 
indicates a recirculation across the outlet. After running the analysis, 
the user can look at the result plots to see if the flow is entering through 
the outlets. This message is only a warning and can be ignored for this 
analysis, but if there was flow entering through the outlet, then the user 
would have to extend the outlet until the flow vectors were all leaving 
the outlet.
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34 Solve the SOLIDWORKS Flow Simulation project.
In the SOLIDWORKS Flow Simulation analysis tree, right-click 
Project 1 and select Run.

Make sure that the check boxes next to Load Results is selected.

Click Run with default settings.

The solver should take approximately 5 minutes to run.

Note The Flow Simulation solver supports parallel computations. This 
allows you to select the number of CPUs to be used in the calculation.

35 Insert goal plot.
While the solver is running, In the Solver toolbar, click 

Insert Goal Plot  to open the Add/Remove Goals window.

Click the top checkbox to add all the goals you want to plot.

Click OK.
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36 Insert preview.
With the solver running, 
after a few iterations, click 
the Insert Preview button 

 on the Solver toolbar.

In the Preview Settings 
window, selecting any 
SOLIDWORKS plane and 
clicking OK will create a 
preview plot of the 
solution on that plane. For 
this model, the Top Plane 
is a good choice to use as 
the preview plane. The 
preview plane can be 
chosen anytime from the 
SOLIDWORKS 
FeatureManager.

Click the Settings tab.

In the Parameter list, 
click Velocity.

Click OK.

Note The preview allows one to look at the results while the calculation is 
still running. This helps to determine if all the boundary conditions are 
correctly defined and gives the user an idea of how the solution will 
look even at an early stage. It is important to note that at the start of the 
run the results might look odd or change abruptly. However, as the run 
progresses, these changes will lessen and the results will settle in on a 
converged solution. The results can be displayed either in contour, 
isoline or vector representation.

37 Close the Solver window.
Click File, Close. This will close the Solver window.
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Post-
processing

The first step to view the results is to generate a transparent view of the 
geometry, a 'glass-body' image. This way, you can easily see where cut 
planes etc. are located with respect to the geometry.

Introducing: Cut 
Plots

A Cut plot displays any result on any SOLIDWORKS plane. The 
representation can be as a contour plot, as isolines, or as vectors and 
also in any combination of the above (e.g. contour with overlaid 
vectors).

Where to Find It  Shortcut Menu: Right-click Cut Plots under Results in the 
Flow Simulation analysis tree and click Insert

 CommandManager: Flow Simulation > Insert > Cut Plot 
 Menu: Tools, Flow Simulation, Results, Insert, Cut Plot 

38 Set model Transparency.
In the Tools, Flow Simulation menu, select Results, Display, 
Transparency.

Move the slider to the right to increase the Value to set. Set the model 
transparency to 0.75.

Click OK.

Tip You can also right-click each part in the SOLIDWORKS 
FeatureManager tree and select Change Transparency.

Note As selected when initializing the solution, the 
results will be automatically loaded. The 
associated result file is indicated in the 
parentheses next to the Result folder.

39 Create Cut Plots.
In the Flow Simulation analysis tree, right-click Cut Plots under 
Results and select Insert.

In the Section Plane or Planar Face box, select the Top plane view. 

Click OK.
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We can observe that the total pressure magnitude varies from 
101,249 Pa to 101,459 Pa.

A Cut Plot 1 item will be created in the Flow Simulation analysis tree 
under the Cut Plots folder.

40 Hide the cut plot.
Right-click the Cut Plot 1 icon and select Hide.

41 Add a cut plot.
Right-click the Cut Plots icon under Results 
and select Insert.

Choose the Top Plane as the cut plane.

Make sure that the Contours button is 
selected.

Under Contours select Velocity and increase 
Number of Levels slider to 50.

Click OK.

Note The limits of the legend default to the global maximum and minimum. 
Use the Adjust Maximum and Minimum button under the Contours 
dialog to change them.

The maximum velocity close to 15.3 m/s is reached close to the inlet 
where the rapid narrowing of the profile ends.
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To modify the options for this and other plots, either double-click on 
the color scale or right-click the plot name and select Edit Definition.

Scaling the Limits 
of the Legend

Click directly on the lower or upper limit 
value in the legend. The desired limit value 
can then be entered in the text field.

To the right of the text field, there are two 
auto-scaling buttons. The first button (left 
side) auto-scales the maximum value of the 
legend to the maximum value existing in 
the model. The second button auto-scales 
the maximum value of the legend to the 
maximum value in that cut plane. These 
buttons also exist for adjusting the minimum values of the legend.

Changing Legend 
Settings

To edit various legend settings such as color 
palette, out of range colors, font and its size and 
others, right click directly on the legend and use 
the Edit and Appearance commands.

Orientation of the 
Legend, 
Logarithmic Scale

Legend can be oriented vertically, or 
horizontally. To change the legend orientation, 
right-the legend and click Make Horizontal (or 
Make Vertical).

Click Logarithmic Scale to change the axes to 
this scale.

Double-click

Model 
Maximum

Cut Plane
Maximum
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42 Animate cut plot through the model.
The animation feature can be used to view how the quantity plotted on 
the cut plot (total pressure in our example) varies through the model.

Right-click on the 
Cut Plot 2 item 
under the Cut Plots 
folder and select 
Play, to automatically move the cutting plane (Top plane in our 
example) through the mode and view how the plotted quantity varies.

Stop the animation by clicking the stop button  in the right bottom 
corner of the screen.

43 Create vector cut plot.
Right-click the Cut Plot 2 icon under Cut Plots and select 
Edit Definition.

Under Display, deselect Contours and click Vectors.

Click OK.

Note The vector Spacing, their Size, and other vector parameters can be 
adjusted in the Vectors dialog of the Cut Plot window.

44 Edit Cut Plot 2.
Edit definition of Cut Plot 2. Change the offset distance to -0.02m. 
Click OK.

Note The new position of the cut plot will be used later on in this lesson.

45 Hide Cut Plot 2.
Right-click the Cut Plot 2 icon under Results, Cut Plots in the 
SOLIDWORKS Flow Simulation analysis tree and select Hide.
379



Lesson 9 SOLIDWORKS Education 2023
Creating a SOLIDWORKS Flow Simulation Project
Introducing: Surface 
Plot

A Surface Plot displays any result on any SOLIDWORKS surface. 
The representation can be as a contour plot, as isolines, or as vectors - 
and also in any combination of the above (e.g. contour with overlaid 
vectors).

Where to Find It  Shortcut Menu: Right-click Surface Plots under Results in the 
Flow Simulation analysis tree and click Insert

 CommandManager: Flow Simulation > Insert > Surface Plot 

 Menu: Tools, Flow Simulation, Results, Insert, Surface Plot 

46 Create surface plot.
In the Flow Simulation analysis tree, right-click the Surface Plots 
icon under Results and select Insert.

Select Use all faces.

Make sure Contours is selected and specify Pressure as the quantity 
to plot.

Click OK.

A Surface Plot 1 icon will be created in the SOLIDWORKS Flow 
Simulation analysis tree under Surface Plots. The same basic options 
are available for Surface Plots as for Cut Plots. Feel free to experiment 
with different combinations on your own.
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47 Probe.
In the Flow Simulation analysis tree, right-click Results and select 
Probe. Select points of interest in the graphics window.

The pressure at those locations will appear in the graphics window.

To turn the Probe tool off, right-click Results and select Probe again.

To turn off the probe displays, right-click Results and select 
Display Probes.

48 Hide Surface Plot 1.
Right-click the Surface Plot 1 and select Hide.

Introducing: Flow 
Trajectories

Using Flow trajectories, you can show the flow streamlines and paths 
of the massless particles that are inserted into the fluid. Flow 
trajectories provide a very good image of the 3D fluid flow. You can 
also see how parameters change along each trajectory by exporting data 
into Microsoft Excel. Additionally, you can save trajectories as 
SOLIDWORKS reference curves. The trajectories can also be colored 
by values of whatever variable chosen in the View Settings window.

Where to Find It  Shortcut Menu: Right-click Flow Trajectories under Results in 
the Flow Simulation analysis tree and click Insert

 CommandManager: Flow Simulation > Insert > 

Flow Trajectories 
 Menu: Tools, Flow Simulation, Results, Insert, 

Flow Trajectories
381



Lesson 9 SOLIDWORKS Education 2023
Creating a SOLIDWORKS Flow Simulation Project
49 Create flow trajectory.
In the SOLIDWORKS Flow 
Simulation FeatureManager, right-
click the Flow Trajectories icon 
under Results and select Insert.

Click the Flow Simulation analysis 
tree tab.

Under Boundary conditions, click 
Static Pressure1 item. This will 
select the inner face of the outlet Lid 
2 part as the origin for the 
trajectories.

Under Appearance click the Static Trajectories , and set 
Draw Trajectories As to Pipes.

In the Number of points box, type 16.

Click OK.

Discussion Notice the trajectories that are entering and exiting through the exit lid. 
This is the reason for the warning (A vortex crosses the pressure 
opening) during the solution process. When flow both enters and exits 
the same opening, the accuracy of the results will be affected. In a case 
such as this, one would typically add the next component to the model 
(such as a pipe extending the computational domain) so that the vortex 
does not occur at an opening.

Another approach to deal with this warning message could be to 
change the boundary condition at the pressure opening. We applied a 
static pressure boundary condition to each outlet face. This applies 
static pressure to both sides of the lid. In reality, we know that if the lid 
was extended, the flow would experience some amount of pressure 
difference. To account for this, we could have used an environment 
pressure boundary condition. The environment pressure boundary 
condition applies total pressure to the face of the lid where the flow 
enters the model and static pressure to the face of the lid where the flow 
leaves the model. This type of boundary condition will provide us with 
more reliable results than the static pressure condition.
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Introducing: XY 
Plots

XY-Plot allows you to see how a parameter changes along a specified 
direction. To define the direction, you can use curves and sketches (2D 
and 3D sketches). The data are exported into an Excel workbook, 
where parameter charts and values are displayed. The charts are 
displayed in separate sheets and all values are displayed in the 
Plot Data sheet.

Where to Find It  Shortcut Menu: Right-click XY Plots under Results in the 
Flow Simulation analysis tree and click Insert

 CommandManager: Flow Simulation > Insert > XY Plots 
 Menu: Tools, Flow Simulation, Results, Insert, XY Plots

50 Hide Flow Trajectories 1.
Right-click the Flow Trajectories 1 icon under Results, Flow 
Trajectories in the SOLIDWORKS Flow Simulation analysis tree and 
select Hide.

51 Plot XY plot.
We have already created a SOLIDWORKS sketch containing a line 
through the manifold. This sketch can be created after the analysis is 
finished. Take a look at Sketch-XY Plot in the SOLIDWORKS 
FeatureManager analysis tree.

In the SOLIDWORKS Flow Simulation analysis tree, under Results, 
right-click the XY Plots icon and select Insert.

Under Parameters, select Pressure and Velocity.

Under Selection, select Sketch-XY Plot from the SOLIDWORKS 
FeatureManager.

Leave all options as defaults and click Show.

The window with the graphs of the selected results will open on the 
bottom of the screen.

Close the plot window by clicking the close button (see the figure 
above).

Still in the XY Plot PropertyManager, click the Export to Excel button.
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Microsoft Excel will open and generate two lists of data points as well 
as two graphs, one for Velocity and the other for Pressure. You will 
need to toggle between different sheets to view each graph.
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Introducing: Surface 
Parameters

Surface Parameters can be used to determine pressures, forces, heat 
flux as well as many other variables on any face within your model 
contacting the fluid. For this type of analysis, it would probably be of 
interest to calculate the average static pressure drop from the valve inlet 
to outlet. Surface parameters can also be calculated using section plane. 
If a section plane divides a model into several closed contours then 
surface parameters for each parameters can be calculated separately. 
Cut Plots can be used to obtain Surface Parameters. This eliminates 
the need to create a dummy body to measure a fluid's integral 
parameters.

 Shortcut Menu: Right-click Surface Parameters under Results in 
the Flow Simulation analysis tree and click Insert

 CommandManager: Flow Simulation > Insert > 

Surface Parameters 
 Menu: Tools, Flow Simulation, Results, Insert, 

Surface Parameters

52 Create Surface Parameters.
In the SOLIDWORKS Flow Simulation analysis tree, under Results, 
right-click the Surface Parameters icon and select Insert.

In the SOLIDWORKS Flow Simulation analysis tree, under 
Boundary Conditions, click the Inlet Volume Flow 1 item. This 
will select and add the inner face of the inlet Lid 1 part to the Faces 
list.

Select All from the Parameters list.

Click Show. At the bottom of the screen, two tables will appear. The 
table on the left will contain the local parameters and the table to the 
right contains the integral parameters.

Shown in the Local table are the Minimum, Maximum, Average, and 
Bulk Average values for a number of parameters (including Pressure, 
Temperature, Density, etc.) for the inlet face. The same information 
can be obtained if the outlet lid faces were selected.

Close the two tabs by clicking the Close Table mark at the right hand 
side of the screen. 

Click Export to Excel.
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An Excel spreadsheet will be automatically created containing the 
values in the Surface Parameter window.

Note The Integral table contains integrated values taken across the face of 
the selected surface. We can see that the volume flow rate on this inlet 
face is equal to the volume flow rate boundary condition of 0.05 m^3/s 
that we specified.

53 Calculate mass flow rate, volume flow rate and 
average pressure at each outlet.
In the SOLIDWORKS Flow Simulation analysis 
tree, under Results, right-click the Surface 
Parameters icon and select Insert.

Under Selection select Cut Plot.

Select Cut Plot 2 from the Cut Plot drop down.

Select Separate check box.

Under Parameters, select Mass Flow Rate, 
Volume Flow Rate and Pressure.

Click Show.

Note Separate check box appears in the Surface Parameters 
PropertyManager when the section plane divides the model into several 
closed contours. 

Under Display Contours, select items Air(1) to 
Air(6) corresponding to the six outlet ports locations.

Click OK.
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Note Numbering of your Air items corresponding to the outlet ports may be 
different.

Flags of selected parameters for each contour are displayed in the 
graphics area. 

Take a look at each parameter. Mass flow rate for each outlet is 
different. 

There is smooth transition between Air (6) outlet and the main pipe. 
For that reason the mass and volume flow rates at Air (6) outlet is at 
their maximum.

On the other side, Air (1) outlet and the main pipe do not have smooth 
transition, and hence the mass and volume flow rates at Air (1) outlet 
are at their minimums.

Click OK.
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Introducing: Goal 
Plot

The goal plot allows you to see how the goal changes throughout the 
flow simulation as well as the final value of the goal at the end of the 
calculation.

Where to Find It  Shortcut Menu: Right-click Goal Plots under Results in the Flow 
Simulation analysis tree and click Insert

 CommandManager: Flow Simulation > Results > Goal Plot 
 Menu: Tools, Flow Simulation, Results, Goal Plot

54 Goals plot.
In the SOLIDWORKS Flow Simulation 
analysis tree, under Results, right-click Goal 
Plots and select Insert.

Select All Goals in the Goal Filter and check 
All in the Goals to Plot list.

Under Options select Group charts by 
parameter.

Click Show.

The table of the goal values will open on the bottom of the screen.

Change the view from Summary to History.
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Close the goal plot window by clicking the close button (see the figure 
above).

Still in the Goal Plot PropertyManager, click the Export to Excel 
button.

An Excel spreadsheet will be automatically created containing 
information about the goals.

Close the Goal Plot PropertyManager.

Note The spreadsheet contains the final, maximum, minimum and averaged 
values of the goal during the calculation. In addition, there are plots 
showing how the goal changed during the calculation.

Negative values represent flow out of the computational domain.

Here, we can also verify that our inlet volume flow rate boundary 
condition was also applied properly during the calculation. In addition, 
the total flow out is equal to the total flow in.

Introducing: Save 
Image

Postprocessing images such as cut plots and surface plots can be 
exported in various image formats, and also in the eDrawings format.

Where to Find It  Shortcut Menu: Right-click the Results folder and select 
Save Image

 CommandManager: Flow Simulation > Screen Capture > 

Save Image 
 Menu: Tools, Flow Simulation, Results, Screen Capture, 

Save Image
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55 Save image as eDrawings.
Show all your result plots.

Right-click on the Results folder and select Save Image.

Select eDrawings as the format, and keep the default name 
Project 1.easm.

Click Save.

The file will be saved in the directory associated with this project.

Close the PropertyManager.

56 Open eDrawings file.
Navigate to the result folder associated with this project, and open 
Project 1.easm by double-clicking on it.

eDrawings will open the model with all defined results plots.

All plots shown in the Flow Simulation feature tree will be included.
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57 Save and Close.
Save and Close the assembly.

Discussion We specified an inlet volume flow rate of 0.05 m^3/s and have verified 
that this boundary condition was applied properly using 
Surface Parameters and Goal Plots that this value was applied.

Due to conservation of mass, we also know that the total volume flow 
rate into the manifold should equal the total volume flow rate out of the 
manifold. We can verify that this is true using the Goal Plot and 
looking at our goal for the Sum of outlet flow rates.

Furthermore, we would like to determine if the design of the manifold 
will result in efficient engine performance. In the beginning of the 
lesson, we said that the ideal situation would have similar flow through 
all of the outlet ports. When looking at our goals, we can see that the 
volume flow rate can vary significantly through the outlet ports. It is up 
to the engineer to decide whether design modification would be 
necessary to produce a more uniform outlet flow through each port.ì

Summary In this lesson we learned how to set up a Flow Simulation project. The 
Wizard was used to create all of the general settings of the analysis. 
Both inlet and outlet boundary conditions were defined and a number 
of goals were created. The results of the simulation was thoroughly 
post-processed using many of the options available in SOLIDWORKS 
Flow Simulation. The stages of flow simulation that were outlined in 
this lesson will be followed throughout the book.
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